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Introduction 

EnterpriseIQ is capable of generating material, assembly, and schedule requirements with extreme 
accuracy. In order to do this, EnterpriseIQ needs to know some precise information about your tooling 
and methods of assembly. This information is entered and edited using the BOM (Bill of Manufacture) 
module. 

The BOM module provides the method for defining how parts are made in your environment. This 
information includes elements such as part number(s), material designation and usage, production times 
(cycles), packaging, process notes and instructions. 

EnterpriseIQ uses the information in the standards in several areas of the system (such as in the creation 
of work orders and material purchasing requirements), therefore it is critical that the BOM's are 
accurate. 

Note: The terms BOM, Manufacturing Standard, and Manufacturing Configuration all mean the same 
thing. 

Unique Standards - The Key to Proper Production 

Each manufacturing configuration must be unique to the way in which the parts are made. It will tell you 
how long the cycle is (rate of production), how much the parts weigh (material consumption), how many 
parts will be produced at a time, and what materials will be consumed during production. For every 
possible way that the parts can be made, there must be a separate manufacturing configuration. 

If an item is produced in many different colors or with varying types of material, each item MUST have 
it’s own manufacturing configuration with it’s own unique configuration number. When EnterpriseIQ 
generates material requirements and scheduling estimates, it relies on the unique data pertaining to 
each item number. 

Numbering Schemes for Configurations 

Like customers, vendors and raw materials, manufacturing configurations must be uniquely identified via 
the Manufacturing Configuration Number/Routing Number combination.  

The manufacturing configuration number is an alphanumeric field. This means it may contain numbers as 
well as letters. The user should create a manufacturing configuration numbering scheme that is simple 
and easy for everyone to understand. 
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Manufacturing Types 

`There are several default Manufacturing Types in EIQ. Below is a list with a brief description of each: 

ASSEMBLY  Similar to Generic BOM except Cycle Time on BOMs is in Hours instead of 
Seconds. 

Note: The Cycle time for the Assembly Mfg Type in the Estimating module is in 
seconds and not hours. When converting an Assembly manufacturing type Quote 
to BOM the system will convert the cycle time to hours. 

ASSY1 Utilizes BOMs with processes attached that call out work centers, tools, labor and 
quality requirements. Uses Assembly Track and Assy Data for reporting and 
tracking. Labor reporting is done for each process and components are 
backflushed during labor reporting. 

ASSY2  Same as ASSY1 except Work Centers are associated to the processes, and to the 
Assembly Line. 

ASSY3 Similar to  the other ASSY types except an Assembly Line is associated to the 
BOM, and by default, Final Assembly is used to report production. 

(Please see the ASSY Manufacturing documentation for more details on these 
MFG Types). 

BLOWMOLD  Similar to Injection BOM except Runner/Sprue is changed to "Parison/Flash". 

COMPLEX  Similar to Generic BOM except it has an icon to Designate Child Complex BOMs 
(this brings up a window called "Complex Visual BOM" where you can enter in 
additional info). Designed to simplify the scheduling process where multiple WO’s 
are involved in producing a product and they are done on multiple work centers 
that make up a complex line. When a WO for the complex BOM is set up in first 
position on the Complex Line, all child work orders will automatically also be set 
up on their work centers in the line. (See Complex MFG Type BOMs for more 
information). 

COMPOUND1  The Compound1 manufacturing type is used to create items with a unit of 
measure based on a weight such as grams or pounds. This manufacturing type is 
similar to Extrusion2 where there is a Lbs/Hr field, however there is no primary 
material. The item produced is made up of several components which also must 
have a weight type unit of measure. The components are assigned on the item 
details tab similar to the Masterbatch manufacturing type. (See Compound1 for 
more information). 

DIECAST  Similar to Injection except Runner/Sprue is changed to "Runner/biscuit". 

EXTRUSION  Item is Part Length with a typical unit of measure in feet. The BOM includes 
Feet/Lb and Lbs/Hr. Production is reported as a total length. (See Extrusions - 
General BOM Information for more information on the Extrusion MFG Types). 
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EXTRUSION2  Item is in part weight with a typical unit of measure in pounds. The BOM includes 
Lbs/Hr. Production is reported in total Lbs. 

EXTRUSION3  Item is in part weight with a typical unit of measure in eaches. The BOM includes 
Lbs/Hr. Production is reported in total parts. 

GENERIC  The most basic BOM structure used for manufacturing that does not fit any of the 
other more specific types. Like other standards, generics can consume finished 
goods, components, and packaging, and can include labor and overhead. (See 
Generic Standards for details). 

INJECTION  Primary material, tooling info, cavitation and part weight information. (See 
Creating a New BOM for details). 

JOBSHOP  Designed for toolmakers, die makers, and other short run, discrete manufacturers 
utilizing Generic BOMs. It provides visual routing and fast creation of new 
projects based on existing routing templates It simplifies production based on 
longer run times and tiered manufacturing processes, including coring, lathing, 
drilling, grinding and milling. It’s recommended to have a  separate EPlant for 
handling JobShop parts separate from regular manufacturing processes. For 
JobShop, you create a new project from the JobShop module and then build out 
the routing info with a BOM set up for each step in the routing process. (See the 
JobShop documentation for more information). 

JOBSHOP2  Similar to JobShop in that it is designed for toolmakers, die makers, and other 
short run, discrete manufacturers. This is based on the ASSY1, ASSY2, or ASSY3. It 
brings together the JobShop module and Assembly Track in one place. (See the 
JobShop2 documentation for more information). 

MBATCH  The Masterbatch manufacturing type is used to create items with a unit of 
measure based on a weight such as grams or pounds. The item produced is made 
up of several components which also must have a weight type unit of measure. 

▪ Item details tab has icon to add components based on quantity or percentage 
instead of calling out for a primary material (similar to Compound1).  

▪ Production Summary info for "Batches/Hr" and "Hours/K Batches".  

▪ Cycle Time is called "Batch Time", Actual and Standard Cavitation is called "Act 
Batch Size" and "Std Batch Size", no Part Weight 

(See Masterbatch MFG Type for details). 

OUTSOURCE  For Outsource operations. The Center Type is changed to "Vendor" and Cycle 
Time is changed to "Days/K" (days required to get 1000 parts), there are also 
fields for a "Flat Ratio" cycle time and "Drop Ship". There’s no Tooling or 
Production Summary data. (See Outsourcing below for details). 

PM  No BOM’s are created for this MFG Type. It is used if you wish to set up PM Cells 
for using the PM Capacity Schedule tool. The PM MFG Type is only used in 
Maintenance, Repair and Overhaul. It will not be visible in BOMs, Work Centers, 
Scheduling, Production Reporting, and RealTime. (See the Maintenance, Repair 
and Overhaul help file for more information). 
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REWORK  Same as Generic BOM. Used in conjunction with creating RMA rework work 
orders for Rework type work centers. (See Mfg Rework Order for details). 

RIM  Similar to an Injection BOM except Runner/Sprue is called "Flashing". The cycle 
time defaults to minutes and not seconds. Shift Backflush can only be "Based on 
total cycles at shot weight. The Eff Factor is called "Yield Factor", Production 
Summary also has a "Parts/Hr" value. 

ROTATIONAL  Similar to Injection BOM except no Runner/Sprue field, and cycle time defaults to 
minutes and not seconds. 

SFOAM  The same as Injection BOM, however in the Work Center module, the Center 
Type is changed to "Platen Type". 

SLITTING Used for slitting rolls of material to specific thicknesses. Similar to EXT1 as it has 
Feet/Lb and Lbs/Hr. (See Slitting for details). 

STAMPING Similar to Injection BOM except Runner/Sprue is changed to "Waste Material". 

TFORM2 Fields for Gauge, SPG, Tool Width, Tool Length, Sheet Weight, and Skeleton 
Weight. Designed for inputting sheets that have native UOM of Each and are 
dispositioned in Each (includes additional fields for Rail and Clamp values). 

 

THERMOFORM  

Fields for Gauge, SPG, Tool Width, Tool Length, Sheet Weight, and Skeleton 
Weight. Designed for continuous feed input. (See Thermoform - General BOM 
Information for information on Thermoform and TForm2 MFG Types). 

THERMOSET  Same as Injection BOM. 

TREATMENT This manufacturing type is used for processes such as heat treatment and 
annealing where multiple items are processed at one time. All items that require 
a specific Treatment are included in the BOM. 

ASSY vs. Generic Comparison 

MFG 
TYPE 

WORK 
CENTERS 

BOMS PROCESS/ 

OPERATIONS 

SCHEDULING PROD/LABOR 
REPORTING 

ASSY 
1 

Work 
Centers 
are 
associated 
to the 
processes 

Processes are 
added to the 
BOM 
(required) 

Process 
(required)  
contain Center 
Types, 
Materials, Cycle 
Times, Yield, 
Labor, etc.  

Work Orders/ 
Processes  are 
added to ASSY 
Track, and Finite 
Scheduling 
(optional) 

ASSY Track, or ASSY 
Data;  backflushing is 
done when Process is 
completed. FG item is 
added to inventory 
when Final Reporting is 
done.  
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ASSY 
2 

Work 
Centers 
are 
associated 
to the 
processes 
and      
Assembly 
Line 

Processes are 
added to the 
BOM 
(required) 

Process 
(required)  
contain Center 
Types, 
Materials, Cycle 
Times, Yield, 
Labor, etc. 

Processes are 
scheduled    on 
work centers in  
scheduling similar 
to    ASSY1  

ASSY Track, or ASSY 
Data;   backflushing is 
done when Process is 
completed. FG item is 
added to inventory 
when Final Reporting is 
done. 

ASSY 
3 

Work 
Centers 
are 
associated 
to the 
processes 
and      
Assembly 
Line 

Processes are 
added to the 
BOM 
(required);  
Assembly Line 
is    
associated to 
the BOM 

Process 
(required)  
contain Center 
Types, 
Materials, Cycle 
Times, Yield, 
Labor, etc. 

Work orders are 
scheduled on work 
centers in Finite 
Scheduling 

ASSY Track, or ASSY 
Data; Components are 
backflushed at Final 
Assembly by default. 
Optionally, components 
can be backflushed 
when reporting labor 
instead of at final 
assembly if the 
'Backflush Each Process' 
option is checked for the 
MFG Type. 

GENE
RIC 

Work 
Centers 
Types are 
associated 
to the 
BOM 

Required 
fields include 
center type, 
cycle time 
(seconds); 
optional fields 
scrap%, labor, 
and eff % 

Operations are 
additional 
steps;  can 
include cycle 
time and rate, 
and are 
optional 

Work orders are 
scheduled on work 
centers in Finite 
Scheduling 

Prod Rep by Shift / PRLS 

Prod Rep by WO 

PRA 

ASSE
MBLY 

Work 
Centers 
Types are 
associated 
to the 
BOM 

Required 
fields include 
center type, 
cycle time 
(hours); 
optional fields 
scrap%, labor, 
and eff % 

Operations are 
additional 
steps;  can 
include cycle 
time and rate, 
and are 
optional 

Work orders are 
scheduled on work 
centers in Finite 
Scheduling 

Prod Rep by Shift / PRLS 

Prod Rep by WO 

PRA 

 

Compound vs. Masterbatch 

MFG TYPE COMPOUND MASTERBATCH 
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Cycles Based On / Cycle 
Time 

Lbs/Hr Batch Time in Secs 

Item Details > Item Info Item Weight > Lbs / Gr / Oz Std Batch Sz / Act Batch Sz 

Assign Batch Components By Percentage / By Qty & % / Parts 
Per 

By Percentage / By Qty & % / Parts 
Per 

Production Reporting  Total Cycles X Batch Size = Good 
Parts (Lbs) + Reject (Lbs 

Total Lbs = Good Lbs + Reject Lbs 

Modify or Add MFG Types 

To modify or to add additional manufacturing types, follow the steps below. 

➢ From the EIQ Launcher Bar, click on File|Manufacturing|Mfg Setup|Mfg Type. The Modify 

Manufacturing Types screen will appear. 
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➢ Highlight the Mfg Type to modify and make the change. 

➢ If adding in a new type, click on the ADD [+] function key located on the Navigator bar. 

➢ From the Select Mfg Type form choose the Predefined or User Defined tab.   

Predefined - This tab is used to add predefined manufacturing types available in the system. Select the 
drop down list and choose from the supported manufacturing types. 

User Defined - This tab is used to create user defined manufacturing types. Enter the name in the Mfg 
Type field (apostrophes are not allowed) and select the manufacturing type the user defined type should 
default to from the drop down list of system supported manufacturing types. Once the manufacturing 
type is selected, the options on the right side of the MFG Types screen  will be updated based on the 
selected default type. To function properly the predefined type the user defined type is based on must 
be active in the MFG Type list for non ASSY types. When a user defined type ASSY manufacturing type is 
created without having the predefined ASSY type created, the system will still make the Assembly Track 
and Assembly Process Maintenance modules visible after logging back in. 

Note: When naming multiple user defined manufacturing types, ensure that the names are unique in 
ways other than just special characters (for example, not “TYPE#NAME” and “TYPE/NAME”).  This will 
ensure that the different types will be able to have their own User Defined Forms associated with them.  

Notes:  

Once BOMs are created using the user defined manufacturing type the default type cannot be changed.  
If BOMs have not been created and the user wants to change the ‘default to’ type, the user defined 
manufacturing type will need to be deleted and then recreated. 

If a user does not select a 'Default To' MFG Type, it will default to Generic. 

If a user attempts to create a user defined manufacturing type with the same name as a predefined 
manufacturing type a warning will appear stating, "This is a standard mfg type and is not available to 
utilize in a User Defined mfg type." 

When naming multiple user defined manufacturing types, ensure that the names are unique in ways 
other than just special characters (for example, not “TYPE#NAME” and “TYPE/NAME”).  This will ensure 
that the different types will be able to have their own User Defined Forms associated with them. 

Reports Names Tab: 

Assign the appropriate BOM and WO reports by clicking on the search button to right of these fields. The 
BOM and WO reports can be EPlant specific if desired. Select the EPlant ID and then select the report 
using the search button. When generating reports using speed buttons in the BOM or WO module, the 
report that prints will be based on the EPlant the user is logged into. 

Labor/Overhead Tab: 



BOM-Manufacturing Configurations Page 12 of 273 

 

Set the labor and overhead cost element associated with the manufacturing type.  

➢ Default Labor Rates - Default Labor Rates may also be setup from within this screen as well. 

These rates can be overridden when setting up a manufacturing configuration by clicking on 
Options|Misc. Parameters from within the BOM screen or by utilizing the employee levels in the 

labor field of the BOM. Rates can be set for Current, Future, Budget, and Forecast. If these 
costs are populated, the system will use these instead of the current cost for calculating the 
applicable cost such as Future Cost.The same cost elements assigned to the center type will 

be used for these calculations. 

➢ Labor posted from Time & Attendance - When checked the labor will not post to translog from 

floor dispositioning. Labor will be posted from Time & Attendance only. When floor 

dispositioning the system will not put an actual cost into the translog for labor for that 
manufacturing type.  It removes the actual labor entry from the floor disposition/backflush 
routine so that only actual labor is picked up in PIT from the Time and Attendance records. 

If it is not checked and labor is reported using Time and Attendance there will be a double 
hit to labor. Note: During production reporting the employee hours information can only be 
edited if the user has security rights to do so. A Status Exception will appear stating “Mfg 

Type is setup to have labor posted from Time & Attendance”. By default, if users enter labor 
in production reporting it will post to translog, therefore Time and Attendance users should 
not enter labor in production reporting. 

▪ Include Manual Labor from PRS - If the 'Labor posted from Time & Attendance' option is checked 
this option can also be checked to include manual labor information from Production Reports by 
Shift (PRS). If the 'Labor posted from Time & Attendance' option is not checked this option will be 
grayed out. When checked it allows users who do not have Time & Attendance setup for all 
EPlants to still report labor from PRS. This can also be checked at the MFG Cell level. When 
determining if manual labor should be included from PRS the system will look at the MFG Cell 
first using the hierarchy below: 
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If 'Include manual labor from PRS' is set as 'Yes' on the MFG Cell the system will include both 
manually entered labor and labor posted from Time & Attendance.  

If the MFG Cell is set to 'N' the system will not include manual labor from PRS.  

If this field is not set at the MFG Cell level the system will use what is set for the MFG Type.  

 

Note:  When 'Labor posted from Time & Attendance' is checked and 'Backflush on Clock Out' is also 
checked, when clocking out and reporting zero good parts, only Labor hours, the Actual Cost is updated 
to include the Actual labor dollars recorded for all labor reported.  This Actual Cost will be updated on 
the Location when parts are put in to inventory, and captured in IACJ.   

Note: When the ‘Labor posted from Time & Attendance’ is enabled on the MFG Type and the 'Include 
Manual Labor from PRS' is not checked, if a user manually adds labor to the Employee Hrs on the 
Production Report, the user will need to close the production report and go to Task Clock Maintenance 
to post those manually added labor records before dispositioning the production report. 

➢ Use Labor Rate to calculate Actual Labor - If this option is checked, when calculating actual labor 

in Actual Costing, instead of using the employee charge rate, the system will use the Mfg 
Type Labor Rate. The calculation is (Mfg type labor rate * Production Hours)/Quantity. 

➢ Variable Overhead - The calculation for Variable Overhead can be Work Center Based or Labor 
Based. If 'Work Center Based' is selected, standard and actual overhead will be calculated as 
usual using the center rate. If 'Labor Based' is selected with a rate filled in then the standard 
and actual overhead costs will be based on the labor rate entered for the manufacturing 

type. If a rate is not filled in, the overhead will be 0. See Standard Cost Calculations - For 
Non Extrusion MFG Types in the Accounting manual for additional information. 

➢ Variable Overhead generates its own IACJ file - its header references the Variable Overhead 

Translog record. Users can drill down in IACJ to view further details. 

➢ Fixed Overhead - A Fixed Overhead Cost Element can be assigned to the MFG Type. When the 

Overhead is work center based the system will use the rates associated to the work centers. 
If the overhead is labor based, enter the rate in the Fixed field. Note: The Labor Based Rate 

Fixed rate is not currently used in an Engineering Quote calculation for Prod Cost.  The 

Variable rate can be used. 

Fixed Overhead generates its own IACJ files - its header references the Fixed Overhead Translog record. 
Users can drill down in IACJ to view further details. 

➢ Overhead Posted from Time and Attendance - This option is only available when the option 'Labor 

Posted from Time and Attendance' is checked and 'Work Center Based' is not checked. With 

this option enabled, an Overhead record is posted to the Translog (Transactions Log) along 
with the Labor record.  

➢ The Total Calculated Hours are used for the Variable Overhead Quantity. If the Work Order 

is scheduled when the Labor record is posted, the Variable Overhead will post as the 
following:  
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➢ (Calculated Labor Hours) * (Variable Overhead Center Cost of the Work Center on which the 

Work Order is scheduled) 

➢ If the Work Order is not scheduled when the Labor record is posted, the default rate 
currently set in the MFG Type -> Labor/Overhead -> Labor Based Rate -> Variable field will 

be used:  

➢ (Calculated Labor Hours) * (MFG Type Labor Base Rate Variable Overhead Cost) 

➢ This feature also applies to PRW (Production Reporting by Work Order). Since both the 

Labor and Overhead Translog records have the same batch and sub batch records, they are 
linked in Post Inventory Transactions (PIT). However, the Labor and Overhead records will 
not display in PRW when they are posted - they will only display in PIT.  

➢ The following hierarchy will be used to capture Overhead cost elements. 

▪ Cost Element on the Work Center assigned to the Labor record. 

▪ If no Work Center is assigned to the Labor record, use the Cost Element on the Manufacturing 
Type. 

▪ If no Cost Element is found on the Manufacturing Type, use the Overhead Cost Element(s) on the 
Item. 
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Note:  When 'Labor posted from Time & Attendance' is checked and 'Backflush on Clock Out' is also 
checked, when clocking out and reporting zero good parts, only Labor hours, the Actual Cost is updated 
to include the Actual Overhead dollars recorded for all labor reported.  This Actual Cost will be updated 
on the Location when parts are put in to inventory, and captured in IACJ.  

Note: When 'Overhead Posted from Time and Attendance' is checked, variable overhead is still calculated 
and associated with the correct FG_MULTI record when a clock out occurs and 0 good parts are 
reported. 

Note: When 'Overhead Posted from Time and Attendance' is checked, the FGMULTI_COGS also tracks 
labor and overhead posted from Time and Attendance, so the COGS amounts are still calculated 
correctly. 

➢ Fixed Overhead records will post from Production Reporting and Floor Dispositions as they 
currently do:  

➢ (Number of Parts) * (Fixed Overhead Posted from Time and Attendance) 

➢ If an MFG type does not have 'Overhead Posted from Time and Attendance' checked and 
Task Clock Labor hours associated ot the MFG type are posted from Task Clock IN/OUT 
Maintenance, Variable Overhead will NOT post to Translog. 

➢ If a floor disposition occurs involving an item associated with an MFG type that has both 
'Labor Based Rate' and 'Overhead Posted from Time and Attendance' checked, the Variable 
Overhead will not post to Translog until the Labor record is also posted.  

➢ If an item is associated with an MFG type that has both 'Labor Based Rate' and 'Overhead 
Posted from Time and Attendance' checked, the system does not use the value in the 
'Production Hours' field for the Overhead calculation when the Production Report Line is 

dispositioned because the Variable Overhead record has not been posted to Translog yet. 
The Variable Overhead record will not be posted to Translog until the Labor record is posted. 

➢ If 'Overhead Posted from Time and Attendance' is checked and Actual Costing is enabled, 

whenever Labor records are posted to Translog, Fixed Overhead records are also posted to 
Translog. The Fixed Overhead record in Translog will mimic the Variable Overhead record 
created in Translog whenever Backflush on Clock OUT occurs with Standard Costing 

enabled. The Fixed Overhead Actual Cost posts as the following:  

➢ (Number of Parts) * (Fixed Overhead Cost of the Cost Element's Standard Cost) 

Note: The Fixed Overhead cost is only the top level item's Fixed Overhead Cost - costs of components are 
not included in the calculation. 

Note: The TA_LABOR table holds the Number of Parts records. 

Note: The 'Overhead Posted from Time and Attendance' option is designed to use PRS (Production 
Reporting by Shift and PRW (Production Reporting by Work Order) modules as its reporting methods. 
Attempting to use other reporting methods may result in errors. 
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Note: Labor based overhead is not applicable to the Treatment MFG Type and will be grayed out so users 
will be unable to select this option. 

General Tab: 

➢ Shift Backflush Rules - This option is available for applicable Mfg Types (Injection, Blow 

Molding, Extrusion 1, Extrusion 2, Extrusion 3, Rotational, SFOAM, Stamping, and 

Thermoset). From this setting the user can establish the default Shift Backflush Rule for a 
Manufacturing Type. When creating new BOMs for a Mfg Type with a default Shift backflush 
Rule the system will assign the default rule automatically. The default Shift Backflush Rule is 

also used when converting a quote to BOM for the designated Mfg Type. 

➢ Backflush on Clock Out - If this option is checked when the user clocks out of a task they will 

be prompted with the Floor Disposition screen. From the floor disposition screen the user 

can enter the quantity of parts produced while clocked in to the task. Note: This option 
requires RealTime to tie the floor disposition transactions to Production Reports. For Non RT 
users please see the “Non RT Backflush” option below. 

➢ Non RT Backflush - If the Backflush on Clock Out option is checked the Non RT Backflush 

option becomes available. With both the Floor Dispo and the Non RT Backflush checked 

when the user clocks out of a task they will be prompted to disposition parts from the work 
order they clocked out of and backflush components. This backflush is not tied to the 
production report. The transactions are made in inventory and tied to the labor record. 

➢ Use Yield % on BOM - If this box is checked the BOM 's associated to the MFG Type will say 

'Yield %'  instead of 'Scrap %'. 

➢ RT parts to go based on scans - This option is available for all Mfg Types except ASSY1, ASSY2, 

ASSY3, Outsource and JobShop. If this is checked, a warning message will display, 'You 
must close and reopen the RTServer.exe for this to take effect'. Once RTServer is restarted 
RealTime monitoring parts to go count, as well as any other field calculated from Parts to 

Go, including Shift Parts and Total Parts will not be changed until an RF scan / floor 
disposition transaction is done. Cycles will accumulate, up time, downtime, etc will be 
monitored. Note: Rejects will not affect parts to go.  

Note: For User Defined MFG Types this is a pass through feature from the default MFG Type. For 
example: If the standard Injection MFG Type is checked on RT Parts to Go is based on scans, then all UD 
MFG Types with the default as Injection will decrement by scans and not cycles. 

➢ Include scrap in By-Product weight calc - This option only applies to the Thermoform MFG Type. 

With this option checked if scrap is added to the main form of the BOM, it will be included in 
the by-product weight on the item details tab. 
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➢ Logical Work Center Support - This option only applies to the Injection, Die Cast, Generic, 

Extrusion, Extrusion 2 and Extrusion 3 Manufacturing Types, or user defined types based on 
those MFG Types. This is designed to create logical work centers running multi-position mold 

frames. When this option is checked, on work centers, a tab called 'Change Over' appears. 
Please see the Logical Work Center https://my.iqms.com/cfs-
file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf TechNote for 

more information. 

➢ Do not round up dependent demand - With this checked the dependent demand will not be 

rounded up to the next whole number on dependent work orders. If this option is checked, 

the quantities will be calculated and displayed with full decimal precision to mirror the BOM 
Tree explosion. This setting also applies to the 'Explode Forecast' tool in the Forecast 
module. When exploding a Sales Analysis Forecast, the quantity for dependent demand will 

be rounded up to the nearest whole number unless this option is checked for the relevant 
Manufacturing Type. This applies to all MFG Types except MBATCH, JobShop, ASSY1/2/3, 
EXTRUSION2, SLITTING, COMPOUND1, and OUTSOURCE. Important Note: Any MFG Type 

that makes an item in EACH will round, regardless of this setting. 

➢ Std costing calc to consider family tool part weights - This option only applies to the TFORM2 Mfg 

Type. When this is checked the standard cost calculation for TFORM2 items will take into 

account the part weight of each member of the family tool.  The calculation will be very 
similar to the standard cost calculation for the THERMOFORM Mfg Type. 

➢ Add Floor Disposition Out Qty to Calculated Usage - This applies to all Mfg Types except ASSY 1, 

2, and 3. If this is checked the out disposition quantity will be added to the calculated 
material usage during production reporting by shift. If it is not checked it will replace the 

calculated material usage in the production report. Note: This applies only if the work center 
has the 'Floor Actual Material Usage' option checked. 

➢ Use SN Labels to Control MTO Dispositions - When this option is set to Yes, MTO releases will be 

combined on work orders rather than getting a work order for each release (including 
multiple customers/orders). All other allocation functions of MTO will remain the same, only 
bucketing is different. When printing labels, the Order # drop down will reflect the customer 

for that order on the label. This option can be set at the Manufacturing Type level, which will 
override the default setting in System Parameters->Purchase Order and Sales Order Setup 
tab. Choices in the drop down are System Default, Yes, and No. ‘System Default’ will look at 

the global setting. A selection of ‘Yes’ will enable the ‘Use SN Labels to Control MTO 
Dispositions’ functionality for the specific Manufacturing Type. If ‘No’ is selected the 
functionality will not apply to that particular Manufacturing type. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/Logical_2D00_Work_2D00_Centers.pdf
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➢ Auto Substitute BOM - When this setting is enabled, when attempting to add a work order to 

the first position (in EIQ or ShopData), the system will look to see if the BOM on the work 
order is already scheduled in the first position on a logical work center. If the same BOM is 

already scheduled/running on a logical work center, and the user is trying to add it to a 
different logical work center then a substitute BOM will be created before adding the work 
order. A security enabled warning message will appear: “Attempting to schedule this work 

order on a different logical work center than the currently running BOM. What do you want 
to do?" The warning message that surfaces will give the user the option to 'Create a 
substitute BOM' or 'Do not create substitute BOM'. There is also a “Do not show again” 
check box. Note: This option is visible on all MFG Types but will not affect anything unless 

the MFG Type also has 'Logical Work Center Support' enabled. 

➢ Plug Value - This is used for informational purposes only. 

➢ Disposition all Hard Allocated raw material when work order is marked "Prod Finished" - This option 

can be set at the Manufacturing Type level so that when materials are backflushed for a 
work order that has been marked 'Prod Finished' either by selecting 'Workorder xxx is 

finished' when performing a setup in RealTime™ or Scheduling, or when it is manually 
checked in the production report, all hard allocated materials will be removed from inventory 
instead of the calculated required quantity. For example, if the quantity hard allocated is 

1500 and the required quantity based on what was manufactured is 1250, the system would 
remove the 1500 when this is checked, if not checked it would remove 1250. If some 
required material was not hard allocated the system will calculate the material usage using 

the standard method, i.e. by evaluating total cycles and parts counted, etc. 

➢ The system will look at the Work Center/Manufacturing Cell that the work order actually ran 
on when verifying whether or not the options are checked. This also applies to Non-

RealTime Production Reporting by Shift (PRS). If a work center/Manufacturing Cell is 
selected that differs from the one the BOM has assigned, the Work Center/Manufacturing 
Cell in PRS will be used. 

There are three options that can be selected from the drop down list: Yes, No, and System Default.  

▪ Yes - When Yes is selected the option is enabled at the this level. 

▪ No - When no is selected the option is not enabled at this level and the system will not continue 
looking at the hierarchy. 

▪ System Default - By default it is set to 'System Default'. If system default is selected the system will 
evaluate the hierarchy.  

A mouse-over hint is available when hovering on the setting that will let the user know which level of 
hierarchy will be used for both options (Disposition all Hard Allocated... and Freeze Consumption...), and 
what the values are. For example, "All hard allocated materials will be consumed. Consumption beyond 
hard allocated will not be frozen. Hierarchy Level = System". 

The hierarchy for this option is: 

1 Work Center 

2 Manufacturing Cell 
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3 Manufacturing Type 

4 Production Reporting by Shift Parameter 
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Note: This feature is available for all MFG types except ASSY2, ASSY3, and COMPLEX. 

➢ Freeze consumption beyond hard allocated - This option will be available if the 'Disposition all 

Hard Allocated raw material when work order is marked "Prod Finished"' option is checked. 
If this option is enabled and 'Prod Finished' is checked for the work order, the system will 
not consume more material than what was hard allocated. 

Note: When dispositioning the item the system will show material/components that were not hard 
allocated to the WO and only freeze consumption of material/components that were hard allocated but 
have been brought to zero through Return to Inventory or consumption. 

General Tab for Assembly MFG Types (ASSY1, 2 and 3): 

➢ Process Certification – (This only applies to ASSY1) Select the desired process certification 

from the drop down list. The Certified tab in Assembly Process Maintenance will adjust 

depending on the selection made here. There are two choices: 

▪ Certified Jobs – (Default) - Users can specify job requirements for running the process. This will limit 
which employees can log into a specific process. Only those employees with an active certification 
level high enough for the specific job can log into the process. 

▪ Certified Employees – With this option selected individual employees will be certified on a process 
rather than a job. 

➢ No Supervisor required for Final Assembly – This option controls whether a supervisor is required 

to enter the Final Assembly in AssemblyData. 

Note: The ‘Process Certification’ and 'No Supervisor Required for Final Assembly' settings will be 
determined by the default predefined ASSY MFG type for any user defined MFG Types based on the ASSY 
type.  The reason for this is the potential to have the same process linked to multiple BOM's. 

➢ Dispo IN and OUT Locations – A disposition In and Out location can be entered here. Click on 

the ellipsis button and select a location from the pick list. The Mfg Type dispo designated 
locations will fit into the hierarchy after the Mfg Cell dispo designator locations for both IN 

and OUT locations. This option is also available on user defined MFG Types that are based 
on the ASSY Type. 

➢ Use Percent Complete Reporting - (For ASSY1 and ASSY2 MFG Types) - If this option is 

checked, when reporting labor for an ASSY1/ASSY2 work order/process, a percentage can 
be reported against a process instead of entering a quantity.  In Assembly Track and 

JobShop, the Progress bar in the Process Details will display the last percent complete that 
was reported.  Material attached to the process being reported on will not be backflushed 
until Final Assembly Reporting. 
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➢ Consume Raw Material by Process - If the 'Use Percent Complete Reporting' option is selected 

this option is available. If this option is unchecked, in Assembly Track-> Labor Reporting, 
the Report Consumed Materials tab will be hidden. Material will be backflushed upon Final 

Assembly.  If this option is checked, in Assembly Track-> Labor Reporting, the Report 
Consumed Materials tab will be visible to enter a value of components to be backflushed. 
Upon Final Assembly the system will not backflush material. 

➢ Backflush Each Process - (For ASSY3 only). If this option is checked, when clocking out of a 

process in AssemblyData or labor reporting in Assembly Track, the system will backflush the 
components.  When performing Final Assembly, it will not backflush the components. This 

allows users to be able to finite schedule a work order to an Assembly Line and still allow for 
backflushing at each process.  

Note: If this option is not checked, the Processing Time on the BOM must be calculated using the Process 
Throughput Map button. If it is not calculated the system will have no way to know when material(s) are 
required so it will assume it will end on the last day. 

➢ Launch Final Assembly Reporting on designated process - If this is checked users can designate a 

single process in the Assembly BOM that will launch the “Final Assembly Reporting” form. 
The Assembly BOM can only have one process designated as “Final Assembly Reporting”. 

➢ Use SN Labels to Control MTO Dispositions - When this option is set to Yes, MTO releases will be 

combined on work orders rather than getting a work order for each release (including 
multiple customers/orders). All other allocation functions of MTO will remain the same, only 
bucketing is different. When printing labels, the Order # drop down will reflect the customer 

for that order on the label. This option can be set at the Manufacturing Type level, which will 
override the default setting in System Parameters->Purchase Order and Sales Order Setup 
tab. Choices in the drop down are System Default, Yes, and No. ‘System Default’ will look at 

the global setting. A selection of ‘Yes’ will enable the ‘Use SN Labels to Control MTO 
Dispositions’ functionality for the specific Manufacturing Type. If ‘No’ is selected the 
functionality will not apply to that particular Manufacturing type. 

➢ Auto Substitute BOM - When this setting is enabled, when attempting to add a work order to 

the first position (in EIQ or ShopData), the system will look to see if the BOM on the work 
order is already scheduled in the first position on a logical work center. If the same BOM is 

already scheduled/running on a logical work center, and the user is trying to add it to a 
different logical work center then a substitute BOM will be created before adding the work 
order. A security enabled warning message will appear: “Attempting to schedule this work 

order on a different logical work center than the currently running BOM. What do you want 
to do?" The warning message that surfaces will give the user the option to 'Create a 
substitute BOM' or 'Do not create substitute BOM'. There is also a “Do not show again” 
check box. Note: This option is visible on all MFG Types but will not affect anything unless 

the MFG Type also has 'Logical Work Center Support' enabled. 

➢ Plug Value - This is used for informational purposes only. 

For more information on the ASSY MFG Types please refer to the ASSY Manufacturing documentation. 
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File Menu: 

Alter Lbs/K Calculation - This option is only available to the Injection and Diecast MFG Types, and for 
Custom MFG Types that default to Injection and Diecast.  Injection and Diecast MFG Types can have a 
different percent. There can only be one % value for Injection and custom MFG Types like Injection, and 
the same is true for Diecast and MFG types like Diecast. 

From the File menu select the ‘Alter Lbs/K Calculation’ option. A screen will appear for users to enter in a 
different percent of the runner and sprue to be used when calculating the Lbs/K for BOM’s associated to 
the selected manufacturing type. This defaults to 0.   

 

After entering a new percent the user can check the ‘Recalculate all BOM’ box to have the system 
recalculate the Lbs/K for all BOM’s associated to the selected manufacturing type.  

When users do not check the Recalculate BOM box, what is calculated depends on where the changes 
are made: 

▪ When on a Diecast BOM and the user goes to Configure->Mfg Types, selects Diecast and changes the 
% but does not check Recalculate BOM. When they exit the form only the BOM they were on will 
recalculate. 

▪ When on an Injection BOM and the user goes to Configure->Mfg Types, selects Diecast and changes 
the % but does not check Recalculate BOM.  When they exit the form no BOMs are recalculated. 

▪ When on a Diecast BOM and the user accesses Mfg Types from the Launcher File menu or from Lists 
in System Parameters, when they change the % and do not check Recalculate BOM, when they exit 
Mfg Types and refresh the BOM form that BOM is recalculated but other Diecast BOMs are not. 

▪ If the BOM form is not open and the user accesses Mfg Types from the Launcher File menu or from 
Lists in System Parameters, when they change the % and do not check Recalculate BOM, when they 
exit Mfg Types, no BOMs are updated. 

Example Calculation: 

The Alter Lbs/K value only applies when AA - AB < Cavity * Part Weight 

AA is the Shot Weight, taking into account runner/sprue and scrap = (Cavity * Cavity Weight + 
Runner/Sprue) / Yield 

AB is the Shot Weight * regrind percentage = AA * (Regrind / 100) 
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Example:  Cavity * part weight is 12.05 and Regrind is 5% 

AA = (1 * 12.05 + 12.05)/ .95 

AA =  25.3684 

AB = AA * (Regrind / 100) 

AB = 25.3684 * .05 

AB = 1.26842 

AA - AB = 24.1 

24.1  is not less than 12.05,  so with these numbers the Alter Lbs/K value is not used 

If Regrind is 75%: 

AB = 25.3684 * .75 

AB = 19.0263 

AA - AB = 6.3421 

6.3421 is less than 12.05,  so with these numbers the Alter Lbs/K value is used. 

Please see Calculations for LBS/K Cycles for more information. 

User Defined Conversion Factor 

Each MFG Type has default values for the basic calculations such as cycle time and shots per hour. This 
function allows the user to override the defaults and create user defined factors for a specific MFG Type. 

Select the  speed button to open the form to input the conversion information for the highlighted 
MFG Type. The form will be empty when first opened. 
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Select the speed button on this form to add all of the fields available for creating user defined 
conversions, or select the arrow down button next to the speed button to choose a single item. 

For each field selected the Default Caption will fill in automatically. 

 

The user can change the caption and/or the unit of measure: 

▪ UD UOM - To change the unit of measure, double-click in the UD UOM field and the following Define 
UOM form will appear: 

 

Choose the desired unit of measure (Second, Minute, Hour, or Day) from the drop down list and select 
OK. The user defined caption will fill in automatically with the selected UOM but can be overridden. The 
Factor field is based on the UOM chosen and cannot be edited. 

▪ UD Caption - To change the caption that appears on the BOM form for this MFG Type enter the 
information in the UD Caption field. 
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Creating a New BOM 

The following information is specific to the Injection manufacturing type, however several MFG Types 
such as Die Cast, Rotational, RIM, and Stamping are very similar. The terminology used on the BOMs will 
be changed to apply to the specific manufacturing processes. Examples of other manufacturing types are 
available at the end of this section. 

Minimum Requirements 

Each manufacturing configuration must contain at least the following information. Be sure that this data 
is available prior to entry: 

▪ Manufacturing Configuration Number (Mfg#) 

▪ Cycle Time in seconds 

▪ Work Center Type (normally the press tonnage this configuration should be scheduled on) 

▪ Item number and Description (each standard allows unlimited items per configuration - family tools). 

▪ Material designation 

Optionally, the following information should be available: 

▪ Insert information 

▪ Packaging information 

▪ Operation information 

▪ Instructions detailing machine setup, manufacturing process, operation notes, quality control and 
auxiliary equipment. 

Accuracy is Important 

As you enter in the configurations, make sure the information is as correct and complete as possible. 
Accuracy is very important because all calculations and assumptions are based on this information. 

Before You Begin 

Prior to the entry of Manufacturing Configurations, be sure that all the basic information has been 
entered as outlined below: 

▪ Customer Data 

▪ Raw materials 

▪ Inserts (purchased components) 

▪ Packaging 

▪ Work Centers 

▪ Vendors 

NOTE: The section following will outline the guidelines for creating a standard BOM for injection 
molding. To create Generic, Extrusion, or Outsource BOM’s please see those sections later in the 
chapter. 
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Use the following information to understand the basic process of creating a new BOM. The Injection 
BOM is used as it illustrates the basic steps for all types of BOMs. Specific information concerning the 
Extrusion, Thermoform, Generic and Outsource BOM is available later in this chapter. 

Many of the steps are similar regardless of BOM type, and they are described once in the following 
section. For example, adding components, packaging, documents and auxiliary equipment are all 
handled in an identical manner for all manufacturing types. 

To create an injection BOM follow the steps below. 

➢ From the EIQ Launcher Bar, click on the Mfg tab and select the BOM button. A pick list will be 

the first thing to appear even if no configurations exist in the database. 

➢ Click on the [New] button located in the lower right hand corner of the pick list screen. From 

within the main BOM entry screen, you can also select the ADD [+] function key or click on 

File|New Mfg Config to perform the same operation. 

➢ Upon selecting New (or Add), the following screen will appear: 



BOM-Manufacturing Configurations Page 27 of 273 

 

 
 

➢ Select a Manufacturing Type and/or Cell Type using the scroll bars or enter information in the 
white space to hyperbrowse to the desired Manufacturing Type or Cell. Press [OK] or 

[ENTER]. 

NOTE: The MFG Types that are visible by default are determined during implementation of the software, 
however many manufacturing types are available and the user may add them to the list. 

User defined MFG Types may be added by going to Configure/Mfg Types on the menu. If a user defined 
type is added it will display in red on the list and default to the calculations used by the Generic 
standards. User defined conversion factors may be created. 

Manufacturing Cells are used to designate separate areas in your facility for a single MFG Type. 
Manufacturing Cells allow a logical grouping of work centers. Separate scheduling and production 
reporting is done for each cell. When creating a BOM only the work center types associated with the 
selected cell will be available. For more information on MFG Cells please see the Manufacturing Cells 
section. 
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General BOM Information 

The main entry screen contains all of the standard information such as the customer, manufacturing 
type, cycle time, materials, and more. The example below displays an injection configuration, however 
the information applies to the majority of MFG Types, such as Diecast, Blow Molding, and Rotational 
molding. The main entry screen for creating an Extrusion, Thermoform, Generic, or Outsource standard 
is subtly different than the screen shown here and will be described later in this chapter. 

 

Note: When a user creates a User Defined Form field and grants security to that UDF field, if the UDF field 
is deleted the security to the field is removed. If the UDF field is re-added with the same name, security 
will need to be reestablished for users. 
 



BOM-Manufacturing Configurations Page 29 of 273 

 

Field Listings for Injection Standards 

The following is a field listing for an injection configuration. When greater detail is required to describe 
how the information is entered it will be described below the corresponding field listing. 

BOM/Standards Info 

Mfg # Up to 50 characters can be entered in this field. The number entered here is the number of 
the actual standard.  

Each configuration number and routing number combination must be unique. If the user 
enters a Mfg #/Routing Seq # combination that already exists, a prompt will be issued 
informing that a duplicate number was entered. The user will need to reenter a new Mfg or 
routing number. 

If the System Generated BOM # option is enabled in System Parameters->Sequential 
Numbering tab the Mfg # will be automatically populated with the next sequential number. 

Note: To view the STANDARD table ID for this BOM select the Alt F1 keys and a pop up will 
display the ID and the Table name. From the pop up users can right click to access copy, save, 
and print options. 

Routing Seq # This field can be used for informational purposes to define the routing step sequence of the 
BOM when there are several steps, or it can be used to differentiate between a BOM with the 
same Mfg #. This field and the Mfg # field are what makes a configuration unique. This field 
displays in the BOM pick list. 

Description The description of the BOM. This is optional but can be used to describe the BOM for 
reference. 

Hint: When using the same Mfg # but different routing seq #'s be sure to enter a unique 
description in order to differentiate between BOMs on the Manufacturing tab in Inventory. 

Customer This field is not required but BOM’s should have a default customer attached. For proprietary 
parts, attach your company as the customer. 

See the information below for more details. 
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Select a Customer from the drop down list or the pick list. From the drop down list begin typing the 
customer’s name and the system will hyperbrowse to the customer. If the customer does not exist in the 
hyperbrowse list, use the pick list located next to the Customer field and click on [New] to create the 
customer. Please see the section below on creating a customer on-the-fly. 

Creating a New Customer 

If a customer does not exist in the pick list or hyperbrowse list, one may be created by selecting the 
“New” button within the pick list. The following Quick Add screen will appear: 

  

➢ Enter the basic customer information such as company name, address, telephone, and 
contact. The status will default to Active, but can be changed by selecting a different option 
from the list. Note: The user must enter or select a Country first before the State drop-down 
list is populated.  Once the information has been entered press [OK]. You will be returned to 

the main BOM entry screen.  

➢ Once an existing customer or new customer is associated to the BOM, the user may right 
click on the Customer field and select Customer Docs to view or add any internal 

documentation associated with the customer, or you can also jump to Customer Maintenance. 
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Note: A record will be created in the Customer Maintenance module for this customer automatically. If 
you create a customer on the fly, you will need to go in and enter additional information (i.e. 
credit/sales, bill to, etc.) in the Customer Maintenance module. Creating a customer using this form 
supports only basic information. 

From RFQ # The information displayed here originates from the Quote module and will only be present if 
the standard was converted from a Quote. When a value is present the user can right click 
and jump to the quote. The quote the system will jump to is based on the quote ID 
associated to the standard. 

To change the quote the BOM is linked to, right click and select 'Edit RFQ Jump'. A pick list of 
quotes that exist for the same item number will appear to choose from. 

BOM Control # The field consists of today’s date, time and EnterpriseIQ user ID of the person who made the 
change. 

The BOM Control number will change automatically when someone makes a change to the 
configuration. This field cannot be edited. 

Note: Changing the Lot Number will not update the BOM Control Number. 

Note: The format of the Control # can be set in System Parameters->Company File 
Information->Application tab. If this field is blank it will default to MM-DD-RRRR-HH24:MI:SS 
(e.g. Username 03-16-2010-16:56:35). The user name is always the prefix. 

The format must start with a dash (-) . But the order of the  the 'RRRR', 'MM', 'DD', HH24, 
MI or SS can be changed. 

First Article Date Enter in the  First Article Date using the drop down calendar (Optional). This is the date that 
the configuration was first approved for use in a production run. This field is for information 
purposes only. 

This field description can also be changed by right clicking on the field and selecting the 
Define Label Text option. Enter in a user defined caption in the New Value field. The 
customized caption is based on Manufacturing Type. If the caption is changed for an Injection 
BOM, all of the Injection BOM’s will have that same caption but not other types of BOM’s 
such as Generic. 

Security can be placed on this field. 

Schedule 
Information 

The user can enter up to 250 characters of information that will display when a work order is 
scheduled to a work center that uses this BOM. A pop up form will appear with the note and 
includes a Cancel and OK button. If the user selects Cancel the job will not be added to the 
schedule. This note also displays on the Move Job form when moving the job between work 
centers, and is visible on the Unscheduled tab in the Scheduling Pool window. Security can be 
placed on this field (security item wwDBComboDlgInfo_Sched). 

The information can be printed using the Print button from the BOM or from the schedule. 

EPlant Name If you are using EnterpriseIQ’s EPlant module the EPlant you are logged into will populate the 
EPlant field automatically. It is not a required field if EPlant is not being used. 

To manually select the EPlant associated with the BOM click on the ‘Assign Plant’ button near 
the field. Select the EPlant from the drop down list in the One Plant field. Select the ‘Apply' 
button to update the field and automatically post it. If the 'OK’ button is selected the change 
is made, but requires a manual post by the user. 
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Inactive A BOM can be marked inactive. This will ‘hide’ the BOM from pick lists. To view an inactive 
BOM the pick lists have a new button in the upper right corner to ‘view inactive’ items. 

Note: An inventory item with an inactive BOM attached will be considered a purchased item. 

Note: When a BOM is marked Inactive with a Split Mfg Percentage populated in Inventory, 
user get a confirmation message “MFG# XXXXXXXX will be removed from Item # XXXXXX 
Manufacturing Load Split Percentage Calculation” with an “OK” button to continue. This 
removes the BOM from the grid of Split Manufacturing Load for the Inventory item. This 
message will not appear if the BOM has a value in the threshold field. 

 
 

Material/Regrind Section 

Material Spec. Enter the material that will be used for this job. This section has two fields--one will list the 
material item number and the other will fill in with the description.  

This is not a required field. 

To add the material, type in the first few characters of the material in the hyperbrowse list or 
select a material from the pick list near this field. Only primary materials will make up this list. If 
a material does not exist in the pick list, click on NEW to create the new material item. A blend 
may also be created by following this step. For more information on defining a blend, please 
see the section on Defining a New Blend Operation. 

The user can “Jump to Inventory” by right clicking on the description field. 

EPlant EPlant associated with material. This will fill in automatically. 

Runner/Sprue If this mold has a hot-runner system, the weight is zero. Most other types of molds will 
produce a sprue and/or runner that must be weighed. This information entered in this field is 
used to calculate how much material will be required and how much regrind will be produced. 
The UOM can be in grams, pounds or ounces. 

If the UOM is set to GR in the Quote module under Misc/Rates and Parameters, the system will 
use that for the BOM UOM regardless of whether the System Parameter setting is Metric or 
Imperial. If this UOM is set to null or any other value except GR the system will go to the 
System Parameters->Regional tab or EPlant Parameters (Enterprise->Miscellaneous tab) to 
determine whether to use the Metric or Imperial UOM. The UOM can be manually changed in 
the UOM field on the BOM. 

NOTE: Generated material requirements are based on the total CYCLE shot weight which 
includes all cavities and the runner and sprue. 

(This field is called Runner/Biscuit for the Diecast manufacturing type BOM, Waste Material for 
the Stamping manufacturing type, and Parison/Flash for Blow Molding). 
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Allowable 
Regrind% 

This field is used to enter the amount of allowable regrind that can be used for this job. 
EnterpriseIQ will assume regrind consumption up to this amount, if the job will generate that 
much. This field is used in the calculation for raw material requirements only, and is related to 
the Disposition Regrind option below. 

The user can choose to have the system check if the amount of regrind is available while the 
Lbs/K calculation is done. This switch is available under Options/Miscellaneous Parameters. If 
this is selected, when the program calculates the lbs/K, the calculation checks to see available 
regrind (100*Runner wt/Shot weight) and will give a warning if the allowable regrind entered 
exceeds the calculated available regrind. 

If the allowable regrind % is greater than the available the following warning box will appear: 

 

The user can choose to Replace the Allowable Regrind % with the calculated amount or Ignore 

the warning. 
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Shift Backflush This field determines how the material will be dispositioned (backflushed) at the time of 
production reporting.  

If the MFG Type associated to the BOM has a default 'Shift Backflush Rule' (MFG Types-
>General tab) the system will assign the default rule automatically. It can be overridden by 

selecting a different option. To access the screen click on the  Edit Shift Backflush 
Parameters button. There are three options: 

Total Cycles at Shot Weight - This is the default method. The system will calculate total cycles at 
total shot weight for the raw material usage. 

Total Cycles at Part Weight - If this option is checked the system will calculate the total cycles at 
part weight. The runner and sprue are not included in the calculation for raw material usage. 

Good Parts Only at Part Weight - If this option is checked the system will calculate the good 
parts only at part weight for the raw material usage. It assumes that all scrap, and the runner 
and sprue have been ground up and reused at the machine. In effect, this reduces the amount 
of virgin that should be removed from inventory. 

Regrind Option: 

If the user selects this option, the program will backflush from the regrind on hand based on 
the amount entered in the Allow Regrind% field. During dispositions, the program will reduce 
the amount of virgin material used by the quantity of regrind. This question has NO EFFECT on 
the total amount of material used. 

Example 1: Leave the box un-checked: 

During dispositioning, the program calculates that you used 100lbs of material. 100 lbs of 
virgin material and 0 lbs of regrind will be relieved from inventory.  

Example 2: Check the box: 

During dispositioning, the program calculates that you used 100 lbs of material. At 20% 
regrind, 80 lbs of virgin material and 20 lbs of regrind will be relieved from inventory. If you 
have no regrind in the inventory file, the regrind amount will go negative. 

 
 

Tool Information Section 

Equipment # The Tool equipment field is used to link a specific tool or tools which are used to run the 
configuration. The tool becomes equipment which can be tracked in the Maintenance, Repair 
and Overhaul module. 

Cycles for all tools associated with the BOM will be updated in Maintenance, Repair and 
Overhaul when a line item on a production report is dispositioned. 

Location This is the location of the tool. Select a location from the master location pick list. 

Primary Mark the tool that will be primarily used to run the configuration. Only one tool can be marked 
primary. This is the tool that will display in Scheduling and RealTime. 

Service Date IN 
and OUT 

These two fields show when the tool is out of service and when it will be back in service. See 
below for more information. 
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Multiple Tools may be linked to a configuration. Only one tool can be marked as the primary tool which 
will be the tool displayed in RealTime and Scheduling. However, all tools associated with the BOM will 
have the Total Units field updated in Maintenance, Repair and Overhaul when cycles are recorded on an 
archived production report. 

To link a tool to the configuration, click on insert record (+) button then click on the ellipsis button in the 
Equipment # field to bring up the following form: 
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➢ The user can either select an existing tool from the equipment pick list or create a new tool.  

▪ To pick an existing tool: Select the Class from the drop down list. This list will include all classes of 
equipment including user defined classes. Once a class is selected the pick list will be filtered based 
on that class. Select the Pick button and then select the Equipment from the filtered pick list.  

▪ Creating a new tool: To create a new tool enter up to 25 characters in Equipment # field. Enter a 
Description and select a Class from the arrow down menu near this field.  

In both cases the following fields may also be filled in: 

➢ Optionally enter a Location for this item using the drop down list of master locations. Most 

equipment may have a location code such as a rack number, or a floor position that specifies 

where they are supposed to be stored or returned. 

➢ The Service Date OUT and IN fields are used to designate when the tool is out of service and 

when it will be back in service. A warning will pop up when the ‘Service Out’ date entered for 

the tool is before or during scheduled jobs using that equipment.  The warning screen 
displays the work center, MFG#, and work order information, with a right click Jump to 
Schedule available. Depending on security the user can choose Ignore or Cancel.  The same 

warning pops up if a ‘Back in Service’ date is entered in which the date range conflicts with 
scheduled jobs. 
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➢ If the dates do not conflict with scheduled work orders or the ignore option is selected this 

will show up in the tool number field on the schedule after update schedule is run when the 
Out of Service date for the tool is before or during the start/end dates for the job in 
scheduling. This applies to all tools associated to the BOM, not just the one marked as the 

primary.The tool number on the line item associated with the out of service tool will be 
yellow and show the date the tool is out of service.  

➢ When adding an item to a sales order, if the tool associated to the item's default BOM is 

currently out of service, a pop up message will display stating, 'The tool is currently out of 
service.  Continue?' Users can select Yes to continue adding the item to the sales order, or 
No to not add the item. There is also a 'Do not show next time' check box which can be 

checked so that this message will not appear. Security can be placed on this form.  

Continue this process until all tools which run this configuration are linked to the BOM. Be sure to check 
the Primary box for the primary tool. 

Jump To MRO 

Once tool information is added the user can jump to Maintenance, Repair and Overhaul for the 
highlighted Tool Eq # by right clicking in the Tool Info area. 
 

BOM Manufacturing Details Section 

Mfg. Type This field shows the TYPE of manufacturing associated with this standard. 

Cell Manufacturing Cells are associated to specific MFG Types and are used to designate separate 
areas in your facility. Manufacturing Cells allow a logical grouping of work centers. Group work 
centers by location, product line, process, etc… for separate scheduling and production 
reporting. 

Upon creation or modification of a BOM, if the Center Type does not match the Cell a pop up 
warning will appear stating, 'Selected center type does not match mfg cell - continue?'  Select 
Yes to make the change or No to return to the BOM with no changes. Security can be placed 
on the Yes button and the 'Do not show next time' check box. 

Cells are discussed in the Setup Manual under Manufacturing Cells. Refer to that section for 
more information. 

Center Type Required Field. The entry here is based on the Center Type field in the Work Center module. 
Select the Center Type from the alphabetized drop down list or the pick list. 

This field links the job to a particular type of work center, though it does not necessarily link it 
to any one specific work center. Conceptually, EnterpriseIQ needs to know what kind of work 
center is used in the production of the item. It does not need to know specifically which work 
center. Assigning a specific work center is done during scheduling, where the user will have 
many options when placing the job in a particular work center queue. 

When attaching a Type to a configuration, the required type should always be entered as the 
smallest work center size in which this configuration would run. As an example, a job that runs 
in a 100 ton machine may also be able to run in a larger machine, but probably not in a smaller 
machine. 

The machine scheduling portion of EnterpriseIQ will group production jobs together according 
to the type, though the user can override this behavior. 
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Cycle Time Required data. This field is the time, measured in seconds, from the start of one shot to the 
start of the next shot. EnterpriseIQ will convert cycle time in seconds to shots per hour on all 
production reports. 

Seconds per cycle can be calculated from parts per hour by this simple equation. Divide parts 
per hour by the number of cavities in the tool, then divide 3600 by that number to achieve 
cycles in seconds. Conversely, shots per hour is calculated by dividing 3600 by the seconds per 
cycle. 

NOTES: 

▪ The system will not allow users to enter a cycle time that will end up being 0 (ex: cycle time = 
0.0000278) because of the rounding to 4 decimal places. 

▪ For the RIM and Rotational MFG Types the cycle time defaults to minutes. 

▪ The unit of measure for cycle times for specific MFG Types can be changed. Please see User 
Defined Conversion Factor in the Modifying  Manufacturing Types section for more 
information. 

SetUp Hours 1 This is the typical time in hours required to set up the tool. Use a close estimate, but 
remember that it could vary from time to time based on the previous job. The schedule will 
add this amount of time to each work order, or bucket, for this configuration. 

This field can also be used to determine the set up cost portion for a manufactured item. Setup 
Labor can be broken out on the standard cost of a manufactured item. This option must be 
turned on in system parameters (Sys Setup->System Parameters->Inv Setup tab). When 
activated, the user can add a cost element and type to an employee level. There are two 
supported types: Setup and Production. When the standard cost is calculated the system will 
check to see if this option is on and if so will break out the labor costs to the cost elements 
attached to any employee levels on the BOM. For “Production” types, the calculation will 
remain as is. For “Setup” types, the system will look at the number of setup hours 1 on the 
BOM times the number of operators for that type times the rate for the employee level 
divided by the standard run qty. Please see the Standard Cost section for more information. 

SetUp Hours 2 This field is used in the schedule when the same tool is running consecutively in a machine 
instead of Setup Hours 1. If the same tool is running back to back in a work center the Setup 
Hours 2 value will be used instead of Setup Hours 1. For example, this value can be set to zero 
and if the same tool will be running back to back the schedule will not add the set up time to 
the schedule which will provide a more accurate end time for the job. 

Eff. Factor This field will automatically populate from the default Efficiency Factor field in Miscellaneous 
Parameters (BOM->Option menu) when creating new BOM's but can be overridden for an 
individual BOM. 

This field is used to help EnterpriseIQ plan for an assumed production time. Entries made here 
will effect the Net Cycles/Hr and Hours/K fields in the Production Summary. EnterpriseIQ uses 
the Net cycles per hour to determine the length of a production run. 

Scrap% or 

Yield % 

Depending on the setting for the MFG Type ('Use Yield % on BOM' on the General tab in MFG 
Types)  this will display as Scrap % or Yield %. 

Scrap % - This is the estimated amount of scrap that the process itself will generate. This is 
used in calculating the extra production time and material needed to complete the run. It is 
used on the Lbs/K calculation for raw material. Adding a scrap rate will affect the effective 
cycles per hour. Because each configuration can have it’s own scrap rate, you should not 
include any other anticipated scrap usage here. 

Yield % - The estimated % of good product yielded during the operation.  
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Labor This is the labor required at the work center to run this operation. This field is used to compute 
the labor hours required to complete the work order. 

To enter the required labor click on the ellipsis button in the labor field and the following form 
will appear: 

 

From this screen click on the ADD (+) button, enter in the quantity of operators required (this 
does not have to be a whole number) then select the Employee Level Code from the drop 
down list. The Labor Rate will fill in with the rate associated with the code. (Note: Security can 
be placed on the Labor Rate field so that it is hidden from the user in the BOM and the Work 
Order). 

The user can select multiple labor codes and associate fractions of operators per code or 
multiple operators per code. 

EnterpriseIQ supports a range of 0.00 to 999 operators per job. A number less than 1 can be 
used for jobs running automatically and an operator is not always at the press. For these tools, 
a partial number such as 0.5 is entered depending upon the number of machines the operator 
is tending. 

The Employee Levels list is created in Sys Setup->System Parameters->Lists. An unlimited 
number of employee levels may be created for use in the BOM and RFQ modules. The system 
comes with a Default labor code. 

If the Default labor code is selected the system will use the labor rate associated with the 
specific BOM (BOM->Options->Misc Parameters->Labor tab). If that is blank it will use the 
labor associated with the Manufacturing Cell. If the cell does not have a labor rate associated 
with it the system will use the labor rate associated with the Manufacturing Type. 

Users can access the Employee Level list to add or edit the records by clicking the icon in the 

top left corner of the form . (Security is available on this button). 
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UOM The Unit of Measure of the runner and sprue and the part weight.  The default UOM is set in 
the Engineering Quote module under Miscellaneous->Rates and Parameters.  

The UOM will be converted to the nearest Imperial/Metric version of the UOM depending on 
the setting in System Parameters->Regional tab or EPlant Parameters (Enterprise-
>Miscellaneous tab) for Imperial or Metric UOM.  

 

To change the default, click on the arrow near this field and select whether it will be in grams, 
pounds or ounces. Be sure to click on the ‘Convert To’ button in order for the weights to 
convert accurately. If the ‘Save As’ button is used the weight entered is not converted but 
simply saved as the new UOM as the weight entered. If the UOM field is changed it affects the 
units of measurement for this BOM only. 

FG Lot # This selection allows the user to assign a Finished Goods lot number to the configuration. For 
additional information on this field, please see the Finished Goods Lot Number section below. 
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Max WO Batch 
Size 

Enter the maximum work order batch size if desired. This will break up the sales order releases 
into multiple buckets if necessary on the work order(s). For example: The sales order release is 
2000 pieces, and the Max WO Batch is 500. Assuming zero on hand the system will create four 
work orders for 500 pieces each. For family items on order, a separate work order is created 
for the max quantity of each item. The Must Start dates on multiple work orders created from 
a BOM with a setting for Max WO Batch Size are incremented based on the estimated 
production time. The system starts with the original must ship date and backs up in groups 
based on the batch size. The difference is put into the last record. The must start is the must 
ship of the preceding record. This guarantees it will finish exactly on the requested must ship 
date. 

Note: Work order creation also takes into account the Mfg Min Qty inventory setting when 
used in conjunction with Max WO Batch Size on the BOM. 

Note:  Similar to the Inventory setting MFG Min Quantity, entering a value in this field will 
create a separate work order for each release quantity. 

Note: If a manual work order is created with a quantity greater than the Max WO Batch Size, or 
if a planned work order is firmed and then the quantity is changed to be greater then the Max 
WO Batch Size a status exception will appear stating 'Max WO Batch Size Exceeded'. It will 
include the WO #, BOM#, WO quantity and Max WO Batch Size. The form includes OK and 
Cancel buttons. Security can be placed on the OK button. For family tools, if any item exceeds 
the BOM Max WO Batch size, the status exception will surface. 

Assy @ Mach This option should only be checked when setting up an assembly at the press configuration, 
where you need more than one produced part to make the final assembly. For example, if it 
takes two cycles to make enough parts to create the actual part number, click this option.This 
changes the terminology on the Item Detail page from Cavities to Multiplier. 

For example, the multiplier can be set to.5 of a part. This means that only half of the part is 
made each cycle. With this knowledge, EnterpriseIQ understands that it will take 1000 cycles 
to make 500 parts. 

The weight entered should be the total weight of the items assembled. In the above example 
the weight should the weight of the two items together (i.e. doubled). 

Right Click Options: 

From the General BOM tab users can right click and select: 

▪ Trace BOM - This opens the Trace form to view changes made to fields setup in Trace for the 
Standard table.  

▪ Jump to Process Monitoring Mfg # Setup - For users with a license for RT Process Monitoring, this 
option will jump to the Process Monitoring Mfg # Set up module with the current BOM highlighted. 
For more information see the RT Process Monitoring TechNote https://my.iqms.com/cfs-
file.ashx/__key/Technote/RealTime_2221_-Process-Monitoring.pdf. 

▪ Jump to Sales Configuration Template - When this option is selected, if the BOM is only associated to 
one sales config template, that sales configuration template will open. If the BOM is associated to 
multiple sales configuration templates, a pick list of templates will display to choose from. 

 

https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Process-Monitoring.pdf
https://my.iqms.com/cfs-file.ashx/__key/Technote/RealTime_2221_-Process-Monitoring.pdf
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Finished Goods Lot Number 

A single Finished Goods lot number can be used to trace all raw material lot numbers associated with the 
production of the finished good. The FG Lot number is stored with the item during production. Any raw 
material lot number of any items consumed during the creation of the part is automatically linked to the 
FG lot number. 

FG Lot numbers can be maintained within the BOM. They can be manually set here, or from the 
RealTime system. 

In addition parameters can be set in Scheduling to automatically increment the Lot number or use the 
work order # at Setup for work orders on work centers that are connected to RealTime (see Increment 
Lot # at Setup and Use WO# as Lot # in the Scheduling Parameters section for more information). 

This section describes how to create and maintain the FG Lot number. 

To CREATE a new FG Lot #: 

➢ Click on the Set Next FG Lot # icon. 
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➢ From this screen, select Next Lot #. 

▪ Next Lot # simply tells the system to apply the next lot number to this item. The next lot number is 
the next sequential lot number maintained by the system. Note: With ‘Use WO as Lot#’ checked, if 
the user wants to change the lot number using the ‘Next Lot#’ button on the ‘Set FG Lot#’ screen, the 
specific MFG Lot# increments unless the 'Retain Assigned Lot# for this Work Order' is checked for the 
firmed WO. 

▪ General - This field shows the last number used when Next Lot # was selected for any item. 

NOTE: Alpha characters cannot be used in the Lot Number field if you are going to use the auto-
increment feature. 

▪ User Defined -The user can also choose to type the lot number in the field rather than use the system 
generated lot number. 

▪ Assign user defined lot # expression - This option allows the user to build a lot number from a SQL 
expression. Select the 'Set FG Lot #' button to access this option. Up to 4000 characters may be 
entered in the pop up form. Example expression: 

select 

NVL( rtrim( substr( misc.get_eplant_name, 1, 1)), ' ') || 

substr( to_char( sysdate, 'YYYY' ), -2) || 

to_char( sysdate, 'MM' ) || 

LPad( fg_lotno, 5, '0') 

from params 

The Work Order ID can be used as a parameter. Here is a sample SQL:  

select mfgno || '_' || :workorder_id 

  from standard 

where id = :standard_id 

The FG lotno generated in this example is mfgno+workorder_id.  If the Lot # is generated from the 
BOM, the result is mfgno+0.  Elsewhere, where the workorder_id is known the result is 
mfgno+workorder_id. 

Notes:  

▪ If the workorder_id is included as a parameter in the user defined lot # expression, when the FG lot # 
is generated from a form that does not know the workorder_id, be aware that the FG Lot # will be 0, 
unless the SQL is written to include what to do when workorder_id is null.  

▪ 'Increment/Change Lot # at Setup' must be checked in Scheduling Parameters for this to work on 
setup.  

▪ If 'Use WO# as Lot #' is checked the SQL expression does not kick in.  
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▪ The FG Lot# field is 25 characters long. Using a sql statement to create the lot # may generate a lot # 
that goes over the character limit. 

When setting up a work order in the first position or adding a work order to a work center when there 
are no jobs currently scheduled, if the user defined expression is invalid users will receive a general SQL 
error stating, "While evaluating user assigned Lot # expression the following error occurred:...invalid SQL 
statement...". 

Ensure unique lot # per item - When this option is checked the system will assign a unique lot number for 
each item in a family tool. If the Scheduling Parameter's option to have the work order number be the 
lot number is checked, the system will use the work order number as the prefix for all items, but it will 
add a dash and a unique number for each item in the family configuration. If the work order is not being 
used as the lot number, the system will use the lot number associated to the BOM with a dash and a 
unique number following. This also applies when printing labels from RF/WMS. 

Exp. Date - If the item has the 'Expiration Date is Mandatory' option checked (Inventory->Additional tab) 
this field will be visible. For a new lot number a date must be entered or the user will get an error. Select 
the date from the drop down calendar. 

Using the Lot Number 

During production reporting, the finished good lot number follows the parts through to dispositions. At 
this point, the FG lot number is written to the Translog in the same record as the raw material lot 
number. 

This relationship allows the system to find any particular FG lot number and all other raw materials 
associated with the run 

When the option to maintain lot numbers from the BOM is used, that lot number will apply to all future 
production runs for this configuration until changed. The user must manually change the lot number 
from the standard or within the RealTime monitoring system screens. 

When changing the FG lot number to account for the next FG lot run, the system will automatically 
increment the lot number if Next Lot # is selected, or the user may enter their own Lot # by selecting Set 

Lot #. The system does not check for duplicates. 

Note: The BOM Control Number will not change if the lot number is changed through the BOM, 
RealTime, or Work Orders. 

Note: From the Work Order module - FG Lot # field - If the work order is marked Firm an additional check 
box will display on the Set FG Lot # form, 'Retain Assigned Lot # for this Work Order'. When this option is 
checked the system will populate the FG Lot # in the Work Order table (WORKORDER.FG_LOTNO), and 
the lot number that is assigned will not be changed by the system later with the work order number if 
the global Scheduling Parameter 'Use WO # as Lot #' is checked.  
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Production Summary 

Cycle/Hr Basic calculation based on the standard cycle time, and how many cycles will occur in one hour. 

Example: 

Assume 45 second cycle time 

3600/45 = 80 Cycles per Hour 

Net Cycles/Hr. The total number of assumed or net cycles that will be generated in an hour. This field is 
calculated by taking the number of seconds in an hour and dividing it by the cycle time, and 
then factoring in the scrap rate and the efficiency factor. This is the value used by the Work 
Order system to generate the total length of time required to manufacture the part(s). 

Example: 

(3600 / (cycle Time))(1-Scrap Rate percentage)(Efficiency Factor) = Net Cycles/Hr. 

Assume Cycle Time = 45 seconds 

Scrap rate = 4 

Efficiency Factor = 100 

(3600/45) * .96 * 1 = 76.8 Net Cycles per hour 

If the Efficiency factor was set to 90, then the Net Cycles per Hr = (3600/45) * .96 * .9 = 69.12 

Shot Wt. (Lbs) Shot Weight automatically calculates after you have entered in the manufacturing details. This 
field estimates the total amount of weight that the molding process itself will consume each 
cycle. This value is used in material planning, so accuracy is critical. 

If the UOM is in grams the calculation is as follows: 

(Cavity weight x # of cavities) + Runner & Sprue / 453.6 = Shot Weight in pounds. 

Hours/K Cycles This value displays the number of hours required to complete 1000 cycles. It is based on the 
Cycles/Hr. 

Assume 80 cycles per hour 

Hours/K = 1000/ Cycles per hour 

You can use this basic value to determine how many hours it takes to make one thousand parts 
by including the number of cavities for a part number. For example, if we assume the tool has 
two cavities, then: 

1000/80 / 2 = 6.25 Hours. This is how many hours it would take to produce a thousand parts. 

Hours/K Cycles does not show the number of hours to make a 1000 parts, because of family 
tooling issues. For example, a tool with several of one part number and one of another would 
not be easily represented in a single value. 

Lbs/K Cycles The number of pounds of material that it takes to complete 1000 cycles. Determined by Shot 
Weight times 1000. 

Edit the part weight, runner and sprue and scrap to modify this value. The information in the 
Calculations for LBS/K Cycles section describes the Lbs/K calculation. 
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These values are based on the parameters entered earlier. The Shot Wt. and Lbs/K Cycles values are 
dependent on the part weights. Changing any of the parameters, then saving the changes will force the 
system to recalculate and re-display the new results. 

 
 

Calculations for LBS/K Cycles 

The Lbs/K Cycles calculation contains adjustments for regrind use. 

The system will calculate the AA and AB values below to determine which formula to use for the LBS/K 
calculation. To find Lbs/K Cycles, the regrind percentage must be evaluated. 

AA (Shot Weight, taking into 
account runner/sprue and 
scrap) 

= (Cav. x Cav. Weight + Runner/Sprue) / Yield 

AB (Shot Weight x regrind 
percentage) 

= AA x (Regrind / 100) 

BB (Shot Weight when 
Regrind is considered)  

This is used to determine the 
LBS/K when there is regrind 
on the BOM 

See below for calculation examples. The calculation used depends on if the 
process will produce enough regrind. 

If the process will not produce enough regrind: 

BB = (Cav x Part Weight) + (Sprue x defined percent of runner and sprue*) 

If the process will produce enough regrind: 

BB = AA - AB 

Use the chart below for the values used in the LBS/K calculation examples: 

Cavities = 1 

Cavity Weight = 3 gr.   

(Please note, if you have a tool with more than one part 
attached, each part will be summed individually). 

Runner & Sprue = 12 gr. 

Scrap% = 5% 

Yield = (100 - Scrap) / 100 

Regrind% Two examples below: One using 25%, and one using 85% 

Given the above values: 

AA = (1 x 3 + 12)/(100-5)/100 

AA = 15/.95 

AA = 15.7895 
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AB = 15.7895 x .25 

AB = 3.947 

If Regrind = 0% then the following formula would apply: 

Shot Weight in grams x 1000 cycles / 453.6 (converts grams to lbs) or: 

((Cav. x Cav. Weight) + Runner & Sprue) / Yield x 1000 cycles / 453.6 

Using the above values, then: 

AA x 1000 / 453.6 

15.7895 x 1000 / 453.6 

Lbs/K Cycles = 34.81 

If Regrind is >0%  

If Regrind is >0% then one of the following formulas would apply depending on whether the process will 
produce enough regrind. The system does a comparison of shot weight less the shot weight times the 
regrind % to the cavity times part weight to determine which formula will be used. The first calculation 
checks to see if the Shot Weight less the Shot Weight times the Regrind Percentage is LESS than the 
Cavity weight total. If so, then the new Shot Weight (BB) will be equal to the total cavity weight plus the 
runner/sprue weight times defined percent of runner and sprue*. 

If the process will not produce enough regrind: 

[If (AA - AB) < (Cav x Part Weight)] then BB = (Cav x Part Weight) + (Sprue x defined percent of runner 
and sprue*). Essentially this will require more material (LBS/K will be greater than if the process will 
produce enough regrind). 

* The Defined percentage of runner and sprue can be set up for Injection and Diecast MFG Types, and for 
Custom MFG Types that default to Injection and Diecast, from Mfg Types->File menu->Alter LBS/K 
Calculation. (See Alter LBS/K Calculation in the Manufacturing Types section). The default is 10%. 

If the process will produce enough regrind: 

[If (AA - AB) > (Cav x Part Weight)] then BB = AA - AB. Essentially this will require less material (LBS/K will 
be less than if the process will not produce enough regrind). 

➢ Use the same example as illustrated above, this time using the Allowable Regrind value 
equal to 25%. The goal is establish a shot weight (BB), which takes into account regrind 

reusage. 

Example: 

AA - AB = 15.7895 - 3.947 = 11.8425 

Cav x Cav Weight = 1 x 3 = 3 

11.8425 > 3 so the formula used is BB = AA - AB 

BB = 15.7895 - 3.947 
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BB = 11.8425 

Therefore, Lbs/K Cycles = 11.8425 x 1000 / 453.6 

Lbs/K Cycles = 26.11 

➢ Use the same example as illustrated above, this time using the Allowable Regrind value 
equal to 85% 

Example: 

AB =  15.7895 x .85 = 13.4211 

AA - AB = 15.7895 - 13.4211 = 2.3679 

Cav x Cav Weight = 1 x 3 = 3 

2.3679 < 3 so the formula used is BB = (Cav x Part Weight) + (Sprue x defined percent of runner and 
sprue*) 

BB = (1 x 3) + (12 x .1) 

BB = 4.2 

Therefore, Lbs/K Cycles = 4.2 x 1000 / 453.6 

Lbs/K Cycles =9.26 

Note: If the runner and sprue is zero and the allowable regrind is greater than the scrap % the system 
will simply take the Part Weight * Std Cavity / 453.6 *1000 to determine the LBS/K value. 

Calculation examples for Regrind generated per 1000 part run 

Allowable Regrind = 0 

This calculation takes the total shot weight (AA), removes the cavity weight only, multiplies the 
remaining grams by 1000 cycles, then converts this value to lbs.: 

(AA - (Cav. x Cav. Weight)) x 1000 / 453.6 

15.7895 - (1 x 3) x 1000 / 453.6 

12.7895 x 1000 / 453.6 

Regrind generated per 1000 cycles = 28.195 lbs 

This makes sense because the runner and sprue contributes 12 grams per cycle, compared to the 3 
grams consumed by the actual part. This value will be very small if the runner and sprue represents a 
small volume of material consumed. 

Allowable Regrind = 25% 

Regrind generated per 1000 cycles run 

(BB - (Cav. x Cav. Weight)) x 1000 / 453.6 
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11.8425 - (1 x 3) x 1000 / 453.6 

8.8425 x 1000 / 453.6 

Regrind Generated per 1000 cycle run = 19.494 Lbs 
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Item Details Tab 

Once the general BOM information is entered, the user must add at least one item number. This 
information is detailed in the next section. 

Attaching Item Numbers 

A manufacturing configuration may contain more than one item number. The system provides the ability 
to enter multiple parts, along with packaging and components associated with each. 

To begin entry: 

➢ Click on the Item Details tab. The following screen will appear: 
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This screen contains a visual browser showing the relationships between item numbers that are made 
using this BOM, and other components and packaging items consumed during the same process. For 
example, you may create a part and immediately put the part in a box. When a work order is created 
that uses this BOM, then the production report will understand to add the finished good to inventory, 
and relieve the raw material and any attached component or package. 

By highlighting any item in the visual view (left side of the screen), the details will be shown on the right 
side of the screen. 

To ADD a manufactured item: 

➢ Click on the Add [+] function key located on the navigator bar within the Item Info section 
of the screen, or right click anywhere within the left side of the Items Details screen and 

select the 'Add Item' function. 

➢ From within the 'Add Inventory Item to BOM' screen, click on the Pick Item button to select 
an existing item from Master Inventory, or begin entering the item information in the fields 

provided. When adding a new item, be prepared to specify an item number, description, 
cavity weight, and the number of cavities before attempting to exit. For some manufacturing 
types, such as Generic, the system will automatically populate the Item # field with the MFG 

# from the General BOM Info tab. This value can be removed or modified. 

Note: A circular reference error will occur if a users attempts to add the Primary Material of a BOM as a 
manufactured part on the same BOM. 

The field listing below describes each field shown within the Add Inventory Item to BOM screen: 
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Class Shows the class of the item that you are adding to the BOM. When you first enter this screen, 
the class field will default to ‘FG’ for Finished Goods item but can be changed by selecting a 
class from the drop down list.  

The master class list can be accessed by selecting the button next to this field. 

Note: You can create a BOM for a PK class item. The manufactured PK items will be 
calculated like an FG item if it has a Standard ID associated to it. 

Item # Enter in the inventory item part number. 

Note: If the ‘System-Generated Inventory#’ option is enabled in System Parameters-
>Sequential Numbering tab, the system will populate the item number with the next 
sequential number. If the user clicks on the 'Pick Item' button and clicks 'New' on the 
pick list, the item # will be the same as what was generated. For example, if the next 
sequential item was '123', when selecting 'New' on the pick list it will still be '123'. The 
value can be overwritten if desired. 

Note:  If the ‘System-Generated Inventory#’ option is not enabled in System 
Parameters, for some manufacturing types, such as Generic, the system will 
automatically populate the Item # field with the MFG # from the General BOM Info 
tab. This value can be modified. 

Revision This field is optional though very important for tracking revisions to parts. It is used to 
distinguish between similar part numbers. (EnterpriseIQ sorts and stores unique part numbers 
based on Class, Item Number and Rev). You can use it to track any revisions made to the part 
and can also be retrieved in reports. 

The information can be typed manually or selected from a user defined list. (Uppercase is 
forced). To create the list right click on the Rev field and select ‘Edit User Defined List’. Select 
the + button and enter the text. (This field is only 15 characters  - any additional characters 
entered will be ignored). 

Unit This is the Unit of Measurement. Select the desired UOM from the drop down list.  

The master UOM list can be accessed by selecting the button next to this field. 

Description Enter a short description or common name of the item. The description entered here will be 
used throughout the system to identify this item.  

Extended 
Description 

Extended description field—use up to 100 characters for the description. 



BOM-Manufacturing Configurations Page 53 of 273 

 

Weight Enter the weight for a single item. The weight will be shown in either pounds, grams or ounces. 
If the UOM is set to GR in the Quote module under 'Misc/Rates and Parameters', the system will 
use that for the BOM UOM for Part Weight regardless of whether the System Parameter setting 
is Metric or Imperial.  If the quote parameter UOM is set to null or any other value except GR 
the system will go to the System Parameters->Regional tab or EPlant Parameters (Enterprise-
>Miscellaneous tab) to determine whether to use the Metric or Imperial UOM.  

If the default UOM was overridden it will look at the UOM field on the general BOM screen.  

Do not multiply the weight by the number of cavities. Do not include runner and sprue weight. 
Also, do not include any additional weight an insert might add. EnterpriseIQ is only interested in 
the amount of material used to create a single part, even if the tool contains multiple cavities. 

Note: The part weight displays out to eight decimal places when using pounds. 

Actual & 
Standard 
Cavities 

The Standard Cavity is the number of cavities in the tool for the item. The Actual Cavity is how 
many cavities in the tool for the item are functioning. 

Actual Cavity is used to determine how many shots are required on a production run. The 
calculation is the number of Items Required divided by the Actual Cavities. For family tools, the 
item with the least number of cavities is used in the calculation. 

For RT users, this is also used when shutting off cavities so that RealTime monitoring can count 
parts correctly. The user is given the option of changing the cavitation on a part directly through 
RealTime as well. 

Standard/Actual Multiplier: If the box 'Assy at Machine' is checked, the actual and standard cavity 
fields will change to allow the entry of an item multiplier. Instead of entering the number of 
cavities, the user would enter in how many items will be produced with each cycle. Normally, 
this feature should only be used when setting up an assembly at the press configuration where 
you are ending up with more than one of the finished good items being produced. 

Note:  If desired, users may enter negative cavitation/multipliers on the BOM, 
although this is not recommended. 

Note: When a parent item with multiple cavities has an existing firm work order in the 
system, newly created child work orders for new demand have the potential to be 
created for less than the amount needed to fulfill the new demand if the existing firm 
work order is allocated to the parent demand. 

Drawing No. Optional. The number entered here is used to track the drawing number for the part. Use up to 
30 characters. 

ECNO Optional. This user defined field normally carries an engineering change number, but it can also 
be used to hold additional information about the part, such as a UL number. 

Note: This is an informational field only and is not related to the ECO Quality module. 
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➢ Upon selecting or creating the item, press [OK] to exit back to the Item Details Entry screen. 

User Number field 

On this screen there is an additional field called 'User Num'. This field is only used for EDI or Crystal 
reports. (The field is in the table Partno and is called Nuser1). The label text for this field can be changed 
by right clicking over the field and selecting 'Define Label Text'. The changes made to the text name will 
only affect BOM's with the same MFG Type. 

Item Details Documents and User Fields 

▪ Documents - This tab contains Internal or External documents associated with the attached item in 
relation to this BOM. These documents can be selected to print with the BOM, Work Order, Routing 
Packet, All, or None. This option defaults to None. If the Print with Routing Packet option is selected 
for a document, when the Print Work Order speed button is selected from the work order module 
the routing document will also print. 

▪ User Fields - This tab contains three alphanumeric and three numeric user defined fields that are 
associated with the attached item in relation to the BOM. The three alphanumeric fields can hold up 
to 255 characters. The user may change the label text of these fields by right clicking on them and 
then typing the new label. 
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Certified Employees 

This is a list of employees that are certified to run the specific BOM. Logging into a work order in Task 
Clock from Time and Attendance or Task Clock in ShopData and AssyData will be restricted to only 
certified employees. Employees must be certified on all external documents associated to a BOM, that 
do not have the 'No Training Req' set to 'Y', in order to be able to clock in to the work order. If a non-
certified employee attempts to clock into a work order they will receive an error, 'Document Name Not 
Certified', and will not be clocked in. (If there are multiple certified documents, the error will just list the 
first document in the Certified Documents list for the BOM). 

The Certified Employees tab is applicable to BOMS for all MFG Types except: Outsource, ASSY1, ASSY2, 
and ASSY3. The Processes associated to the ASSY MFG Types have a Certified Employees tab and not the 
BOM. 

 



BOM-Manufacturing Configurations Page 56 of 273 

 

To add employees, select the insert record (+) button to bring up the pick list of employees. Use the 
toggle buttons on the pick list or the Shift and Ctrl buttons on the keyboard to multi-select the 
employees to be added. 

The Certified Documents section displays any External documents that have been associated to the BOM 
on the Documents tab. Upon adding a document, the employee is marked as ‘Not Certified’ and the line 
item is red. To certify an employee for all of the associated documents highlight the employee and select 
the ‘Certify Selected Employee’ speed button. A confirmation button will appear – select Yes to continue. 
The document(s) text will turn black; the status will say ‘Certified’, and the system date and time the 
employee was certified will populate in the Certified Date field. 

Manually Certifying Employees 

Employee(s) can be manually certified on all of the documents associated to the BOM from the Certified 
Employees tab on the BOM. There are two certification options available from the drop down arrow on 

the 'Certify Selected Employee' speed button : 

▪ Certify selected employee(s) - Select this option to certify the highlighted employees on the 
documents in the lower section. Employees can be highlighted in the grid using the Shift or Ctrl 
keyboard buttons. Once the desired employee(s) are highlighted, select this option. A confirm 
message will appear with Yes and No options. Select Yes to continue with the certification, or No to 
return to the module with no changes.  

▪ Certify selected employee(s) on all BOM(s) containing the same documents - Selected employee(s) can 
be certified on all BOMs containing the same document by selecting this option from the drop down 
arrow from the 'Certify Selected Employee' speed button. A confirm message will appear with Yes 
and No options. Select Yes to continue with the certification, or No to return to the module with no 
changes.  

Single Document Certification - To certify an employee on a single document, right click on the document 
and select 'Certify This Document'. The specific document will be marked as Certified. A confirm message 
will appear with Yes and No options. Select Yes to continue with the certification, or No to return to the 
module with no changes. (Note: Employees must be certified on all documents before being allowed to 
log in to a work order for the BOM). 

Certification Reason 

When using any of the certification options in the BOM module, when 'Yes' is selected on the confirm 
message, a pop up form to enter the reason will appear. It is mandatory for a reason to be entered. 
Select the Certification Reason from the drop down list, or manually enter a reason. The drop down list is 
a user defined list. Right click on the blue arrow and select 'Edit User Defined List' to access the list to 
add or edit records.  
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Certification Revision Mismatch Status - If the external document is updated to a new revision the 
employee will not be certified any more for that document and the status will display ‘Certification 
Revision Mismatch’.  If the document has a Certification Test associated to it the employee will be 
prompted to take the Certification Test for the new revision of the document. If there is not a test, select 
the ‘Certify Selected Employee’ button to certify the employee to the latest document revision. 

▪ When new revision is released the system will create a record in the log table. The Event is "Revision 
Change" and the Reason is "Document Revision Change". 

▪ The Certified Employee tab will change from "Certified" to "Certification Revision Mismatch". 

Re-certification Required (months) - This is the number of months required for recertification. This value 
comes from the External Documents tab, it cannot be edited from here. This is used in the Labor 
Scheduling module. An employee will display in blue in Labor Scheduling if they are due for re-
certification. (Due for re-certification is determined if an employees Certified Date + # Months < Today's 
date).  

De-certifying Employee(s) - Employee(s) can be de-certified on all documents or a single document. 

▪ Decertify selected employee(s) - Select this option from the drop down arrow on the 'Certify Selected 
Employee' speed button. This will decertify the highlighted employee(s) on all documents associated 
to the BOM.  

▪ Single Document De-Certification - To decertify an employee on a single document, right click on the 
document and select 'Decertify This Document'. The specific document will be marked as Not 
Certified. A confirm message will appear with Yes and No options. Select Yes to continue with the de-
certification, or No to return to the module with no changes. 

Decertification Reason - As with the certification process a confirm message will appear with Yes and No 
options. When Yes is selected, users must enter a 'Descertification Reason' in the pop up form. Select the 
Decertification Reason from the drop down list, or manually enter a reason. The drop down list is a user 
defined list. Right click on the blue arrow and select 'Edit User Defined List' to access the list to add or 
edit records. 
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Note: Entering a Reason for certification/de-certification is only available when certifying documents at 
the BOM level. Users will not be asked to enter a Reason when certifying employees on documents from 
the Workforce module. 

Remove an Employee - Select the minus (-) button to remove an employee. A confirm message will 
appear Stating, "Delete Employee?". Select OK to delete the employee or Cancel to return to the BOM. 
There is also a check box to remove the employee from All BOMs. (Note: This check box does not store 
its value, it will need to be checked for every employee removed in this way). 

Note: If there are no certified employees listed, and there are external documents associated to the 
BOM, any employee will be able to clock into a work order associated to that BOM. 

Certification Tests 

Certification Tests can be associated to documents (in the Document Control module). When an 
employee that is not certified on the document attempts to clock into a work order they will receive an 
error, 'There are pending certification training tests required for this Work Order.  Would you like to 
take the test now?' If Yes is selected the system will present the employee with the test questions and 
multiple choice answers.  As the user progresses through the test, the percentage of correct answers 
will be compared to the Pass Percent on the Certification Training to determine whether the employee 
passes or fails. If a Certification Test is associated to the document, it will be listed in the Certification 
Test field in the Certified Documents section.  If the employee passes the test the document will be 
marked certified for all instances where the user/document exists in BOMs, Processes and Employee 
Training records. Employees are prompted to take the Certification Test unless the Status in Certified 
Documents is set to 'Certified'.  If the external document is updated to a new revision the status will 
display ‘Certification Revision Mismatch’, and the employee will be required to take the test to be 
certified. (Please see the Document Control section of the Quality manual for more information on 
setting up Certification Tests). 

Note: Employees can also access required certification tests from My Pending Approvals (accessed from 
the My Pending Workflows menu on the EIQ Launcher Bar). This enables employees to take the 
certification tests without having to log into a work order or process. 

BOM Document Certification Log 

A log of all BOM Document certification/decertifications is kept. This can be accessed from the speed 

button  on the Certified Employees tab. A report is also available with this information. 
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Selection Criteria 

The fields available for entering selection criteria are: MFG #, Document #, Employee, From and To. 
When this form is opened the Selection Criteria defaults to the current BOM and the highlighted 
employee. The To date defaults to the current date and the From date is 30 days prior to the current 
date. All of the criteria can be changed manually to view the desired records. Note: When changes have 
been made to the criteria, once the form is closed and re-opened, the default selection criteria will 
display again. 

▪ To clear a field, highlight the text and click the Delete button on the keyboard. 

▪ To select a value in the MFG #, Document #, or Employee fields click on the ellipsis button to access 
the corresponding pick list, then select the desired record. To enter different dates, select the drop 
down arrow in each field to access the calendar. 

▪ Once the desired values are entered press the 'Apply' button to refresh the data in the grid. 

Grid Field Listing  

Date The date and time of the event. 

MFG # The MFG # associated to the log record. 

Employee Name The Employee Name for the log record. 

Event The Event. This field can be: 

▪ Certified - The document on the BOM was certified for the employee. 

▪ Decertified - The employees was decertified on the document on the BOM. 

▪ Revision Change - If the document has a revision change a log entry will be created 
automatically. The employee will also be automatically decertified on the document with a 
status of 'Certification revision Mismatch'. 

Approver The user name of the approver. 
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Reason The reason selected when certifying or decertifying an employee.  

If the employee is certified after taking a certification test the reason will automatically 
populate with the name of the document and the employee's score. (i.e. "Certification Test 
'Document Name.pdf' - 100"). 

For a revision change, the reason field will populate with "Document Revision Change". 

Document Name The name of the document. 

Document # The Document number. 

Revision The revision of the document. 

Library Name The Library Name where the document resides. 

Cloned BOMS, Substitute BOMs, and Sales Configuration Template Generated BOMs 

▪ Certified employees are automatically certified on documents when a substitute BOM is created, 
either from a work order, or if one is created by the system for Logical Work Centers.   

▪ Automatic certification also occurs for certified employees when a BOM is cloned if the 'Include 
External Documents' option is checked.  

▪ Certified employees associated to BOMs created when sales quotes for sales configuration template 
items are converted to a sales order will be automatically certified.  

For these scenarios a certification reason is automatically added in the BOM Doc Certification Log noting 
the MFG# it was created from, for example, "Clone/Substitute Mfg# TAS-55000-ASSY". 
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For employees that are not certified, they carry over to the cloned or substitute BOM as not certified, 
therefore no log entry is created. 

Labor Scheduling 

Allow Non-Certified Employees - This option is at the bottom of the Certified Employees tab in BOMs. This 
check box allows users to establish whether to allow Non-Certified employees to be scheduled in Labor 
Scheduling for the BOM. This defaults to un-checked. When a work order for the BOM is first scheduled 
the allow non-certify option in Labor Scheduling is updated with the control set at the BOM level. If this 
option is unchecked the Allow Non-Certified will be 'No' in Labor Scheduling. When this option is 
checked, Allow Non-Certified will be 'Yes'. The setting can be changed in the Labor Scheduling screen to 
override the BOM level setting. When it is manually changed, when removing the work order from the 
work center and then adding the work order back in the first position, the Allow Non-Certified will be 
populated with what is set at the BOM. When moving the work order from the first position into a 
different position on the same work center and then moving the work order back in the first position, 
the Allow Non-Certified will be populated with what was set in Labor Scheduling. When moving the work 
order from one work center to a different work center, the Allow Non-Certified will be populated with 
what was set in Labor Scheduling. 
 

Documents and Routing Notes 

Documents Attached to the Item 

EnterpriseIQ supports attaching unlimited notes and documents to any item number. Use the Documents 
button to access the internal and external documents linked with the finished goods item number. This 
same list of documents can be accessed from within the Inventory module. 

Note that the Documents button provides direct access to the Item Number documents, as opposed to 
the Documents tab which provides access to documents concerning the configuration. 

The user can add, edit, and delete documents from the maintenance form that is displayed. Any changes 
made to the documents from this area will be reflected when viewing the documents for this item from 
within the Inventory module. 

Routing Notes 

 In the Item Info section of the Items Details tab is a speed button to access a routing note field. This 
is a 2000 character note field used for work instructions for routings. This information will print on the 
Routing Packet report available in work orders. 
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Editing, Deleting Part Numbers 

Editing Part Numbers Attached to a BOM 

To EDIT the part number once it has been linked to the BOM: 

➢ Highlight the item in the visual view (left side). 

➢ Right click on the item and select 'Change Item' from the menu that will appear, or highlight 
the item and click on the 'Edit' button located under Item Info (right side) to perform the 

same function. The following screen will appear: 

 

➢ Make any changes to the attached item through this screen. 

If editing the item number directly, a prompt will appear advising the user that the item entered is not 
found in the Master Inventory and if you wish to create a new item? Enter 'OK' if this is the case. 

If adding or changing the revision number, the following prompt will appear: 

 



BOM-Manufacturing Configurations Page 63 of 273 

 

The user has three options: 

▪ Update current item - This option changes the revision number but will not add a new inventory item. 
This option will overwrite the old revision number. If you need to track both revisions in inventory, 
select Create New instead. Note: This will only update the revision. If changes to other fields were 
made such as weight, the user will have to select edit again to make those changes. This is due to the 
fact that the information is found in two different tables. 

▪ Create New Inventory Item - This option creates a new inventory item in the master inventory. The 
new item will now have this BOM as the Default Mfg # associated with it. The old item will no longer 
have a default manufacturing number. 

If the Create New Inventory Item is selected three additional options will be available: 

▪ Attempt to delete previous revision 'x' - This gives the user the option of deleting the previous 
revision number and/or copying the item info from the ‘old’ item. In order for the deletion of a 
previous item and revision number, the inventory item must not have any quantity on hand, be 
tied to any other BOM, have an existing Sales Order or Work Order, or be associated to a 
Forecast. This will delete the item from the system, it is not just marked inactive. 

▪ Copy item detail from prior revision - The copy option carries all the previous item’s pricing, AKA 
customer information (i.e. quantities & price breaks,), Auto MRP data, Inventory Documents, 
Sales Account splits, and all standard costing information. 

▪ Update all BOM’s that make this item - This will update all the BOMs that make the item. To view 
the BOM’s that make the item click on the icon next to the field and a list of BOM’s which 
produce the item will appear. 

Note: When using the Add a New Part Number (+) button in the Item Information section, these 
three options are not available. 
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▪ Clone Original Item -  Select this option to clone the current item and create a new one. This 
functions like the existing “Clone item” functionality. The Clone Inventory pop up form will appear 
for the user to select what to clone. See Cloning an Inventory Item for details. 
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Note: When cloning an item the system will populate the item number with the next sequential number 
if the ‘System-Generated Inventory#’ option is enabled in System Parameters->Sequential Numbering 
tab.  The value can be overwritten if desired. 

Pick Item 

An manufactured item can be selected from the pick list if it already exists in master inventory. Select the 
Pick Item button and select the item that is manufactured using this BOM from the pick list. A confirm 
message will appear stating, 'The following inventory item details (description, ecno, drawing etc) is 
about to be updated...'. Select Yes to continue making the change. If this change affects the default BOM 
another confirm message will appear stating, 'Replace Default Inventory Mfg# with current Mfg Config # 
?' Select Yes to change the default MFG # associated to the item to the current BOM or No to not change 
the default BOM. It also has the 'Do not show next time' check box if users do not want to be asked to 
change the default BOM. 

Deleting an Item 

To DELETE an attached item: 

➢ Highlight the item to be deleted. 

➢ Right click on the item and select 'Delete Item' from the menu that will appear. A prompt will 
appear asking you to confirm your actions. 

➢ Select 'YES' to delete the item. This action will delete the item and all attached components 

and packaging. 

Note: You can also delete the item by selecting the item and clicking on the Delete [ - ] function key 
located on the Navigator bar within the Item Info section. 
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Item Details - Right Click Options 

The right click options will depend on the record the user right clicks on.  

When right clicking on a manufactured item the options are as follows: 

▪ Add Item/Material - When highlighted on the manufactured item, this will open the 'Add Inventory 
Item to BOM' form, which can also be performed by selecting the plus button. When highlighted on 
an attached material the corresponding pick list (i.e. packaging items) will appear to choose an 
additional material to add. Note: If the ‘System-Generated Inventory#’ option is enabled in System 
Parameters->Sequential Numbering tab, the system will populate the item number with the next 
sequential number. If the user clicks on the 'Pick Item' button and clicks 'New' on the pick list, the 
item # will be the same as what was generated. For example, if the next sequential item was '123', 
when selecting 'New' on the pick list it will still be '123'. The value can be overwritten if desired. 

▪ Change Item/Material - When highlighted on the manufactured item, this will open the Edit this BOM 
Inventory Item form to make changes. It is the same function accessed from the Edit Item button. 
When highlighted on an attached material the corresponding pick list will appear to choose a 
different material. 

▪ Delete Item/Material - This will delete the attached item or material after selecting Yes on the confirm 
box. 

▪ Jump to Inventory - This feature will take you to the inventory module for the highlighted item. 

▪ Jump to Transactions/Locations - This will access the Transactions module for the highlighted item. 

▪ Jump to BOL Data - This will access the BOL Data form for the item. 

▪ Jump to Inspection Setup - This option will only be available for users who own the quality modules. It 
allows the user to jump to the Inspection Setup for the inventory item. 

▪ Jump to BOM - This will be available for attached manufactured items, and will jump the user to the 
item's BOM. 

▪ Add Component - Adds a component to the BOM. 

▪ Add Packaging - Add a packaging item to the BOM. 

▪ Add Operation - Adds an operation to the BOM. 

▪ BOM Tree - This screen allows the user to see all required inventory for the manufactured item along 
with the requirements per item. This information can be exploded for a specific quantity. Click on the 
BOM Qty Explosion button and enter in a quantity. The information displayed will show the 
requirements per item, the required amount of material to manufacture the quantity entered, On 
Hand inventory, as well as non-committed material on hand. This function will show the user how 
much of the material in inventory that is not allocated towards existing orders. Select the Material 
Exception List button to open the BOM Tree Material Exceptions list. This list displays only the 
materials associated to the BOM. For more information please see BOM Tree in the Inventory 
section. 

▪ Routing Tree - This screen displays the work center routing tree for the highlighted item. 

▪ Routing Diagram - This feature brings up a color coded, visual routing diagram of the processes 
involved to make the highlighted item. This is based on the item and not the BOM. If there are 
multiple BOM’s that make the same item, the default BOM will always be listed on the routing 
diagram, regardless of what BOM it is accessed from. 
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The boxes can be expanded (right click - expand) to view additional information. The additional 
information available is: On Hand, Non Committed, Std Cost, and Ext Cost. To set a quantity click on the 
BOM Qty Explosion speed button. Then right click on a box to see the additional information you 
selected in parameters for the quantity. For example, if the BOM explosion qty is set to 1000 and the 
purple material box is expanded, the amount of material required for that quantity will display along 
with any other options selected under parameters, such as on hand quantity. Select the printer speed 
button to print the Visual Routing report to a printer. From this form the user can also jump to Inventory, 
BOM, Process, or the Material Exception list. The jump to option will be grayed out if no jump is 
available. 

▪ Trace Item - Allows the capability to trace changes to fields set up in the trace tables (System 
Parameters->Options->IQTrace Tables). 

The same options are available when right clicking on an attached component or packaging item. The 
exceptions are, there will not be the Add Component/Packaging/Operation options, and the 
Add/Change/Delete Material options will allow for changing the attached component or package, and 
not the attached manufactured item. 

When right clicking on an Operation (Attached Packaging, Attached Components, or Operation)  the 
options are: 

▪ Add Operation - This will open the Routing or Standard Operation pick list to choose or create a new 
operation.  

▪ Edit Operation - This will open the Operation form for the highlighted operation. This will be based on 
the type of operation: Attached Component, Attached Packaging, or Processes/Operations. The form 
below shows the Processes/Operation and the Attached Packaging for examples. Each time a 
component or packaging item is added to a BOM, and operation is automatically created.  
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From the actual operation forms users can associate Internal/External Documents that can be set to 

print with the BOM,Work Order, or both; and Routing Notes (select the  to access the pop up form) 
that can be added to reports. 

▪ Delete Operation - This will remove the operation from the BOM, but not from the system. 

▪ Edit Operation Routing Note - This option will pop up the Routing Notes form to add/edit the notes. 

▪ Routing/Seq# - This allows the user to edit the sequence # (the order is appears in the tree) for the 
operation. 

▪ Add Component and Add Packaging - Allows users to add a component or package item to the BOM. 
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▪ BOM Tree, Routing Tree, and Routing Diagram as described above. 
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Attaching Packaging 

EnterpriseIQ supports attaching unlimited packaging and/or components to any item number. 

To ATTACH a packaging item, complete the following steps: 

➢ Highlight the manufactured item to attach packaging to. 

➢ Packaging can be added from the PK inventory pick list or from the AKA Item pick list. Use 
the drop down next to the Add Packaging to Item button at the top of the screen to choose 
the list. Users can also highlight the item and right click and select Add Packaging from the 

menu to access the PK Inventory pick list. 

Note: The user must enter the packaging items into inventory before using this feature. However, 
packaging items may be created on-the-fly by selecting the “New” button within the Add Packaging 
Inventory pick list. Please see the section below called Creating New Packaging Items (Not found in 
Inventory). 

➢ Use the Search or Sort function to locate an existing PK item number within the pick list. 

➢ Click on [Select] when the item is found. 

➢ The Items/Material Usage screen will appear where the user will enter the parts per 

package, scrap, and other information for the packaging item discussed below. 

Parts/Package 

After selecting a packaging item, the user will be asked to enter in the number of Parts per Package.  
Note: A null or zero quantity is allowed. A message will appear stating, "Parts per Package should be a 
number greater than 0. Are you sure you want to continue?". Select Yes to continue or No to return to 
the form to enter a value. Security can be placed on this message. 

The parts per package calculation needs to know how many parts will be put into the packaging item 
selected. In the case of a box, for example, you will enter how many parts will be placed in the box. The 
system then removes the number of boxes based on the number of parts produced 

For example, if putting a total of 5,000 parts in a box, with 1000 parts each in 5 bags with a single twist 
tie per bag, the number of parts per package would be 5,000 for the box, 1000 for the bag and the tie. 
Put the largest packaging item first in the list. In the example, the box should be first. 

Note: During dispositions, EnterpriseIQ will remove Fractional Packaging items. From the example above, 
if there were 4,000 good parts produced, dispositioning would remove 0.8 boxes, 4 bags and 4 twist ties 
from packaging inventory. While it may seem illogical to remove a portion of a box or bag, the theory is 
that in most cases the partial box will be filled during the next shift. If shipping packages that are not full, 
you can make the adjustment during dispositioning. 
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If the parts use a packaging material that is not easily defined as a single unit (plastic wrap, paper wrap, 
etc.), then the user must calculate how many parts could possibly fit into the entire roll or item. For 
example, assume you stretch wrap the product using a 600 foot roll of plastic wrap. Calculate the 
number of parts a single 600 foot roll could wrap, and enter this value. In this way, EnterpriseIQ will 
figure how much of the material you used based on production. 

Example One: 

A single finished goods item requires three feet of string. In the packaging inventory this item's unit 
of measure is by the foot. Since we need EnterpriseIQ to subtract an appropriate amount of string 
per item produced, we must define the Parts/Package field as 0.33, since we need a total of three 
feet per item. Therefore, for every foot of string, we are only wrapping 0.33 of an item. 

Example Two: 

Assume you use tape to seal a box of items. Tape is maintained on the inventory list by the roll. We 
must determine how many of these particular items we can seal with a single roll of tape. If 100 parts 
are in a box, and we can seal 1000 boxes per roll of tape, then Parts/Package would be 100 x 1000 = 
100,000. EnterpriseIQ will remove fractional portions of the tape as parts are wrapped and sealed. 
Therefore, you may have fractional packaging items on hand. 
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The additional fields on this form can be entered when adding an item or entered later via the Details 
tab for the Attached Material. Please see the section below on Attached Material Details for information 
on all fields. (Details). 

Returned Packaging - If the packaging item will be returned and reused and it is desired it shows up on 
the work order users can set this up on the BOM by adding the packaging item twice, once with a 
positive parts per and once with a negative parts per. 

Creating New Packaging Items (Not found in Inventory) 

If the packaging item cannot be found within the pick list, follow the steps below to quickly create the 
item needed. 

➢ Select 'Add Packaging'. 

➢ Click on the 'New' button located at the bottom of the PK Inventory Pick list. 

➢ Enter in the information about the packaging item on the form that displays and click on 
[OK]. The minimum that can be entered is the Item Number, Description, and UOM. The 

user has the option of also filling in Lead Days, the default vendor, as well as standard cost 
information. Check the 'Non-Material' box if the new item is considered Non-material. Non 
Material items can be attached to BOMs but the system does not allow parts per to be 

entered for a non-material item. They can be shipped but are not dispositioned. Locations 
and On Hand quantities are not maintained for Non-Material items. If the packaging item is 
a pallet, check the 'Is Pallet' box. This setting is used to determine pallet count in 
conjunction with parts per on the BOM. In the RF module it is used for the print label 

function 'Print on Complete Pallet.' Based on the parts per field the system will recognize 
when a full pallet has been reached and prompt to print a label. Also, if this box is checked 
when a pick ticket is converted to a packing slip the Pallet Count field on the Packing Slip will 

populate automatically with the pallet count. 

Note: When creating a new item the system will populate the item number with the next sequential 
number if the ‘System-Generated Inventory#’ option is enabled in System Parameters->Sequential 
Numbering tab. The value can be overwritten if desired. 
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➢ Enter the number of parts per package. Refer to the section above if help is required with 
this entry. 

➢ Click on [OK] when finished. 

Editing Attached Packaging 

Once a packaging item is entered the parts per field may be edited and additional information may be 
added. The information regarding attached packaging or a component is on the bottom right side of the 
item details tab. 
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This section has four tabs which are associated with the highlighted attached item. 

▪ Attached Materials - This tab displays the inventory information about the attached item such as 
Class, Item #, Rev and Description. Every time a packaging item is associated with a BOM the system 
creates a packaging operation. This information also appears on the tab. In addition to inventory 
data the user can edit the parts per information. 

The UOM (Unit of Measure) field can be used to specify a different UOM for usage than what the 
packaging item is stored in inventory. The UOM will default to the UOM associated with the 
inventory item but can be changed by selecting a different UOM from the drop down pick list. 

Parts Per - To Edit the Parts Per for a packaging item: Highlight the packaging item. Place the cursor in 
the Parts Per field in the Attached Material Specification section (right side of Item Details screen) 
and make the change. Click on the Post/Edit function key to save the change. If the value is changed 
to zero a status exception warning will appear "Field 'Parts Per' is 0". Select OK to change the parts 
per to zero or Cancel to return to the BOM to enter a quantity greater than zero. Security can be 
placed on this warning. 

If additional changes need to be made to the packaging item number, select the packaging item 
number and right click to bring up the submenu. Select 'Jump to Inventory'. This will bring up the 
Inventory screen and the item number to make changes to. 

Delete - To Delete a packaging item, highlight the item to be deleted. Right click and select 'Delete 
Operation' from the menu, and select 'Yes'. This will remove the packaging item that is currently 
attached to the part. Note: Make sure the correct operation is highlighted prior to deletion. 

▪ Details - This tab contains the general and packaging details such as Scrap % and weights depending 
on the type of attached material. Please see Attached Materials (Components, Packaging and 
Operations) Details Tab in BOMs for additional options associated to attached packaging. 

▪ Documents - This tab contains Internal or External documents associated with the attached item in 
relation to this BOM. These documents can be selected to print with the BOM, Work Order, Routing 
Packet, All, or None. This option defaults to None. If the Print with Routing Packet option is selected 
for a document, when the Print Work Order speed button is selected from the work order module 
the routing document will also print. 

▪ User Fields - This tab contains three alphanumeric and three numeric user defined fields that are 
associated with the attached item in relation to the BOM. The user may change the label text of 
these fields by right clicking on them and then typing the new label. 
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Attaching Components 

Attaching components is accomplished in the same manner as attaching packaging items. 

➢ Highlight the manufactured item to attach a component to. 

➢ Components can be added from the master inventory pick list or from the AKA item pick list. 
Use the drop down next to the 'Add Component to Item' button at the top of the screen to 
choose the list. Users can also highlight the item and right click and select 'Add Component' 

from the menu to access the master Inventory pick list. 

Note: The user must enter the components into inventory before using this feature. However, 
components may be created on-the-fly by selecting the New button within the Select from Master 
Inventory pick list. 

Note: When creating a new item the system will populate the item number with the next sequential 
number if the ‘System-Generated Inventory#’ option is enabled in System Parameters->Sequential 
Numbering tab. The value can be overwritten if desired. 

➢ Use the Search or Sort function to locate the desired component within the pick list. Click on 
[Select] when the item is found.  

Note: Blends cannot be attached as components. The components of the blend will backflush if the blend 
is placed as the primary material on the BOM (on General BOM Info tab); not as Attached Component 
(on Item Details tab).  Only the blended item will backflush when entered as an Attached Component. 

Note: For family BOMs, sibling items cannot be added as each others components. For example, if a 
family BOM makes part A and B, if a user attempts to add A as a component of B, or B as a component of 
A, a circular reference will occur. This prevents circular references to happen elsewhere. 

Note: When an item on a ECO BOM is edited it is given a Class of ~0. These items will be visible in 
inventory pick lists. If a user attempts to attach an ECO item to a BOM as a component an error will 
display, 'Cannot attach an ECO item as a component'. 

➢ The 'Items/Material Usage' screen will appear asking how many components per part will be 
consumed. If the selected item is a non-material item the screen will not appear as the 
system does not allow parts per to be entered for a non-material item. 

➢ Enter the number of components per part and press [OK]. Note: A null or zero quantity is 
allowed. A message will appear stating, "Components per Part should be a number greater 
than 0. Are you sure you want to continue?". Select Yes to continue or No to return to the 

form to enter a value. 

Note: If a PK Class item is attached to a BOM as a component (rather than a packaging item) it will still be 
calculated as 'Parts per Package' instead of 'Components per Part'. 

➢ Multiple components may be added using the steps described above. 
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Note: Each component will have a sequence # associated to it based on the order they were added. The 
sequencing can be changed by dragging and dropping the components in the left portion of the Items 
Details tab 

Follow the steps under Attaching Packaging for assistance when editing or deleting a component(s). The 
steps are exactly the same. 

Please see Attached Materials (Components, Packaging and Operations) Details Tab in BOMs for 
additional options associated to attached components. 
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Attaching Operations 

Attaching operations is accomplished in a similar manner as attaching components or packaging items. 
This feature is used to attach operations to the injection configuration versus creating a generic 
standard. By adding the operation here the assumption is made that it will be done within the cycle time 
and the operation does not change the manufactured part number. If the part number changes due to 
the operation (i.e. hot stamping a logo) or the operation time needs to be scheduled a generic BOM 
should be created. 

➢ Highlight the FG item to attach an operation to. 

➢ Select the Add Routing / Std Operation button at the top of the screen, or highlight the item 

and right click and select Add Operation from the menu. 

The Select from Std Oper / Routing  pick list will appear. Use the Search or Sort function to locate an 
existing Operation number within the pick list or create a new operation “on the fly”. 

Adding a new Operation 

➢ Right click and select Add Operation or select the speed button, then select New from the 
pick list to get to the Std Operation Routing form: 
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Use the field listing below for assistance in filling in each of the fields on this screen. 

Operation # The operation number will default to the next sequential number but it can be changed by 
typing over the number. Typically the value entered by the system is used because the 
Description field is used to describe the operation. 

Note: If this number is manually changed users could potentially end up receiving a 
unique constraint error if the number is already used. 

Class The class will fill in with OP and cannot be changed. 

Description 60 alpha-numeric description of the operation. 

Operation Info Std Rate: This rate is defined per hour and is used for calculating the labor or overhead costs 
associated with the operation. The system uses this rate in conjunction with the Hours/Item 
value entered on a BOM in the Process Details section of the Item Details tab to determine 
the standard cost per item for the operation for the specific BOM. See the Process Details 

(Operation Only)  in the Attached Materials (Components, Packaging and Operations) Details 
Tab in BOMs for more information. 

Cost element: Choose the appropriate cost element from the drop down menu. Note: In the 
Recipe Card in inventory, the 'Cost Contribution Type' field will always default to Labor 
regardless of the cost element selected here. The actual cost element in the upper section of 
the Recipe Card does correspond to the cost element selected here. 

Materials New or existing materials from inventory can be associated with the operation by clicking in 
the item # field to get an inventory pick list. Select an item from the pick list or select the 
'New' button. 

Note: If the ‘System-Generated Inventory#’ option is enabled in System Parameters-
>Sequential Numbering tab, when creating a new item the system will populate the 
item number with the next sequential number. The value can be overwritten if 
desired. 

Documents Add any internal or External Documents related to the specific operation. These can be set to 
print with BOM and/or Work Order reports. 

Please see Attached Materials (Components, Packaging and Operations) Details Tab in BOMs for 
additional options associated to operations. 
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Attached Materials (Components, Packaging and Operations) Details 
Tab in BOMs 

The details tab allows the user to view and/or edit the details of the attached item (packaging or 
component) or operation. 

 

The field listing below describes how to fill in each field shown in this section. 

Seq # Shows the order of each item attached. The sequence number will default to the order the 
item is added in. The sequence of the items can be changed by dragging and dropping 
them in a different order. 

Note for Packaging: The largest packaging item or the one that will be associated to the Bill 
of Lading should be Seq #1. The default method for calculating BOL’ s uses Seq #1 
packaging items to calculate the BOL data such as class. 

Scrap % This field is used to assign a unique scrap % to the attached item which takes into account 
fall out from using the item during the operation. This is always used in material planning 
and by default in usage (even when the material is hard allocated, scrap % is taken into 
account when calculating the materials involved in production reporting). It will tell the 
user to buy/produce more product, and more product will be dispositioned, unless the 
'Exclude from Calc' option is selected (see below). 

This is calculated: (Quantity / (1-scrap%). If the quantity is 1000 and the scrap rate is 20%, 
the system would calculate the requirement as 1250 for the attached item. If the item is 
manufactured a work order would be created for 1250 pieces (assuming no other 
demand). 

This field is available for both components and packaging. 
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Exclude from Calc With this checked the scrap percentage will not be included in the dispositioning or 
manual backflush calculations. Disposition and backflushing will only look at usage and not 
include scrap. (This does not affect material planning, the system will still tell the buyer to 
purchase more to compensate for potential scrap). 

Disposition based 
on Cycles 

Components and packaging can be consumed during the production reporting process via 
the total cycles counted, or based on good parts only. This method allows you to 
determine whether the insert can be reclaimed or not if the part is defective. If it cannot 
be reclaimed, then check this option. If this option is checked, EnterpriseIQ will calculate 
components or packaging used on total cycles. If left unchecked, the system will base 
components used on good parts. 

Exclude From 
Backflush 

When selected this option will keep the attached component from being dispositioned 
(either through production reporting or manual transactions with backflush). It will not 
show up in the material exception reports nor as a constraint in the CTP Diagram. The 
attached item will also not be included in standard costing unless the Include in Std Cost 
Calc option is checked. If this option is checked the option ‘Exclude from Std Cost Calc’ 
becomes unavailable and vice versa. 

Include in Std Cost 
Calc 

 

If the Exclude Backflush option is checked the user will see this option. Check this box to 
have the attached item included in the standard cost calculation. 

Exclude from Std 
Cost Calc 

If this option is checked the attached component/packaging will be 
backflushed/dispositioned but not included in the standard cost calculation. If this option 
is checked the option ‘Exclude Backflush’ becomes unavailable and vice versa. 

Exclude Reject 
Backflush 

When entering rejects if the user has the Backflush Rejects option checked in Security 
Inspector for their user name, the system will backflush the attached materials of the 
rejected item by default. This box can be checked to exclude the attached material from 
being backflushed when reporting rejects. For example, if an item is rejected it may not be 
placed in a packaging item therefore the package should not be backflushed when 
rejecting the manufactured item. 

Exclude from KIT 
MTO 

This option will only be visible for components of a phantom Kit item. With the option 
selected for a component within the parent BOM, this will exclude the purchased and/or 
manufactured component from automatically inheriting the MTO status of the parent Kit 
item on a Sales Order. 

Note: If selected for a manufactured component, this overrides the 'Cascade Parent MTO 
Designation' check box option in Inventory. 
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Startup Qty A start up quantity can be entered in this field for the attached material. During the 
update schedule process the system will check if a start up quantity is required and if so 
the required material quantity will be added to the first date of each work order. For 
example, if a sales order has a requirement for 10,000 pieces and the system creates five 
work orders, the start up material quantity would be added in five times, one for each 
work order (or start up). The requirements will be visible in the Material Exceptions and 
Staging reports. The quantity entered here will not effect the standard cost of the item 
unless the 'Include in Std Cost option is checked. The system will use the inventory item’s 
standard calc quantity to determine the costs. The Component Calculation = 
[(Components per part + (Start Up Qty / Std Calc Qty))/(1 - scrap percentage)] * 
components standard cost. 

Note: The system will factor in the startup quantity in material exceptions for a 
component with a zero or null parts per.  

Note: The system will only apply the startup qty to the consumed components as 
long as no labor reporting (process wip) took place for the parent item. For 
instance: Item A consumes Item B. The demand for Item A is 100, Item A needs 
10 startup parts of Item B. As long as there is no labor (process wip) reported 
against Item A, the system will add 10 to Item B (during update schedule).  

Include in Std Cost If this is checked the system will include the start up quantity in the standard cost 
calculation. 

Gross Weight (Pkg 
Only) 

This field is used to enter the ENTIRE (final) weight of the packaging item (box). Includes all 
parts, bags, ties, etc. 

The Bill of Lading is based on pounds per cubic feet. Pounds per cubic feet are calculated 
based on box weight and the volume of the package. 

Tare Weight This is the weight of the empty packaging item.  

This information is used when BOL's are being calculated based on individual component 
weights. The program will add up all of the tare weights for the packaging and the net 
weight for the Finished Good based on the parts per in the BOM. 

Please see Calculate BOL based on individual component weights for more information. 

Ret Contnr (Pkg 
Only) 

This is for returnable containers and will only be used by the EDI module. 

Verify ASN 
Quantity (Pkg 
Only) 

This is used for EDI only. 

In the BOM, all returnable packaging items that need to appear on the EDI 856/DesAdv 
outbound transactions should be specified as packaging components and have the Ret. 
Container box checked. In addition, any returnable packaging items in which the quantity 
can vary per shipment (usually tops & bottoms), should have the Verify ASN Qty box 
checked on the BOM. For the inner returnable packaging item, the Seq # MUST be set to 
1. 
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Overlap Hours 
(Manufactured 
Component only) 

This option is only available for attached manufactured components. It is used for 
assemblies. This is the number of hours you can start on the next operation after starting 
to make the previous part. If you are creating part A and have an attached part B, without 
overlap hours the program will want to produce all of part B before you can begin 
production on part A. With overlap hours set you can start A after ‘x’ number of hours of 
starting B. The operations can 'overlap'. 

This will adjust the must start time for child work orders. The must start date on the child 
work order will be based on the must start date of the Parent work order. The system 
takes that date and backs up the number of overlap hours to come up with a must start 
date for the child work order.  

For example: 

Prod Hrs for the Injection (Child) WO = 12.5 

Prod hrs. for the Generic (Parent) WO = 6.94 

No set up hours 

Before overlap hours are added the must start date/time for the injection WO is 4:33: 

  

Overlap hours = 6, the must start date is 11:03 (5:03 less six hours).  

 

With overlap hours of less than the difference between the injection production hours and 
the generic production hours: The Must start is backed up by that difference. 

12.5 - 6.94 = 5.55 or 5:33 hrs.  

So with an end time of 5:03 pm, the must start time is 11:30 a.m.  

(5:03 pm less 5:33 hrs = 11:30 am). 
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Overlap Hours 
(Manufactured 
Component only) - 
Additional 
Examples 

 

Note: When using Batch Production, overlap hours should allow enough time to complete 
the quantity of the batch size. 

Note: If overlap hours are used this information will appear on the Log tab in the MRP 
Engine (update schedule) screen. For example: Overlap hours = 3 was used to calculate the 
must start date 11/28/2013 05:22:23 and must_ship_date 11/28/2013 09:55:54. 

Process Details 
(Operation Only) 

This is the time required to complete the attached operation on one item. This is used for 
costing information only. Select the UOM (Sec, Min, Hour, Day) from the drop down and 
then enter the cycle time. The system will multiply the Std Rate defined on the operation 
times the Hours/Item to calculate the standard cost per item. For example, if the time 
required is 15 seconds at a rate per hour of 25, the system will calculate the cost as 
15/3600 * 25 = 0.104167. 

This time is not included for scheduling purposes. If the operation requires more time than 
the standard cycle for the process and you would like to schedule the time - a Generic 
configuration should be created. 
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Documents Tab in BOMs 

Each manufacturing configuration may have its own set of process instructions or notes such as machine 
setup notes and quality control information. The documents can be created and stored as an internal 
document or associated to a BOM as an external document. These two sections are discussed briefly 
below. For a full discussion on Documents within EnterpriseIQ please see the Documents section in Using 
EnterpriseIQ. 

Internal Documents 

The screen acts exactly like a word processor. The user can add, edit, delete, or print documents from 
here. Graphic images may also be imported into the document or text area. EnterpriseIQ supports.BMP 
or.WMF graphic files only. The following is a sample of the Internal documents screen. 
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External Documents 

This section enables the user to be able to insert or open documents created in different applications 
such as Microsoft Excel Chart/Worksheets, Microsoft Word Documents, Acrobat Reader, Word pad, 
Bitmap images, etc. and map the path to these documents so that anyone can access them. 

To CREATE a new document in this section: 

➢ Click on the ADD [+] function key located on the Navigator bar. 

➢ Find the location of the application or file and double click to select it. The File Name field 
will now contain the path or location of the document attached. If the user has the 
Document Control module the user will first select the Library and then the specific 

document in that library to be attached rather than the path. 

➢ Click on [Open] to assign the document to this section. 

To OPEN the document: 

➢ Double-click on the file name, or select the document and right click. Select [Execute] from 

the submenu.  
 

The program will open both the application the document was created in as well as the 
document itself. 
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➢ When finished viewing the document, click on [Exit]. 

➢ Note that with either an internal or external document you can specify what you want the 
document to automatically print with. To do this click on the “print with” field and choose 

from the drop down menu. You can print the document with the BOM, Work Order, both, or 
none. For External documents this defaults to None. 

➢ For users licensed for Shop Data there are two additional fields: 'Place Shortcut' and 'Shortcut 

Sequence'. Attached documents with 'ShopData specified under the 'Place Shortcut' drop 

down appear on the RealTime Work Center screen in ShopData. The 'Shortcut Sequence' 

column allows users to specify the sequence that the documents appear. 

➢ No Training Req - The External documents are also used in conjunction with Certified 

Employees. If Certified Employees are associated to the BOM, by default they are required 

to be certified on all External documents associated to the BOM. If employees are not 
required to be certified on a specific External document set this field to 'Y'.  

➢ Recertification - This is the number of months required for recertification. This will carry over 

to the Certified Employees tab in BOMs. This is used in the Labor Scheduling module. An 
employee will display in blue in Labor Scheduling if they are due for re-certification. (Due for 
re-certification is determined if an employees Certified Date + # Months < Today's date).  

Filter Dataset - Each External Documents tab within the modules will have a Filter Dataset button to 
enable users to filter the attached external documents by a field within the library, including the user 
defined fields. Select the filter speed button and enter the filter criteria in the pop up form. 

Email Correspondence in BOMs 

In addition to documents there is an Email Correspondence tab. From this tab users can to attach Email 
correspondence related to the BOM. To add an Email simply drag and drop it from Outlook or other 
email programs into the form.  A Received Date box surfaces if the system is unable to determine the 
date (such as: the Received and Sent dates differ, unclear binary data, or older data, etc.). Users are 
asked to provide the Received Date by selecting the correct date from the calendar. The From and 
Subject fields will also automatically populate with the information from the email. The date, from, and 
subject fields cannot be edited. A comment can be entered by double clicking the field. Enter the 
comment in the pop up box to further describe the email correspondence.  

There are three ways to access the email once associated to the BOM:  

▪ Double click on either the Received, From, or Subject fields.  

▪ Right click and select View email.  

▪ Or select the View email button. 

Note: Dragging and dropping from a local workstation to an RDS desktop does not work. Users in this 
environment can drag and drop an email .msg file from a network folder within RDS. 
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Auxiliary Equipment in BOMs 

Auxiliary equipment can be associated to a configuration. By doing so, EnterpriseIQ can check for 
availability of the equipment via the Conflict Evaluator tool in the Scheduling module. This tool evaluates 
if there is a conflict for scheduled jobs, and lets the scheduler review any conflicts. (See Conflict 
Evaluator for details).  

EnterpriseIQ will use the rate field for costing manufactured items if an Overhead Cost Element is 
associated to the equipment. 

When this function is selected, the following screen will be displayed. 
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The left side box will display the items currently associated with the standard, the right side box holds all 
available items. 

To ADD any new items to the Auxiliary Equipment pick list: 

➢ Click on the Add (+) button on the left side. Enter the information in the applicable fields 

described below: 

Description The description can be up to 50 characters. 

Rate This is the hourly charge rate for the equipment. In Quoting, this rate will be added to the 
machine rate and included in production costs. 

In BOMs the rate is only used in costing if the auxiliary equipment has a standard cost 
associated to it. 

How Many How many of these particular items are available on the floor. This information is used to 
determine scheduling conflicts. 

EPlant ID Auxiliary equipment can be assigned to an EPlant. To do this highlight the equipment you 
want to assign and click on the EPlant icon next to the navigator bar. Choose one plant and 
then pick from the drop down list. 

Warehouse/Divisio
n Name 

Auxiliary equipment can also be assigned to a Warehouse/Division. Select the 
Warehouse/Division form the drop down list. 

Cost Element If the auxiliary equipment should be included in the standard cost calculations, select the 
ellipsis button in the Cost Element field and select the cost element from the pick list. This list 
will include cost elements with a Type of Overhead only. Note: Auxiliary equipment does 
include setup time in its calculations. 

Setup 1 

Setup 2 

Setup 1 and Setup 2 values can be entered for an auxiliary equipment. The system will 
calculate the Setup time based on the predecessor's Primary Tool and use Setup  Hours 1 or 
2 from the BOM plus the Setup 1 time on each Auxiliary Equipment attached to the BOM 
being added to the schedule.  If an Auxiliary Equipment matches the predecessor's auxiliary 
equipment the value from Setup 2 will be added instead of the value from Setup 1. 

Teardown A value can be entered in this field to track the teardown time of a piece of auxiliary 
equipment. The system will include this time in the setup time of the preceding job on the 
finite schedule. The teardown time added to the setup hours is the total number of hours for 
all equipment that will not be used in the upcoming work order. If more than one auxiliary 
equipment needs to be torn down then the value added to the setup hours is the sum of the 
teardown times of both. 

Note: This setting also affects Machine Capacity planning, Labor Capacity planning, 
and material exceptions dates, but not Daily projected requirements.  

Note: Teardown time is considered when using Auto Load to schedule work orders. 

Note: This field does not apply to the ASSY (1,2,3) MFG Types. 

Note: Teardown time is not considered in the Capable to Promise Calculation, the 
must start date, or costing calculations. 
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The user can edit the description, rate and quantity by highlighting it and typing the correction. An item 
may be deleted by highlighting it and pressing the [Delete] key. The items in this list are global for all 
BOM’s and quotes. 

➢ Auxiliary equipment can be linked to equipment in the Maintenance, Repair and Overhaul 
module by selecting the ‘Assign Tooling Info’ button. Click on the ellipsis button in the Tool # 

field in the pop up form and select the MRO equipment to link to the auxiliary equipment 
from the pick list. 

Associating the Equipment with the Standard 

To make an entry in the Auxiliary Equipment Assigned to this MFG list: 

➢ Select the equipment of choice by using the drop down menu in the description field on the 
left side of the screen, or highlight the auxiliary equipment you would like to attach on the 

right side of the screen and click on the arrow to the left hand button. 

Likewise, you can easily remove an item from the BOM by highlighting it and pressing [Del] key or using 
the arrow over to the right button. 
 

BOM Main Menu Bar Functions 

Many functions are available regardless of BOM Type. Several of these options are available as speed 
buttons or accessed from the menus.  

As with all modules the BOM includes the standard navigator bar to perform functions such as add, scroll 
and delete. 

Note: To delete a BOM select the (-) button on the navigator. A confirm message will appear. If Yes is 
selected the BOM will be deleted. However, if the BOM or Substitute BOM is associated to a work order 
that is on a production report that has not been dispositioned an error will display and the BOM cannot 
be deleted..  

The following sections provide information on these common functions. 
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Authorized Work Centers 

Authorized Work Centers can be established for BOMs to control where a work order associated to the 
BOM can be scheduled and added to production reports (by shift and by work order). If a user attempts 
to add or move a work order in the schedule, perform a setup from scheduling (not RealTime™), or add 
to a production report for a work center that is not authorized, they will receive an Authorization 
Required Status Exception message. The system does not evaluate whether the work center is 
authorized or not during Auto Load. 

To access Authorized Work Orders select the speed button from the BOM form , or select 
Authorized Work Centers from the Options menu. A form will display that lists all work centers that are 
associated to the EPlant, Manufacturing Type, and Cell that are associated to the BOM.  

Note: This applies to all MFG Types BOMs except ASSY1 and ASSY2. For ASSY1 and 2 the Authorized Work 
Center feature is designated at the Assembly Process level. 
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By default all work centers in the form are marked as Authorized. Also, when a new work center is 
created that is based on the EPlant, Manufacturing Type, and Cell that are associated to the BOM, it will 
automatically be added to this list and marked Authorized. The Authorized check box can be unchecked 
to mark a work center as not authorized to run work orders associated to the BOM.  In order to check 
or uncheck the Authorized check box for multiple work centers at once use the toggle buttons or the 
Shift/Ctrl keyboard buttons to select the work centers to change. Then from the right click menu select 
'Check Selected' or 'Unselect Selected' to update the Authorized check box for the highlighted work 
centers. 

Users can sort based on any column in the table. This form also includes a 'Filter Dataset' button to filter 
the list. 

The Authorized check box is also visible in the Runs the Best list. It is a read only field so changes cannot 
be made from Runs the Best list. Users can right click and jump from Runs the Best to the Authorized 
Work Centers form. 

Note: When a BOM is cloned or a substitute BOM is created the authorized work center information 
populates based on the EPlant/MFG Type/MFG Cell query. In other words, if work centers were 
unchecked in the Authorized Work Centers form for the 'cloned from' BOM, they will be checked on the 
new BOM. The system does not assume that the authorized work centers will be the same for the cloned 
BOM. 

Status Exception 

For unauthorized work centers the Status Exception message will state, "BOM is not Authorized to run 
on this work center". The pop up message includes an OK and Cancel button, and a 'Do not show next 
time' option. Security is available on this pop message. 
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If the user has security for the OK button it can be selected to continue to add or move the work order in 
the schedule and add it to the production report for the unauthorized work center. If Cancel is selected 
the work order will not be added/moved. 

Note: There is not a parameter (setting) associated to this feature, the system will always evaluate for 
authorized work centers. 

Note: This is separate functionality from the Runs the Best feature which has it's own warning when the 
scheduling parameter ('Verify Work Center from Runs The Best list') is checked. 

 
 

Bulletin Board Editor 

Select the Add/Edit Bulletin(s) button  to create messages relevant to a BOM (as well as EPlant, 
Work Center, Customer, and Inventory Item) that can be seen in Scheduling, RealTime™ (Individual 
Center Info), and ShopData (RT Work Center).  

The Bulletin Board Editor will display. 
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Select the Source from the drop down list. Then select the ellipsis button to access the corresponding 
pick list, i.e. BOMs, Work Centers, etc. Select the ellipsis button in the Message field to enter a message. 
The Date and User fields will populate automatically with the date/time the message was created and 
the logged in user name. These fields cannot be manually changed. 

A Bulletin Board can be accessed by selecting the Show/Hide Bulletin Board button  in the modules 
that have this feature (i.e. Scheduling). The bulletin board will display messages associated to the EPlant, 
Work Center, BOM, Inventory Item, and Customer if relevant to the current work center. The number of 
Bulletins will display at the top. The messages will be bold until marked read. Select the blue source 
header or the text to mark it as read. Select the 'Read All' button to mark all the messages as read. 

 

Note: This requires the IIS Server to be setup and the information populated in System Parameters-
>Company File Information tab->Web tab for the Bulletin Board to be available. Please see the IIS 
Installation TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf for more 
information. 

The Add/Edit Bulletin(s) button is also available in Customer Maintenance, Inventory, ShopData, and 
RealTime™. 

 
 

https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf
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Checklists 

Checklists can be associated to BOMs. The checklist will display when a setup is initiated, for a work 
order associated to a BOM with a setup checklist, from EIQ RealTime™, ShopData, and RTStation. 
Checklists can also be associated to work centers and Assembly Processes. During a setup the web based 
Setup Checklist form will appear for the user to enter responses to the checklist items. If a BOM/Process 
and Work Center both have checklists the checklist will be combined on the same form with the Work 
Center's checklist listed first. A checklist history is stored for the work center or BOM/Process and can be 
reviewed at anytime, or used for reports. 

Note: This requires the IIS Server to be setup and the information populated in System Parameters-
>Company File Information tab->Web tab in order to view the web based checklist. See the IIS 
Installation TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf for more 
information. 

Setup 

To begin to use the checklist functionality checklist templates will need to be created. Select the 'Setup 

Checklist Templates' button at the top of the BOM module  to access the checklist for the BOM. 
The Mfg # will appear in the title bar. 

https://my.iqms.com/cfs-file.ashx/__key/Technote/IIS-Installation.pdf
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From this form select the template button to access the pick list of checklist templates. Select the 'New' 
button on the pick list to create a new template. The Checklist Template form will display with a new row 
created for the user to enter the checklist information. 

 

Enter the data in the form. The top section is a description of the checklist. 

Checklist 
Description 

Enter the description of the checklist (up to 150 characters). 

Note Enter additional information about the Checklist (255 character limit). 

EPlant This will populate automatically based on the EPlant the user is logged into when 
the checklist is created. Users will only be able to see checklists for the EPlant they 
are logged into. 

Enter the actual checklist items associated to the highlighted checklist record. 

Sequence # The sequence of the checklist item. The sequence can be changed using the up 
and down arrow buttons. 

Text The description of the checklist item. This is a list of steps involved in completing 
the corresponding Checklist. 

Critical Check this box if the checklist item is critical. Critical items must have the status 
column on the checklist populated with Y, N, or N/A in order to complete the 
setup checklist. 
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Note A list of responses can be created which will apply to all checklist items. When the 
employee performs the checklist item they will be able to select from the drop 
down list, or manually enter a note (if allowed) in the Note field to further 
describe the outcome of performing the step. 

To create the list, right click and select 'Edit User Defined List'. Enter the list 
details in the text field. The Drop Down Style can be selected from the list: 

▪ Drop Down - Free form data entry. 

▪ Drop Down List - Predefined Text only. 

▪ System Default - Will be based on the setting in System Parameters 

Once the checklist template has been created it can be assigned to BOMs. 

Assigning a Template 

From the BOM where the template is to be applied, select the 'Setup Checklist Templates' button at the 
top of the BOM module. Select the ellipsis button in the 'Setup Template Checklist' field. Select a 
template from the pick list. If a BOM has a Setup Checklist assigned and a user clones the BOM, the 
Setup Checklist will carry over to the cloned BOM. 

As setups are performed for work orders for BOMs with templates, the system will pop up the web 
based checklist for employees to respond to the checklist items. This will populate the Checklist History 
portion of the Setup Checklist form. 

Checklist History 

Setup Template 
Description 

This is the template description associated to the historical record. 

Setup Date The date/time the work order was setup. 

Work Order The work order number. 

Created On Date and time checklist record was created. 

Created By The user name that created the record. 

The checklist results 

Sequence # The sequence of the checklist item. 

Text The description of the checklist item.  

Critical This box is checked for a critical checklist item.  

Status  The status entered during the checklist process for the item. This will be 
populated with Y, N, or N/A. 

Note The checklist note entered by the employee. 
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Checklist 

During a setup the web based Setup Checklist form will appear for the user to enter responses to the 
checklist items. If a BOM/Process and Work Center both have checklists the checklist will be combined 
on the same form with the Work Center's checklist listed first. 
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Users can select Yes, N/A, or No for each question. There is also a comment field to enter notes for each 
checklist item. Once all of the checklist items have been addressed select the Submit Checklist button at 
the top. If a response is not entered for a critical checklist item (critical checklist items will have a red 
asterisk next to the number) upon submitting a popup with a Yes and No button will appear stating, 
'There are critical items on the checklist that are not marked with a decision. Continue?'.  If No is select 
the user is returned to the checklist to enter a response. If Yes is selected, or if there are no un-answered 
critical items, a message indicating the checklist has been submitted will display. Select Close to exit the 
checklist. The work order setup will then be completed. 

Checklist History 

The information entered from this form is visible from the Setup Checklist form in the Checklist History 
section. 
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Cloning Configurations 

EnterpriseIQ supports the ability to clone (copy) an existing standard. Differences between standards 
may be as simple as a single packaging item in one of the many part numbers, or as major as a change in 
material or color. 

➢ Open the configuration to clone. 

➢ From the menu bar, click on File and choose Clone Configuration from the submenu. The 

following screen will appear: 

 

➢ Enter in the New Manufacturing # 

➢ Check the desired options to include in the clone. Then press [OK]. 

▪ Reuse Processes / Operations - If this box is checked, the system will not create new 
processes/operations (i.e. attached packaging operations, attached process/standard operations, 
and Assembly processes) but instead will reuse the current processes/operations. Changes made on 
the process or components when this option is checked will affect both configurations. 

▪ Include User Defined Form - check this box to include the data within User Defined Form fields in the 
main BOM and Runs Best forms. 

▪ Include Internal Documents - check this box to include the internal documents. 

▪ Include External Documents  - check this box to include the external documents. 

Note:  Documents included for cloning can be attached on the original BOM’s main Documents tab, 
within the Runs Best form, and to components/packaging/operations/processes on the Item Details 
tab. 
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▪ Clone All Manufactured items - This applies to the Complex MFG Type only. If this option is checked, 
the parent item and all the children BOMs and items will be cloned.  The new MFG numbers of the 
children will be the ‘MFG # - sequential #’.  The item numbers will be the ‘item# -sequential #’. For 
example, if the item number associated to the original BOM # is F-38900, the cloned item number 
will be F-38900-1, if the original BOM is cloned again the item number would be F-38900-2. Note: 
When Cloning All Manufactured item, the system stops cloning designated child items with a break in 
the ‘chain’ of designated children. For example, Parent Complex item 123 has three children items: 
Child A - designated complex, Child B - NOT designated complex, Child C – designated complex. In 
this example, neither Child B or Child C will be cloned. Child C, even though it is designated complex, 
will not be cloned because Child B is NOT designated complex (breaking the chain). Note: In situations 
where the manufactured item has documents attached, when cloning Complex BOMs, if the same 
document record already exists on the target, it will be skipped.  This applies to internal and 
external documents as well as email correspondence. (The basis for comparison for emails is an exact 
match on subject and body text). 

Most information from the standard (including routing notes, scheduling notes, 'From RFQ#', assigned 
Checklist Templates, and user fields) will copy over to the new configuration. To edit fields in the cloned 
configuration follow the steps mentioned later on in this manual. The following information will not be 
carried over to a cloned BOM: FG Lot #, an ‘Inactive’ checkbox selection, Email Correspondence, and the 
Runs Best ‘From Date’. 

If the BOM has an attached operation, a new operation record is created with a new number. This is to 
allow changes to the new operation without affecting the other BOMs that use the original operation. 

Be sure to change the item number and description fields of any part that has changed.  

Note: order to clone documents on the Certified Employees tab, the ‘Include External Documents’ option 
must be selected. 

Note: Cloning while logged in as ‘View All’ will not clone an EPlant assigned on the original BOM. 
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Convert BOM To Quote from the BOM Module 

A single level BOM or multiple level BOMs can be converted to a Quote. This process will always make a 
new quote even if a quote exists for the exact BOM. 

Convert to Quote (Single Level) 

To convert a single level BOM to a quote click on the Convert to Quote (Single Level) feature in the File 
menu. A pop up form will appear with a field to enter the New RFQ # that will be created and a Revision.  

▪ Enter New RFQ # - If the 'Enabled' checkbox is checked for the System-Generated RFQ # in System 
Parameters->Sequential Numbering tab, this field will be populated with the next sequential number. 
If the enabled option is not checked thsi field will be blank for the user to enter a value manually. 

▪ Enter New Version - The revision field defaults to 1.  

If the RFQ # and Revision already exist a warning will appear stating this. 
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▪ Select the Update Component Pricing box to have the system update the quote inventory price breaks 
and currently assigned price breaks with the Master Inventory price breaks from the Buying section 
(Buy/Sell tab). If the Update Component Pricing option is not selected, the pricing for purchased 
materials will come from the Buying section of the Buy/Sell tab in inventory for the item (never the 
AKA Buying section) unless the raw material is already in the Quote Inventory list. If it is in the Quote 
Inventory list the system will use that pricing even if it is null.  If the 'Update component pricing' is 
checked but the item has the 'Use Standard Cost in Engineering Quote' option checked (Additional 
tab in Inventory) then the system will not update the price breaks in the quote module. 

▪ If the Update Standard Cost option is checked, items (primary material or attached materials) that 
have the 'Use Standard Cost in Engineering Quote' option checked will have the standard cost update 
in the price breaks in the quote module. If the item does not have the use standard cost option 
checked the system will update the price breaks based on the Buying section based on the Update 
Component Pricing check box. 

▪ If the ‘Quote Due Date is Mandatory’ default value (in Quotation Parameters) is checked the user must 
enter a due date for the new quote. If the parameter is not checked this field will not display.   

All of the values from the fields in the BOM will populate into the quote such as Cell, Operators, Labor 
Rate, Cycle Time, Scrap, etc. 

Note: The Units/Cycle field on the RFQ will default to one and should be updated to reflect the correct 
value. 

Note: Since a specific Work Center # is not associated to a BOM, when converting a BOM to a Quote 
using a Work Center with a Center Type that is also assigned to other Work Centers, the system will use 
the Center Rate, Fixed Center Rate, Setup Hours, and Startup Shots from the first Work Center created 
with that center type. To populate the fields for a specific work center, the user must select one by 
clicking the drop down or search button in the Work Center field on the quote and select Yes to the 
Confirm message to paste the values, then the rates associated to that work center will populate. 

If the BOM is a Generic with attached items that are manufactured the system will first look in the quote 
database and if the item is found the system will use the quote prices. If the attached manufactured item 
cannot be found in the quote database the system will use the pricing from the selling prices on the 
Buy/Sell Pricing tab in Inventory. 

Convert to Quote (Multi Level) 

If the BOMs to be converted include several levels select the 'Convert to Quote (Multi Level)' option from 
the File menu. The following form will appear to enter/accept the New RFQ # and Revision for all 
associated BOMs. If the 'Enabled' checkbox is checked for the System-Generated RFQ # in System 
Parameters->Sequential Numbering tab, the Enter New RFQ # field will be populated with the next 
sequential number for each BOM being converted. 

Note: If the same BOM is listed multiple times (same BOM attached to multiple different sub-BOMs), a 
new RFQ # is needed for each instance. If the RFQ # and Revision already exist a warning will appear 
stating this. 



BOM-Manufacturing Configurations Page 105 of 273 

 

 

Highlight each BOM in the tree and enter the information in the fields. The check box options function 
the same as when converting to a single Quote. 

Note: If the ‘Quote Due Date is Mandatory’ default value (in Quotation Parameters) is checked, the user 
must enter a due date for the new quote on the 'Convert BOM to Quote' pop up form. If the parameter 
is not checked this field will not display.   

Note: If the 'Workflow Mandatory' Quote parameter is checked, a pick list of Quote Types will display 
after entering the details on the 'Convert BOM to Quote' pop up form. Select the quote workflow type 
from the list to continue converting the BOM to a quote. The same workflow type will be assigned to all 
levels when converting a multi level BOM. Users can modify the quote workflow type on a quote after it 
is created.  
 

EIQ Bookmark for BOM 

This option allows the user to drag and drop the icon onto the desktop or a folder in order to open the 

exact BOM up again with one click. Select the  EIQ Bookmark button then drag it to the desktop or 
folder and drop it. The shortcut will be named BOM_id#.eiq by default. 
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Miscellaneous Parameters in BOMs 

This form contains various miscellaneous parameters associated to BOMs in general and for specific 
BOMs. Security can be placed on these fields. 

Efficiency Factor 

The Efficiency Factor default for all BOM's is set up from here. This value will automatically populate the 
Efficiency Factor field when creating new BOM's but can be overridden for an individual BOM. 
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Mfg 

Mfg Effective and Inactive date fields are informational only. If the BOM has an inactive date entered it 
will not stop the items from being entered in sales orders. These fields do show up on the pick list. To 
make the BOM inactive which will hide it from the pick lists, click on the Inactive check box on the 
General BOM Info screen. 

Check Available Regrind % 

This option will only display for BOMs with a MFG Type of: Blowmold, Diecast, Extrusion, Extrusion2, 
Extrusion3, Injection, Rotational, or SFoam. For the Stamping MFG Type it will say ‘Check Available 
Waste % in lbs/k Calc’. 

If this is selected, when the program calculates the lbs/K, it will calculate the available regrind 
(100*Runner wt/Shot weight) and will give a warning if the allowable regrind entered exceeds the 
calculated available regrind. 

If the allowable regrind % is greater than the available the following warning box will appear: 
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The user can choose to Replace the Allowable Regrind % with the calculated amount or Ignore the 
warning. 

Scheduling Options 

▪ Default Planning Fence: This is a calendar days value that will automatically firm a scheduled work 
order during the update schedule process if it is scheduled within the planning fence. During update 
schedule the system will mark planned work orders that are finite scheduled within the planning 
fence days as firm. (Manual work orders will not be marked firm). Once the work orders are marked 
firm they will follow the firm work order rules and no changes will be made to the quantity. This will 
prevent any changes to work orders that fall within the planning time fence. (Note: As an alternative, 
there is a Scheduling Parameter,' Mark work order FIRM on setup', that when checked will mark a 
work order Firm when put into first position). 

NOTE: If a work order is marked firm automatically because it was scheduled within the planning fence 
and is later moved outside the planning fence it will remain a firm work order. If the firm check box is 
cleared at a later date, the work order becomes a manual work order, and the normal manual work 
order rules would apply. 

▪ Mfg Planning Fence: This option is only used in Master Planning Scheduling (MPS). The Mfg planning 
fence is the time frame in days when you want the system to warn you to address an issue about an 
item. For instance, if the Mfg planning fence is set for 15 days, and the order is due within that time 
frame, through Master Planning Scheduling, the user will get a message to make the work order firm 
and release it to the floor. However, if a Default Planning Fence is set the work order will be marked 
firm automatically if scheduled within the planning fence. 

▪ Scopes: You can modify the Run Size Scope for the specific BOM from this tab. The value entered in 
the Mfg Run Size field for the specific BOM will override the run size set as the default. You can also 
view and modify the global Schedule scope and Run Size scope. If changed here the fields in 
Scheduling Parameters will also be updated. Changes made to these fields will effect many work 
orders, so change these values with caution. This is calendar days and not production days. 

▪ Start-up Primary Material: This option is used to set a material requirement for start-ups. This option is 
only available for BOM’s with a primary material. Enter the quantity of material required for start up. 
For example, if 25 pounds of material is required for the start up enter 25 in this field. During the 
update schedule process the system will check if start up material is required and if so the required 
material quantity will be added to the first date of each work order. For example, if a sales order has 
a requirement for 10,000 pieces and the system creates five work orders, the start-up primary 
material quantity would be added in five times, one for each work order (or start up). The 
requirements will be visible in the Material Exceptions and Staging reports. The quantity entered 
here will not effect the standard cost of the item unless the 'Include in Std Cost option is checked. 
The system will use the inventory item’s standard calc quantity to determine the costs 

▪ Include in Std Cost - Check this option to include the start up material in the standard cost calculation 
for the manufactured item. This value will be divided by the standard quantity and added to the part 
weight. Please see the standard cost calculations for more information. 
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▪ Alternate Item Code -  An Alternate Item Code can be associated to a BOM in order for the system to 
know which alternate items can be used for substitutions. The system will only show blends that are 
setup as Alternate Item of the original Blend with a matching Alternate Item Code. In the BOM 
Options menu select Miscellaneous Parameters. From the Scheduling tab select an Alternate Item 
Code from the pick list accessed by clicking on the ellipsis button in the field. See Alternate Items for 
more information. 

Note: Security can be placed on these fields. 

Labor Rate 

You can set a different labor rate for this BOM for Current, Future, Budget, and Forecast costing if 
desired. Otherwise, the BOM will base labor costs on the default Labor Rate stored with the MFG Cell if 
applicable and if not it will use the MFG Type. 

Labor Rate Hierarchy 

1 First the system will use the employee levels set up for each BOM if other than the default is used. If 
the Default employee level is used the system will look at the following for the labor rate: 

2 BOM/Options/Misc. Parameters/Labor tab. 

3 Mfg Cell. 

4 Mfg Type. 

In Employee Levels, MFG Types, MFG Cells, and BOM Misc parameters rates can be entered for Future, 
Budget, and Forecast that will be used when calculating the standard cost of an inventory item. If these 
are not populated the system will use the standard hierarchy for determining labor costs. Refer to 
Assigning Labor Cost Elements and Rates for more information. 
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Reject and Downtime Codes for BOMs 

Each Bill of Manufacture can have specific reject and downtime codes associated to them. When 
displaying Reject and Downtime Codes in Shop Floor modules (RT Monitoring, RTStation, ShopData, IQRF 
and WMS) the system will display the sequential codes as follows: 

▪ If there are reject/downtime codes on the BOM Level the system will only show those codes 

▪ If there are reject/downtime codes on the Work Center level the system will only show those codes 

▪ If there are reject/downtime codes on both the BOM and Work Center levels both will be visible 

▪ If there are no reject/downtime codes on either BOM or Work Center levels all codes will display 
with soft filters on EPlant and the MFG Cell 

To associate the codes to a BOM, select Reject Codes or Downtime Codes from the Options menu in the 
BOM module. 

         

 

Select the insert record button and the next sequence number will populate the Seq field. Select the 
ellipsis button in the Code field and choose a code from the pick list. Only codes associated to the EPlant 
the user is logged into or null EPlant codes will appear in the list. There is also a soft filter on MFG Cell, 
where only the codes associated to the MFG Cell associated to the BOM or work center, or those with no 
cell will appear. 
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Continue this process until all of the desired codes have been added. The sequence of the codes can be 
changed using the up and down arrow buttons. 
 

Runs the Best 

Select the Runs the Best button or from the Options menu click on Runs Best. This is a list of the active 
work centers where the BOM runs the best. The system will automatically calculate which work center 
this Manufacturing Configuration ran best on from the overall efficiency information in Archived 
Production Reports. (Note: Inactive work centers are excluded from the runs the best calculation). 

Note: When just beginning to enter data, no production history is available and the Runs the Best 
calculation will have no data. As the Production Reporting module is utilized and reports are archived, 
this feature becomes more useful, or information can be added manually. 

 



BOM-Manufacturing Configurations Page 112 of 273 

 

Calculate Runs Best 

To calculate the Runs Best information: 

➢ Optionally select a From Date using the drop down calendar in the lower left of the form or 

leave it blank to go back to the beginning of all records. 

➢ Then click on the Calculate button. The options for recalculating include: 

▪ Recalc for this BOM - This will recalculate Runs the Best just for the current BOM. 

▪ Recalc and Roll for All BOM's - This will calculate Runs the Best for all BOMs. The user can choose to 
include all manufacturing cells or recalculate just for a specific cell by making the selection on the 
pop up form that displays after selecting Yes on the confirm message. With this option the system 
will use the 'From Date' associated to each individual BOM if applicable. 

▪ Recalc and Roll for All BOM's - Set 'From Date' - This option will recalculate the Runs the Best for all 
BOMs as above but will use the 'From Date' entered on the current BOM for all of them. A 'From 
Date' must be entered or an error stating, 'From Date' is not assigned - operation aborted' will 
appear. 

The system will calculate the efficiencies of where the BOM has run based on production reports. This 
information is then available in scheduling from the ‘Scheduling Pool’ grid accessed by selecting Insert 
Job. 

Note: The system calculates Runs the Best based on each production run for each work center. The total 
value for runs the best is the average of these calculations for that work center. 

Note: The system will not remove work centers from this list when calculating runs the best regardless of 
the date in the 'From Date' field.   

Runs the Best Calculation: 

The calculation for Runs Best for the majority of manufacturing types such as, Injection, Diecast, Blow 
Mold, and Generic is as follows: 

Runs Best % = (Effective Cycles per Hour / Standard Net Cycles Per Hour) * 100 

▪ Effective Cycles per Hour = Good Parts / (Prod Hours + Chargeable Downtime Hours) / Actual Cavities 
(or Multiplier) 

▪ Net Cycles Per Hour = For many manufacturing types this value is displayed on the BOM under 
Production Summary information. The calculation is based on the number of seconds in an hour and 
dividing it by the standard cycle time. Then factoring in the standard scrap % and the standard 
efficiency % thus giving you a net cycles per hour. 

The calculation for Runs Best for the Extrusion manufacturing type is as follows: 

Runs Best % = (Effective feet per Hour / Standard feet Per Hour) * 100 

▪ Effective Feet per Hour = (Good Parts * Part Length) / (Prod Hours + Chargeable Downtime Hours) 
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▪ Standard Feet Per Hour = this value is displayed on the BOM under Production Summary 
information. The calculation is Feet/Hr = Feet/Lb x Lbs/hr. 

Manually Entering Runs Best Information 

Runs Best information may be added manually by clicking on the Add (+) button at the top of the form 
and then selecting the equipment from the drop down list in the Actual Work Center field. The only 
information that will appear is the work center number (no performance or bar chart information). If at a 
later date the Runs Best calculation is run the system will populate the existing manually created line 
with calculated information for that work center if applicable. If Runs Best has been calculated and a 
user attempts to add the same work center manually an error will occur, 'Actual work center selected 
was found among already calculated runs best records for this BOM. Operation aborted!'. 

Note: The MFG Types of the Work Centers manually added to the Runs the Best list for the BOM should 
match the BOM’s MFG Type.  When a Work Center with a different MFG Type than that of the BOM is 
added to the Runs the Best list, the system may load the Work Order onto that incorrect MFG Type Work 
Center during Auto Load. 

Other Options in Runs the Best 

▪ Copy - This button sets the Actual work center column to be equal to the Calculated work center 
column, overwriting any manual changes made to the actual work center field. 

▪ Wrk Cntr Log - This button brings up the work center log for the Mfg #. The work center log is used to 
record and review notes, tool changes, or any other information pertaining to a job and the machine 
it ran on. See Accessing IQLog for more information. 

▪ Comment - A comment (up to 60 characters) can be added to a runs the best record. This will be 
visible from this screen when accessed here and in the scheduling module. 

▪ Do Not AutoLoad - If this is checked, the work center will not be considered when running auto load.  

▪ Authorized - If the work center is marked Authorized in the 'Authorized Work Centers' module this 
check box will be checked. It is a read only field so therefore it cannot be checked/unchecked from 
here. Users can jump to 'Authorized Work Centers' from the right click option in the lower section. 
Refer to Authorized Work Centers for more information. 

▪ Documents - Select the Documents button  to attach internal or external documents to 
individual Runs Best work centers. These documents can be set to print with the work order when 
scheduled on that work center. Documents attached here can be set to print with None or Work 
Order. 

▪ User Defined Form - Select the User-defined Form tab to create a form with user defined fields. The 
values entered in the fields is based on Work Center+Mfg#. See the User Defined Forms section for 
details. 
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User Defined Form in BOMs 

User defined forms allow the user to create a unique form to store information beyond the scope of the 
original BOM. Once established, this form is available to all BOMs. The User Defined form can be 
accessed from the User Defined Form tab, from the speed button, or from the Options menu. 

See User Defined Forms for more information. 
 

User Fields in BOMs 

User fields can be accessed on the User Field tab or select Options|User Fields to access the six 
alphanumeric and five numeric user fields. These user definable fields are used for informational or 
reporting purposes only. 
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Note fields 1 - 6 are character fields, Value 1 - 5 are numerical fields. User fields one and two will display 
in the scheduling pool pick list when inserting a job on the schedule under the column titles of BOM User 
1 and BOM User 2. The six text fields also are in the BOM pick list and will display the user defined label. 

To define label text, follow the steps below. 

➢ Right click on a field within the user defined screen and select Define Label Text. The following 

screen will appear: 

 

➢ Type in the new caption under New Value and click on [OK]. You will be returned to the User 
Defined screen where you will see the new caption. Click on [OK] to exit. The new value will 

display for all MFG types. 

For the User Text Fields the user can define a list that can be used to populate the user field rather than 
manual data entry. To edit the list for a user field, right click on the blue arrow and select ‘Edit User 
Defined List’. A list form will appear to enter the Text selections that will be available when selecting the 
blue drop down arrow in the field. 
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View/Edit Processes and Operations 

From the Options menu select View/Edit Processes and Operations to view/edit packaging operations, 
component operations, blends, or processes/standard operations. When highlighted on a specific 
attached component/packaging item or operation on the Item Details tab, that record will appear by 
default. To choose another record first choose which view, click on View from the menu and select the 
type of operations you want to see. Then choose from the pick list the specific operation to view/edit. 

▪ Attached Packaging - Review and/or change packaging operations. 

▪ Attached Components - Change the details of attached components operations. 

▪ Blends - Edit blend operations by changing blend percentages, blend components or pricing. 

▪ Process/Std Operation - Edit attached processes or operations by changing the labor rate, the cost 
element or the materials involved. 

Each time an item is attached to a BOM, an operation is created automatically. From this screen users 
can view or edit that information. Typically changes are made at the specific BOM level rather than 
attempting to find the specific operation that needs editing from this menu option. See Attached 
Materials (Components, Packaging and Operations) Details Tab in BOMs for details on all fields 
associated to attached materials. 

From this screen it will list the operation number, class and description. 
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Material tab - The item or parts per can be edited from this tab. Select the ellipsis button in the Item # 
field to access the pick list. Type in the Part Per field to make a change to the number of parts per. If the 
item is a non-inventory item the user will receive an error stating, 'Parts per are not allowed for non-
material items.' 

Documents tab - This tab includes access to the Internal and External document tab to associate 
documents to the operation. 

Routing Notes - Select the Routing Notes speed button to enter up to 2000 characters of notes used for 
reporting. 

Where Used - Select this feature from the Options menu to view which BOMs the operation is attached 
to.  
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Virtual BOM 

BOM's that will be run on virtual work centers should be marked as a Virtual BOM. Once a BOM is 
marked virtual an additional field will be visible to enter the number of work centers that will be running 
this configuration at the same time. This option is only available for Injection or Generic BOM's. 
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To mark the configuration as a Virtual BOM, select 'Virtual BOM' from the File menu on the Bill of 
Manufacture.  

Note: The setting in System Parameters > Company File Information > Application tab > ‘Incorporate 
Virtual Work Centers / Work Orders’ check box must be selected in order to see this in the File menu for 
Generic and Injection BOMs. 

Once this option is selected the Virtual BOM Multiplier field will become visible. Enter the number of 
work centers that will run this configuration at the same time. This field will affect the Cycles/Hr, 
Hours/K Cycles and Net Cycles/Hr. This production summary information is used by the system to 
determine the production hours required for a work order, which in turn affects the must start date. This 
information is not used in scheduling; if the BOM's Virtual BOM Multiplier is set to 10, but the work 
order is scheduled on a work center with 3 virtual work centers, the system will divide the work order by 
3 instead of 10. 

Cycle/Hr  Basic calculation based on the standard cycle time, and how many cycles will occur in one hour. 
3600 / Cycle Time) * Virtual BOM Multiplier 

Example:  

Assume 15 second cycle time and 5 virtual machines 

(3600/15) * 5 = 1200 Cycles per Hour  

Net Cycles/Hr The total number of assumed or net cycles that will be generated in an hour. This field is 
calculated by taking the number of seconds in an hour and dividing it by the cycle time, and 
then factoring in the scrap rate and the efficiency factor. This is the value used by the Work 
Order system to generate the total length of time required to manufacture the part(s).  

Example:  

(3600 / (cycle Time))(1-Scrap Rate percentage)(Efficiency Factor) * Virtual BOM Multiplier = Net 
Cycles/Hr.  

Assume Cycle Time = 15 seconds; Scrap rate = 4; Efficiency Factor = 90 ; and 5 virtual machines 
(3600/15) * .96 * .9 * 5 = 1036.80 Net Cycles per hour 

Hours/K Cycles 

 

This value displays the number of hours required to complete 1000 cycles. It is based on the 
Cycles per hour. Hours/K = 1000/ Cycles per hour. 

Assume 1200 cycles per hour  

1000/1200 = .83 
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Note: The 'Virtual BOM Multiplier' is ignored when calculating the standard cost.  

Adding a new child work center to a virtual work center while a job is running will not affect the currently 
running job. The next job setup will be divided by the number of child work centers associated at the 
time of setup. 

 

  
 

Blend Technology 

EnterpriseIQ supports two kinds of blending activity. The first, and most straightforward, is to simply 
create an inventory item of class PL, then assign two or more materials, by percentage, to the item. 

Each material attached to the blend is measured as a percentage of the whole. For example, a simple 
blend may consist of 50% of one type of material and 50% of another. During the production reporting 
process, and depending on how the blend was set up, the base blend material or it’s individual 
components will be relieved. (See Defining a New Blend Operation for more information). 

Another blend method is to use a Generic BOM. Like the basic method, this technology allows the 
creation of a material specification which can call an unlimited number of other materials. Used in this 
manner, EnterpriseIQ can be used to create work orders, and the actual operation of creating the blend 
can be scheduled like any other job.  

Because blends created in this manner can also be consumed by another BOM, you can create an 
operation to make the blend, then consume it during a production process. EnterpriseIQ can report that 
you need to make the blend (if none is already available) and that you need to purchase the raw 
components, if they are also unavailable. In essence, this technology can therefore be used to schedule 
pre-operations.  

It is also an option to create Phantom items where work orders are not created, but the system will 
automatically know to consume the components if the phantom item inventory level is zero. (See 
Creating BOM's for Blends and Regrind using Phantoms Items for more information). 
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Defining a New Blend Operation 

If the raw material required is not in the master inventory pick list, the user has the option of being able 
to define a new raw material while creating the manufacturing configuration. Defining a new material 
may include defining a blend of multiple materials. 

To create a new raw material that is not a blend from the Quick Add form enter the Class, and item 
information but do not check the Blend box. 

EnterpriseIQ only allows the user to call one raw material inventory item per configuration. If the item 
will require a blend of two or more raw materials, the user can create an operation that will call these 
multiple inventory items. Creating a Blend Operation will also add a Blend item to inventory. 

Follow the steps below for creating a blend operation. 

➢ From the General BOM entry screen, select the pick list near the Material Spec. field. 

➢ At the bottom of the pick list, select New. The following screen will appear: 

 

Make sure and place a check mark in the box near the word “Blend.” This tells the system that this 
material is made up of a blend. 

Use the field listing below for assistance in filling in each of the fields on this screen. 

Class The Class defaults to PL but can be changed to any class that is designated as a primary 
material. 
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Item # Enter the blended raw material item number here. 

Note: If the ‘System-Generated Inventory#’ option is enabled in System Parameters-
>Sequential Numbering tab, the system will populate the item number with the 
next sequential number. The value can be overwritten if desired. 

Rev Enter a Revision number. 

Description Enter a description here to identify the item number. The description entered here will be 
used throughout the system to identify the part number. 

 

Unit Unit of Measurement. Click on the arrow down near this field to select the unit of 
measurement (i.e. each, lbs, gal, roll, ft. or in). 

Lead Days The number of calendar days it normally takes to receive this item once a purchase order is 
created. Primarily used for purchased items. Used in the Material Exception List to generate 
a Must Order By date based on the Must Arrive By (manufacturing) date. 

This will populate the lead days field in inventory. 

Vendor From the Vendor tab the user can enter the default vendor for this material. Click on the 
ellipsis button on the Vendor # field to bring up the Vendor pick list. Select the vendor from 
the list and select OK. 

Standard Cost During the Quick Add process the user can also associate the new material with a standard 
cost element and a standard cost. From the Std Cost tab select a cost element from the drop 
down list in the field. Then enter a standard cost for the item. 
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➢ Click on [OK]. The Define Blend Operation screen will now appear. 

 

The information shown in the top portion of this screen is generated by the system. You can accept the 
Operation # and Description shown or make a change prior to going onto the next step. 

➢ If the material is to be blended AT the work center, then click on the box indicating so. If it 
will be blended AWAY from the work center, leave this field blank. 

Options Dispositions Material Planning 

Blended at Work 
Center is Checked 

During dispositioning only the 
individual components will be 
relieved from inventory. 

Material Planning will look at 
the on hand of the 
components NOT the blend. 

Blended at Work 
Center is not 
Checked 

During dispositioning only the 
blend item will be relieved 
from inventory. 

Material Planning will look at 
the on hand of the Blend first 
then the components second. 
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Note: Whether a material is blended at the press determines how the raw materials will be relieved from 
inventory. When a blend is made at the Work Center its “individual ingredients” are removed from 
inventory at the time of production; when a blend is made away from the Work Center the “Blend 
inventory item” is removed from inventory. 

➢ Choose if the blend will be defined by Let Down Ratio. Check the LD Ratio box if the material 
usage will be based on a Let Down Ratio versus a percentage. 

➢ Now, select the Materials tab located towards the bottom of this screen. 
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➢ Click on the ADD [+] function key. 

➢ Click once on the Item # field and then again on the pick list box (shown above) within this 

field. 

➢ Select the material to be used in the blend.  

Notes: The materials added to a blend must all have the same unit of measure as the raw material 
inventory item. If a blend has a unit of measure in LBS the components must be in LBS also.  

Manufactured items should not be added as components of a blend operation as a work order will not 
be created for the component since a work order is not created for the blend. In situations where a 
manufactured item is part of a blend users should create a BOM for the blend rather than use the blend 
operation functionality. See Creating BOM's for Blends and Regrind using Phantoms Items for details. 

➢ Enter the blend percentage amount this raw material item takes as part of the overall blended 

material or if you are defining the amount of material required based on a Let Down Ratio, 

enter that amount. There may be an unlimited amount of raw materials that make up the 
blended item, but the total percentage of all the items equal 100%. 

➢ Click on the Post/Edit function key within this section prior to exiting this module. 

NOTE: You will not be allowed to exit from the Define Blend Operation screen until the total equals 100. 

Blend Standard Cost 

EnterpriseIQ computes the standard cost of a blend based on the standard cost of each raw material in 
the blend when you define it. To calculate the standard cost, go to the STD Costing tab of the blend 
inventory item and click on the Calc button and say Yes on the Confirm box. The Cost Calculations form 
will appear showing the Current and Future standard cost for the blend. To accept the new standard 
cost, click on the Roll to Standard Cost button. This standard cost is copied to the inventory file on the 
STD Costing tab as the raw material cost. 

Blend Buying Price Breaks 

The price breaks for the blend can be manually entered or they can be calculated on the Inventory Item 
tab of the blend form. Click on the calculator button in the lower section to calculate the price for just 
this blend. Choose which price break structure to use. The system will then calculate the price breaks 
based on the prices associated with all of the attached materials and the percentages required for the 
blend. These price breaks will then fill in on the Buying portion of the Buy/Sell tab on the main inventory 
form. 

To calculate the price for ALL blends click on the calculator button at the top of the form. The breaks will 
use the same quantity price bracket used during the first calculation or if this is the first time calculated, 
the program will use the item with the largest percentage. 
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Editing a Blend 

 

If the raw material attached to the configuration needs to be edited, complete the following steps: 

➢ Place the cursor on the Material Spec. description field and right click. 

➢ Select the option “Jump to Inventory” from the menu. The Inventory module will appear with 

the raw material item to change. 

 

To EDIT the materials that make up the blend: 

➢ Under the Additional tab (bottom of screen), click on the Define Blend button near the Blend 

field. The Define Blend Operations screen will appear. 

To EDIT the item number information: 

➢ To make changes directly to the materials attached that make up the blend, click on the 
Materials tab. From this screen, the user can change the blend item numbers, blend 

percentage(s), quantities and price breaks. Additional notes may be attached (or changed) 
at this point by clicking on the Notes tab. 

Remember to SAVE all changes before exiting back to the BOM entry screen. 
 



BOM-Manufacturing Configurations Page 127 of 273 

 

Creating BOM's for Blends and Regrind using Phantoms Items 

A phantom item is a product that is consumed in a higher Bill of Manufacture. If an item is marked as a 
phantom the inventory level will never go negative when being consumed unless the Drive Phantom 
Negative check box is selected. Instead the components of the phantom item will be removed. Items 
that are marked as phantoms will not have work orders generated for them. 

Note: A top level item that is sold should not be marked as a phantom item. 

The benefit of creating phantom items is the system will automatically know to consume the 
components if the phantom item inventory level is zero. 

This technology can be used for blends that are set up as Generic BOM's. The system will pull from the 
existing on hand blend until it goes to zero, and then it will start pulling from the blend components. 

Regrind 

To set up a phantom regrind: 

1 Create a Generic BOM for the Regrind attaching the virgin raw material as a component at 1 per. 
Create the inventory item on the items detail tab as a PL class item. 
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2 Jump to Inventory on the regrind item number and check the box “Phantom Item” on the 
Manufacturing tab. 

 

3 Create a Generic BOM for the Regrind mix. Make sure that the inventory item that represents the 
regrind mix on the items detail tab has an item class of PL.  

4 As in step 2, jump to inventory and mark this item as a phantom on the Manufacturing tab.  

5 In the item details tab, attach the Regrind BOM created in step 1 as a component at the regrind % 
used as parts per. (For example: if you are using 25% regrind - type .25 in the parts per field).  

6 Next add the “virgin” material as a component using a parts per to equal the percent of virgin 
material used, i.e. .75.  
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Note: If Manufacturing Cells are being used, all of the BOM’s must be associated to a cell in order for the 
requirements to flow through correctly. 

 

7 Attach the regrind mix PL item to the injection BOM that utilizes that material. 
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Below is an example of the BOM Tree and Routing Diagram for this set up. 

 

 

Blend 

If the resin used is a blend follow these steps: 

1 Create a Generic BOM for the virgin blend. Create the inventory item on the items detail tab as a PL 
class item. Right click and jump to inventory to mark this item as a phantom in inventory. Attach the 
virgin raw material and the additive(s) as components at the % used in the parts per field. (i.e. the 
resin at .96 and the additive at .04). 

2 Create a Generic BOM for the regrind blend. Create the inventory item on the items detail tab as a PL 
class item. Right click and jump to inventory to mark this item as a phantom in inventory. Attach the 
virgin blend at 1 parts per. 
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3 Create a Generic BOM for the Regrind mix. Create the inventory item on the items detail tab as a PL 
class item. Right click and jump to inventory to mark this item as a phantom in inventory. Attach the 
Regrind blend BOM as a component at the regrind % used as parts per. (For example. if you are using 
it a 25% - type .25 in the parts per field). Also add the virgin blend material as a component using a 
parts per to equal the percent of virgin material used, i.e. .75. 

4 Attach the regrind blend mix PL item to the injection BOM that utilizes that material. 
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See below for an example: 

 

 



BOM-Manufacturing Configurations Page 134 of 273 

 

Transactions 

Inventory levels for raw materials will need to be maintained for all items using manual transactions and 
back flushing. Because the items are marked as phantoms no work orders are generated for them 
therefore production reporting is not used. For example when the regrind mix is blended a manual 
transaction with the back flush option checked is done. This ensures the on hand inventory levels for the 
regrind mix is accurate. 

 

Production Reporting 

When manufactured items are added to a production report the raw material usage will flow through 
based on current on hand inventory for the attached raw materials. An item will be consumed until the 
on hand goes to zero then it will use the next component. 

Using the BOM Tree from below see the following examples: 
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Ex #1: 

To produce 1000 items the required material is 220.463 lbs. (1000 x .220463). 

On hand Inventory: PH-RX MIX = 100 

                                 PH-REGRIND = 0 

The quantities dispositioned would be as follows: 

 

The system would use the 100 lbs of the regrind mix on hand and because there was not any regrind it 
would consume the rest in the virgin raw material component (RM-555) to equal the 220.463 lbs 
required. 

Ex #2: 

On hand Inventory: PH-RX MIX = 100 

                                 PH-REGRIND = 50 

The quantities dispositioned would be as follows: 
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The system would use the 100 lbs of the regrind mix on hand. Then because there is enough regrind to 
make the proper mix the system will consume the regrind and the raw material at the 25% regrind 
requirement. (220.463 -100 = 120.4634; 120.4634 * .25 = 30.12) 

Ex #3: 

If there were only 20 lbs of the PH-REGRIND then the system would use all of that plus enough RM-555 
to equal 120.4634 (100.4634). 
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Note: When using Phantom items and lot numbers, if the phantom item does not have lot number, the 
system will use the upper level items lot number for the translog entry. This ensures that the lot 
information will be available in the Lot Tracking module. 

Material Planning 

Material planning will first look for the on hand for the highest level material and if it is not enough it will 
go through the hierarchy to determine requirements. If there is not enough of the regrind mix or regrind 
it will tell the buyer to purchase more components (in this example more virgin plastic). 

Examples: 

Ex #1: 

On hand Inventory: PH-RX MIX = 100 

                                 PH-REGRIND = 0 

                                 RM-555 =0 

Material Exception List will show a requirement of 120.46 lbs of RM-555 

Ex #2: 

On hand Inventory: PH-RX MIX = 100 

                                PH-REGRIND = 20 

                               RM-555 =0 

Material Exception List will show a requirement of 100.46 lbs of RM-555 

Ex #3: 

On hand Inventory: PH-RX MIX = 100 

                                 PH-REGRIND = 50 

                                 RM-555 =0 

Material Exception List will show a requirement of 90.35 lbs of RM-555 

Comparison of Phantom Blends to Inventory Blends 

As an alternative to the usage of phantoms, blends can be created in the inventory module. The biggest 
difference is the system will not flow through the entire hierarchy to determine usage and requirements 
as it does with a phantom. However, the advantage of inventory blends is mostly in the set up as 
numerous BOM's will not have to be created. 

When using Inventory blends the following logic applies: 
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If Blended at Work Center is checked: 

▪ Material Planning - The system will not look at any blend on-hand, only the components. Only the 
components will show up in material exceptions. 

▪ Dispositions - Only the blend components will be dispositioned. The blend itself will not ever be 
removed during dispositioning. 

If Blended at Work Center is not checked: 

▪ Material Planning - Material planning will first look at how much blend is on-hand and if there is not 
enough, the blend components will show on the material exceptions. 

▪ Dispositions - Only the blend will be removed during dispositioning, never the components. 
 

Two Shot Molding 

Two Shot molding is basically treated as one shot. In two shot molding, every single shot, other than the 
very first shot, produces one finished part. Assuming the cycle time is 30 seconds, from the second shot 
on, a finished part is produced every 30 seconds, therefore the cycle time should be entered as the time 
for a single shot. If two materials are being used the user will need to create a blend operation, with the 
Blend at Work Center option selected, of the two materials in the right proportions of the two base 
resins. 
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Complex MFG Type BOMs 

Complex is a specific manufacturing type designed to simplify the scheduling process where multiple 
work orders are involved in producing a product, and the various operations are performed on multiple 
work centers that make up a complex line. When a Complex BOM is created all of the required BOMs are 
associated to the complex BOM, and those that are part of the complex line are designated as such. 
When the work order for the complex BOM is set up in the first position on the Complex Line,  the 
system will automatically set up the designated child work orders on the work centers associated to the 
Complex Line. 

For more information on the set up and use of the Complex MFG Type please refer to the Complex 
Manufacturing TechNote https://my.iqms.com/cfs-file.ashx/__key/Technote/Complex-MFG.pdf. 

The BOMS for the Complex MFG Type are similar to a Generic BOM. The only difference is that the 
additional BOMs are designated as part of the complex line using the graphical visual routing form.  In 
that screen you can right click to add the BOMs  and then designate them as part of the complex line.   

To create a new Complex BOM, select the COMPLEX MFG Type from the selection criteria list. Enter the 
MFG # and other details based on the field listing for Generic BOMs (See General BOM Information for 
Generic BOMs for details). 

https://my.iqms.com/cfs-file.ashx/__key/Technote/Complex-MFG.pdf
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Once the BOM is created select the ‘Designate Complex Child BOMs’ button  at the top for the 
form to associate the BOMs required to manufacture the Complex item. A Complex Visual Routing 
diagram will appear showing the main level BOM as a blue box. 
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From this screen create or attach the child BOMs using the right click menu options. Use the' Add 
Routing BOM' to create new BOMs, use the 'Add Routing BOMs Like' to clone existing BOMs, or use 
'Components' to associate existing BOMs. 

Note: A complex child can only have one parent. If a user must have two they need to clone the children 
also. 

Add Routing BOM - To create new child BOMs, right click and choose Add Routing BOM. Choose the Mfg 
Type and cell (optional) then fill in the fields on the form with the information for the step. An unlimited 
number of child BOM can be created. 

Add Routing BOM’s Like - This option allows the user to ‘clone’ a BOM and add it to the routing diagram. 
After selecting this option a Routing Diagram pick list will appear. The user can double click on an item to 
view it’s routing diagram. Once the desired step is found, drag the step(s) from the pick list and drop it 
onto the step it will follow in the visual routing diagram. A ‘List of items to be cloned or reused’ will 
appear. Enter the desired Mfg#, Item #, Rev, and Description. 

NOTE: To add existing BOM’s (not cloning) to the routing diagram use the Components option (discussed 
below) and select a FG or WP item as the component. 

Components - This function enables you to add any components from your master inventory. After 
selecting this function a form will appear to add the components. Click in the Item # field and select the 
ellipsis button. The Add Components from will appear. To add FG or WIP items select ‘Components’ from 
the Type drop down list. Select the item from the list and enter the Parts Per, then select OK. 
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Designate the BOMs as Complex Mfg – If the attached BOMs are part of the complex manufacturing 
process, they must be designated as complex manufacturing. To do this, place the cursor on the blue box 
and use Ctrl + Left Click. A blue outline will be displayed around the Complex child BOM/routing box as 
shown below. 

 

Additional Options: 

Edit Routing BOM - This function brings up the BOM for editing purposes. 

Delete Routing BOM - This function will delete the BOM Routing step you right clicked on and all of it’s 
attached steps. This only removes the routing step(s) from the diagram it does not delete the BOM(s). A 
pop up screen asking if you are sure will appear. To delete the step(s) click on the Yes button. 

Routing Notes - This brings up the Routing Notes for the routing step. This is a 2000 character note field 
used for work instructions for routings. This information will print on the Routing Packet report available 
in work orders. 
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Compound1 

The Compound1 manufacturing type is used to create items with a unit of measure based on a weight 
such as grams or pounds.This manufacturing type is similar to Extrusion2 where there is a Lbs/Hr field, 
however there is no primary material. The item produced is made up of several components which also 
must have a weight type unit of measure. The components are assigned on the item details tab similar to 
the Masterbatch manufacturing type. 

All of the fields are the same as described above (in General BOM Information for Generic BOM) except 
as noted below: 

General BOM Info tab: 

Lbs/Hr. Required data. The amount of material (in pounds) that will be used every hour. 

 

Assigning Components 

There are three methods to assign the components: Assign Components by Percentage, Assign 
Components by Quantity, or Assign Batch Components by calculating unit quantity based on weighted 
average. 

 Assign Components by Percentage - Components are added by entering a percentage using this 
speed button. A form appears to associate all of the required components to produce the item. 
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From this form select the ADD (+) button and then click in the Item # field and select the ellipsis button. A 
pick list of inventory items with a primary material class will appear. Select the item from the list and 
enter the Percent required of this material. Only items with a weight type unit of measure are allowed to 
be selected. The Qty Per field is based on the manufactured items unit of measure. It is calculated based 
on the Percent. For example, the manufactured item has a UOM of LBS, the component item’s UOM is 
KG with a Percent of 33%, the Qty Per will be 14.96847, (33 * 0.45359). Continue this process until all of 
the required components have been added. The Percent must total 100%. 

 Assign Components by Quantity - Select this button to enter the components by quantity and then 
calculate the percentages.  
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from this form select the ADD (+) button and then click in the Item # field and select the ellipsis button. 
Select the item from the pick list and enter the Qty Per Std. Continue this process until all of the required 
components have been added. Select the Calculate button to have the system calculate the Percent. The 
Percent must total 100%. 

Note: The Add Material, Change Material, and Delete Material options from the right-click menu are 
disabled for Compound1 components since only the BOM Worksheet should be used for making 
adjustments to Compound1 components. 

 Assign Batch Components by calculating unit quantity based on weighted average - Select this option 
to have the system calculate the unit quantity based on weighted average. The following form will 
appear: 
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From this form users can add materials to be used for the batch. Select the insert record button to add a 
row then select the ellipsis button in the Item # field to access the inventory pick list. Enter the quantity 
in the Parts field.  

Select the Calculate button to have the system perform the weighted average calculation. Following are 
the calculations with examples based on the third line in the above screen shot. 

▪ Unit Qty = (Qty/SUM Qty)  45/60 = .75 

▪ Percent = (Unit Qty*100)   0.75 * 100 = 75 

▪ SPG Total = For each item Parts/SPG = D, then SPG Total field = SUM(Parts/D):  D = (5/1.11) + 
(10/0.9) + (45/1.05) = 58.4728; SPG Total = 60/58.4728 = 1.0261 

▪ Cost Total = (SUM(Unit Qty*Cost))  (0.75 * 2.624762) + (0.083333 * 0.6672) + (0.166667 * 
1.821101) = 2.3277 

If changes are made recalculate by clicking the Calculate button.  

Any changes made to the worksheet are reverted if Cancel is clicked. 

Clicking Save & Exit on worksheet, saves the changes and updates the BOM. 

Right click on an item and select 'Jump to Inventory' to open the inventory module for the item. 
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Extrusions - General BOM Information 

The following information is specific to the Extrusion Manufacturing type. The sample below shows a 
completed configuration. This is the main entry screen for building a BOM for an Extrusion standard. It 
contains all of the standard information such as the customer, manufacturing type, line size, Feet/Lb, 
Lbs/Hr, materials, etc. 
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Extrusion MFG Types 

There are three extrusion manufacturing types available in the system. 

▪ Extrusion 

▪ Extrusion2 

▪ Extrusion3 

The chart below describes some of the differences: 

Type Item BOM Info. Work 
Center 

Typ
ical 
UO
M 

RealTim
e 

Prod. Rep. 

EXT Part Length Feet/Lb and Lbs/Hr; RT 
Signal Rate 
recommended if the 
signal does not equal 
the part length 

Line Size Fee
t* 

 

Feet to 
Go 

Total 
Length 

EXT2 Part Weight Lbs/Hr; RT Signal Rate 
required for 
production reporting 
(RT is not required for 
EXT2) 

Center 
Type 

Lbs
. 

Lbs. to 
Go 

Total Lbs. 

EXT3 Part Weight Lbs/Hr; No RT Signal 
Rate 

Center 
Type 

Eac
hes 

Parts to 
Go 

Total Parts 

Note: Items manufactured with an EXT2 and EXT3 manufacturing type must have a weight UOM, and not 
'eaches'. 

Note: It is recommended that users use the default of Feet imperial UOM and not inches.  Inches 
causes a problem because the system converts from feet to inches by using factor of 83.33 (1/12 = 
.0833333333 indefinite) which could cause rounding issues. 
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Field Listing for Extrusion Standards 

The following field listing details the information that is required for each extrusion configuration. The 
information in the field listing has been broken down into separate sections (corresponding with your 
screen) for easy reference. Use the field listing to familiarize yourself with the data fields prior to making 
any entries. 

Note that one of the major differences between an Injection BOM and an Extrusion BOM is the way the 
rate of production is captured. An Injection BOM requests a Cycle Time, where an Extrusion BOM 
requests a Feet per Lb value and a Lbs/Hr value. Taken together, EnterpriseIQ can generate a valid rate 
of production. 

BOM/Standards Info 

Mfg # Up to 50 characters can be entered in this field. The number entered here is the number of the 
actual standard.  

Each configuration number and routing number combination must be unique. If the user enters 
a Mfg #/Routing # combination that already exists, a prompt will be issued informing that a 
duplicate number was entered. The user will need to reenter a new Mfg or routing number. 

Note: To view the STANDARD ID for the BOM select the Alt F1 keys and a pop up will display the 
ID (for example, Table = IQMS.STANDARD, ID = 46825). 

Routing Seq # This field can be used for informational purposes to define the routing step sequence of the 
BOM when there are several steps. This field displays in the BOM pick list. 

Customer This is not a required field, but is often used to associate a job with a particular customer. If you 
are a proprietary producer, you may leave this blank or list your company as the owner. 

To select a customer, type in the first couple of letters of the customer’s name and the system 
will hyperbrowse to that customer. Another method is to select the customer from the pick list 
near the customer field. 

From RFQ #: The information displayed here originates from the Quote module and will only be present if the 
standard was converted from a Quote. 

This field cannot be edited. 

BOM Control # The BOM Control number will change automatically when someone makes a change to the 
configuration. This field cannot be edited. This field will not update immediately. In order to see 
the change, the user would have to exit the BOM module and come back in. 

The field consists of today’s date, time and EnterpriseIQ user ID of the person who made the 
change. 

Schedule Info The user can enter up to 250 characters of information that will display when a work order is 
scheduled to a work center that uses this BOM. The information can be printed using the Print 
button from the BOM or from the schedule. 

EPlant Name This field is used to designate the configuration to a specific EPlant. It is not a required field if 
EPlant is not being used. 
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Inactive A BOM can be marked inactive. This will ‘hide’ the BOM from pick lists. To view an inactive BOM 
the pick lists have a new button in the upper right corner to ‘view inactive’ items. 

1st Article Ins 
Date 

Enter the First Article Inspection date using the drop down calendar (Optional). This is the date 
that the configuration was first approved for use in a production run. This field is for information 
purposes only. 

This field description can also be changed by right clicking on the field and selecting the Define 
Label Text option. Enter in a user defined caption in the New Value field. The customized caption 
is based on Manufacturing Type. If the caption is changed for an Injection BOM, all of the 
Injection BOM’s will have that same caption but not other types of BOM’s such as Generic. 

 

Material/Regrind 

Material Spec. This field is used for selecting the material that will be used for this job. This section has two 
fields--one will list the material item number and the other will fill in with the description. The 
user can “Jump to Inventory” by right clicking of the material description field. Use the Jump To 
function to make changes to that item, check quantities on hand, etc. 

For information on defining blends, please Defining a New Blend Operation. 

Note: For EXT2 BOMs, the Primary Material should not be an item created from a Generic Bom.  
If it is a blended material it should be added to the item details tab instead. This will prevent an 
off balance in Post Inventory Transactions. 

EPlant The EPlant information associated with the material. 

RT Signal Rate Recommended for Extrusion, Required for Extrusion 2, Not a field for Extrusion3. 

Set the RealTime Signal Rate to the number of feet or pounds produced within the RT Signal time. 

The system uses this field to calculate the Total Length (Extrusion) or Total Lbs (Extrusion 2) for 
production reporting. The calculation is Total Cycles x RT Signal Rate. 

Notes: 

▪ This is required for the Extrusion Mfg Type when the part length is different than where 
RealTime receives the signal. 

▪ This field must be filled in if using the `Dispo by Cycles' option on the Item Details tab for 
attached components. 

▪ Always required for the Extrusion 2 Mfg Type. 

Allowable 
Regrind% 

This field is used to enter the amount of allowable regrind that can be used for this job. 
EnterpriseIQ will assume regrind consumption up to this amount, if the job will generate that 
much. This field is used in the calculation for Lbs/K (does not apply to EXT), and is related to the 
Disposition Regrind option below. 
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Shift Backflush This field determines how the material will be dispositioned (backflushed) at the time of 

production reporting. To access the screen click on the  Edit Shift Backflush Parameters 
button. There are three options: 

Total Cycles at Shot Weight - This is the default method. The system will calculate total cycles at 
total shot weight for the raw material usage. 

Total Cycles at Part Weight - If this option is checked the system will calculate the total cycles at 
part weight. The runner and sprue are not included in the calculation for raw material usage. 

Notes: Since there is not a value for a runner and sprue on an Extrusion BOM the first two 
options are essentially identical. 

This option is not available on EXT2 BOMs. 

Good Parts Only at Part Weight - If this option is checked the system will calculate the good parts 
only at part weight for the raw material usage.  

Regrind Option: 

If the user selects this option, the program will backflush from the regrind on hand based on the 
amount entered in the Allow Regrind% field. During dispositions, the program will reduce the 
amount of virgin material used by the quantity of regrind. This question has NO EFFECT on the 
total amount of material used. 

Example 1: Leave the box un-checked: 

During dispositioning, the program calculates that you used 100 lbs of material. 100 lbs of virgin 
material and 0 lbs of regrind will be relieved from inventory.  

Example 2: Check the box: 

During dispositioning, the program calculates that you used 100 lbs of material. At 20% regrind, 
80 lbs of virgin material and 20 lbs of regrind will be relieved from inventory. If you have no 
regrind in the inventory file, the regrind amount will go negative. 

 

BOM Manufacturing Details 

Mfg. Type This field shows the TYPE of manufacturing this standard will be used for. Cannot be edited. 

Cell Manufacturing Cells are associated to specific MFG Types and are used to designate separate 
areas in your facility. Manufacturing Cells allow a logical grouping of work centers. Group work 
centers by location, product line, process, etc… for separate scheduling and production 
reporting. 

Cells are discussed in the Setup Manual under Manufacturing Cells. Refer to that section for more 
information. 

Line Size 
(Extrusion) or 

Center Type 
(Extrusion2 & 
Extrusion3) 

The field information displayed is based on the TYPE field in the Work Center module. The Line 
Size is the measurement (or diameter) of the extruder barrel. 

The machine scheduling portion of EnterpriseIQ will group production jobs together according to 
the line size, though you can override this behavior. 



BOM-Manufacturing Configurations Page 154 of 273 

 

Feet/Lbs Required field for Extrusion Mfg Type. The number of feet generated for every pound of material. 

(This field is not on the Extrusion 2 or Extrusion 3 manufacturing type BOM’s). 

Note: It is recommended that users use the default of Feet imperial UOM and not inches.  
Inches causes a problem because the system converts from feet to inches by using factor of 
83.33 (1/12 = .0833333333 indefinite) which could cause rounding issues. 

Lbs/Hr. Required data. The amount of material (in pounds) that will be used every hour. 

Labor This is the labor required at the press to run this operation. This field is used to compute the 
labor hours required to complete the work order. 

To enter the required labor click on the ellipsis button in the labor field and the following form 
will appear: 

From this screen click on the ADD (+) button, enter in the quantity of operators required (this 
does not have to be a whole number) then select the Employee Level Code from the drop down 
list. The Labor Rate will fill in with the rate associated with the code. 

The user can select multiple labor codes and associate fractions of operators per code or multiple 
operators per code. 

EnterpriseIQ supports a range of 0.00 to 999 operators per job. A number less than 1 can be used 
for jobs running automatically and an operator is not always at the press. For these tools, a 
partial number such as 0.5 is entered depending upon the number of machines the operator is 
tending. 

The Employee Levels list is created in Sys Setup->System Parameters->Lists. An unlimited number 
of employee levels may be created for use in the BOM module. The system comes with a Default 
labor code. 

If the Default labor code is selected the system will use the labor rate associated with the specific 
BOM (BOM->Options->Misc Parameters->Labor tab). If that is blank it will use the labor 
associated with the Manufacturing Cell. If the cell does not have a labor rate associated with it 
the system will use the labor rate associated with the Manufacturing Type. 

SetUp Hours 1 This is the typical time in hours required to set up the tool. Use a close estimate, but remember 
that it could vary from time to time based on the previous job. The schedule will add this amount 
of time to each work order, or bucket, for this configuration. 

This field can also be used to determine the set up cost portion for a manufactured item. Setup 
Labor can be broken out on the standard cost of a manufactured item. This option must be 
turned on in system parameters (Sys Setup->System Parameters->Inv Setup tab). When activated, 
the user can add a cost element and type to an employee level. There are two supported types: 
Setup and Production. When the standard cost is calculated the system will check to see if this 
option is on and if so will break out the labor costs to the cost elements attached to any 
employee levels on the BOM. For “Production” types, the calculation will remain as is. For 
“Setup” types, the system will look at the number of setup hours 1 on the BOM times the 
number of operators for that type times the rate for the employee level divided by the standard 
run qty. 

Please see the Standard Cost section or the Inventory section for more information on the 
standard set up cost. 
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SetUp Hours 2 This field is used in the schedule when the same tool is running consecutively in a machine 
instead of Setup Hours 1. If the same tool is running back to back in a work center the Setup 
Hours 2 value will be used instead of Setup Hours 1. For example, this value can be set to zero 
and if the same tool will be running back to back the schedule will not add the set up to the 
schedule which will provide a more accurate end time for the job. 

Scrap% This is the estimated amount of scrap that the production process itself will generate. This is 
used in calculating the extra production time and extra material you will need. 

Because each configuration can have it’s own scrap rate, you should not include any other 
anticipated scrap usage here. EnterpriseIQ will calculate the total of all the rates and add the 
yielded scrap back into the job prior to production. 

Note: The system will include the scrap % in the work order lbs/kgs required field. 

UOM Unit of Measurement (i.e. feet, inches, meters, yards). This UOM defaults to the UOM set up in 
the Quote module under Misc/Rates and Parameters. 

Eff. Factor You can adjust the total time required to produce the part with this field. Enter an efficiency 
factor that accounts for production problems that effect overall performance. 

Entries made here will affect the Net Feet/hr and Feet/K fields in the Production Summary. 

This field is used to calculate the assumed production time. 

FG Lot # This selection allows the user to assign a Finished Goods lot number to the configuration. For 
additional information on this field, please see Finished Goods Lot Number. 

Assy @ Mach. This option should only be checked when setting up an assembly at the press configuration, 
where you need more than one produced part to make the final assembly. For example, if it 
takes two cycles to make enough parts to create the actual part number, click this option.This 
changes the terminology on the Item Detail page from Cavities to Multiplier. The multiplier can 
be set to.5 of a part. This means that only half of the part is made each cycle. With this 
knowledge, EnterpriseIQ understands that it will take 1000 cycles to make 500 parts 

 

 

 
 

Production Summary - Extrusion MFG Types 

Production Summary for the Extrusion MFG Type 

Inches/Min Shows the number of inches that will be produced per minute. Automatically calculated from 
the information entered when you set up the configuration. 

[((Feet/Lb * 12) * Lbs/Hr)/60] 

Length (ft) Shows the total length of the part being produced. This information comes from the Parts / 
Operation Details screen. 
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Feet/Hr This field shows how many feet will be generated in one hour. It is automatically calculated by 
taking Feet/Lb times the Lbs/hr. 

Net Feet/Hr. This field shows the approximate GOOD feet/hr based on estimated scrap and/or the Efficiency 
Factor. This value is used to determine the total time this job will require. The calculation is as 
follows: 

Net Feet/Hr = (Feet/hr * (1-scrap)) * Eff Factor 

Lbs/K Items The number of pounds of material that it takes to complete 1,000 items and is calculated by the 
system. 

Calculation: 

((Part Length divided by Feet per Lb) / (1- Scrap%)) x 1000 

 

Production Summary for the Extrusion2 MFG Type 

Hours/K-parts This value displays the number of hours required to complete 1000 parts. It is based on the Lbs 
per hour and Lbs/K. 

It is calculated: Lbs per K / Lbs per Hour / (1-Scrap Rate percentage) 

Assume 20 pounds per hour 

Scrap = 10% 

Lbs/K =200 

(200/ 20) / (1-0.10) = 11.11 Hours per 1000 parts 

Net Hours/K-
parts 

This is the net hours per 1000 parts. This formula takes into consideration the efficiency factor. 

It is calculated: (Lbs per K / Lbs per Hour) / (1-Scrap Rate percentage) / (Efficiency Factor) 

Using the above example and an efficiency factor of 90%: 

(200/20) /(1-0.10) / (0.90) = 12.35 hours per 1000 parts 
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Lbs/K Items The number of pounds of material that it takes to complete 1,000 items. 

With no scrap or regrind the formula is: 

Part weight(s) converted to pounds * 1000 

With scrap and regrind % equal to or greater than the scrap % the formula is: 

((Part weight in lbs. x 1000) / (1- scrap%)) 

If the Regrind % is less than the Scrap % then the formula is: 

((Part weight in lbs.* 1000) / (1- scrap% ) * 1 - Regrind % 

Example: 

Part Weight = 40 grams 

Scrap = 10% 

Regrind = 5% 

40/453.6 = .08818 lbs. 

(((0.08818 * 1000) / (1-.1)) * (1-.05)) 

93.078 

 

Production Summary for the  Extrusion3 MFG Type 

Hours/K-parts This value displays the number of hours required to complete 1000 parts. It is based on the Lbs 
per hour and Lbs/K. 

It is calculated: Lbs per K / Lbs per Hour 

Assume 20 pounds per hour 

Lbs/K = 88.19 

88.19 / 20 = 4.41 Hours per 1000 parts. 
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Lbs/K Items The number of pounds of material that it takes to complete 1,000 items. 

With no scrap or regrind the formula is: 

Part weight(s) converted to pounds * 1000 

With scrap and regrind % equal to or greater than the scrap % the formula is: 

((Part weight in lbs. x 1000) / (1- scrap%)) 

If the Regrind % is less than the Scrap % then the formula is: 

((Part weight in lbs.* 1000) / (1- scrap% ) * 1 - Regrind % 

Example: 

Part Weight = 40 grams 

Scrap = 10% 

Regrind = 5% 

40/453.6 = .08818 lbs. 

(((0.08818 * 1000) / (1-.1)) * (1-.05)) 

93.078 

 

All other functions within the Extrusion BOM, such as adding items, attaching components and 
packaging, linking documents and auxiliary equipment, are identical to the Injection BOM, explained 
earlier in this chapter. 

Keep in mind the item information differences for the different extrusion manufacturing types. Extrusion 
is entered as a part length, Extrusion 2 and Extrusion 3 are entered as a part weight. 
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Generic Standards 

Generic Standards are used by EnterpriseIQ when an operation or process needs to be defined that does 
not fit the Injection, Extrusion or other manufacturing types. Like other standards, generics can consume 
finished goods, components, and packaging, and can include labor and overhead. 

Like all standards in EnterpriseIQ, a generic BOM can be the basis for a work order which can be 
scheduled on a work center. 

Like other standards, Generics contain the basic information about how a part is made. The key 
difference is in the general information area. Generics, for example, do not maintain a material 
specification on the header level, like an injection standard would. Instead, a generic standard consumes 
one or more components as part of the make up of the final part number the generic standard creates. 
Generic standards are very versatile. Use a Generic standard to “track” or “link” various operations and 
parts together to create a finished good. 

An Example of Using a Generic Standard 

Assume the final part number 123-456 is actually made up of two manufactured parts and requires those 
parts to be heat sealed together. To complete this assembly, the user would create the individual mold 
standards for the two components. Then, using a generic standard, “consume” the two parts during the 
heat sealing operation, creating the final part number in the process. 

In the end, part number 123-456 is made up of three standards - two for the manufactured parts, one for 
the final assembly. EnterpriseIQ supports the scheduling of all three jobs. 

Example: 

Injection BOM #1 creates Part A only 

Injection BOM# 2 creates Part B only 

Generic BOM #1 creates Part 123-456. This is the only part number the BOM creates, so it is entered as 
the main part number in the Item Detail screen. 

As described above, the Generic BOM is actually describing the process that makes part number 123-
456. This part number is actually a combination of parts A and B. Therefore, the Generic BOM must also 
consume parts A and B. 

Create this link by adding Components to Part 123-456. Click on the Add Components button (or right 
click and select Add Component), and select Part A from the pick list. Repeat this process for Part B. Note 
that you can add other components at this operational level, and you can add packaging. 

The final Generic BOM now indicates to EnterpriseIQ that for every part number 123-456 created, parts A 
and B are consumed. 

Note: The Assembly MFG Types (ASSY1, ASSY2,and ASSY3) are also very useful for assembly type 
operations. Please see the Assembly Manufacturing documentation for details.  
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Note: There is also an 'Assembly' MFG Type available that conforms to the Generic MFG Type except the 
cycle time defaults to hours instead of seconds. 
 

General BOM Information for Generic BOMs 

The following information is specific to the generic standard only. The sample below shows a completed 
generic configuration. This is the main entry screen for building a BOM for a generic standard. It contains 
all of the information such as the customer, manufacturing type, cycle time, and more. 
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The following field listing details the information that is required for building each Generic configuration. 
The information in the field listing has been broken down into separate sections (corresponding with 
your screen) for easy reference. Use the field listing to familiarize yourself with each data field prior to 
making any entries. 

Field Listings 

BOM/Standards Info 

Mfg # Up to 50 characters can be entered in this field. The number entered here is the number of 
the actual standard.  

Each configuration number and routing number combination must be unique. If the user 
enters a Mfg #/Routing # combination that already exists, a prompt will be issued informing 
that a duplicate number was entered. The user will need to reenter a new Mfg or routing 
number. 

Note: To view the STANDARD ID for the BOM select the Alt F1 keys and a pop up will 
display the ID (for example, Table = IQMS.STANDARD, ID = 46825). 

Routing Seq # This field can be used for informational purposes to define the routing step sequence of the 
BOM when there are several steps. This field displays in the BOM pick list. 

Description Description of the Generic BOM. Typically describes the part and process. Enter a description 
for this standard that describes the type of operation required (i.e. hot stamp, heat treat, 
engrave, assemble parts, etc.) 

Customer Type in the first couple of letters of the customer’s name and the system will hyperbrowse to 
that customer. Another method is to select the customer from the pick list. This is not a 
required field, but is often used to associate a job with a particular customer. 

If you are a proprietary producer, you may leave this blank or list your company as the owner. 

Inactive A BOM can be marked inactive. This will ‘hide’ the BOM from pick lists. To view an inactive 
BOM the pick lists have a new button in the upper right corner to ‘view inactive’ items. 

1st Article Ins 
Date 

Enter the First Article Inspection date using the drop down calendar (Optional). This is the 
date that the configuration was first approved for use in a production run. This field is for 
information purposes only. 

This field description can also be changed by right clicking on the field and selecting the Define 
Label Text option. Enter in a user defined caption in the New Value field. The customized 
caption is based on Manufacturing Type. If the caption is changed for an Injection BOM, all of 
the Injection BOM’s will have that same caption but not other types of BOM’s such as Generic. 

EPlant Name This field is used to designate the configuration to a specific EPlant. It is not a required field if 
EPlant is not being used. 
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BOM Control # The BOM Control number will change automatically when someone makes a change to the 
configuration. This field cannot be edited. This field will not update immediately. In order to 
see the change, the user would have to exit the BOM module and come back in. 

The field consists of today’s date, time and EnterpriseIQ user ID of the person who made the 
change. 

Note: Changing the Lot Number will not update the BOM Control Number. 

From RFQ #: The information displayed here originates from the Quote module and will only be present if 
the standard was converted from a Quote. When a value is present the user can right click and 
jump to the quote. The quote the system will jump to is based on the quote ID associated to 
the standard. 

To change the quote the BOM is linked to, right click and select 'Edit RFQ Jump'. A pick list of 
quotes that exist for the same item number will appear to choose from. 

Schedule Info The user can enter up to 250 characters of information that will display when a work order is 
scheduled to a work center that uses this BOM. The information can be printed using the Print 
button from the BOM or from the schedule. 

 

BOM Manufacturing Details 

Mfg. Type This field shows the TYPE of manufacturing this standard will be used for. 

Cell Manufacturing Cells are associated to specific MFG Types and are used to designate separate 
areas in your facility. Manufacturing Cells allow a logical grouping of work centers. Group work 
centers by location, product line, process, etc… for separate scheduling and production 
reporting. 

Cells are discussed in the Setup Manual under Manufacturing Cells. Refer to that section for 
more information. 

Batch 
Production 

Batch production should be checked when the process is done in batches. For example, oven or 
sterilization processes. It is used in situations where it will take the same amount of time to do 
one item as it would take to do an entire batch of items. The maximum batch quantity is to be 
entered in the Std and Act Multiplier fields on the Item Details tab. 

Note: The 'Max WO Batch Size' setting is not the size of the batch for use with this 
Batch Production option. See below for details on that option. 

Note: When this option is checked the consumed materials in material exceptions will 
be required upfront and produced parts will be projected to be available on the last 
day of run. 
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Center Type Required Field. The entry here is based on the TYPE field in the Work Center module. The drop 
down list will be for work centers with the Generic manufacturing type only. 

This field links the job to a particular type of work center, though it does not necessarily link it 
to any one specific work center. Conceptually, EnterpriseIQ needs to know what kind of work 
center is used in the production of the items. It does not need to know specifically which work 
center. Assigning a specific work center is done during scheduling, where the user will have 
many options when placing the job in a particular work center queue. 

The machine scheduling portion of EnterpriseIQ will group production jobs together according 
to the type, though the user can override this behavior 

Labor This is the labor required at the work center to run the configuration. This field is used to 
compute the labor hours required to complete the work order. 

To enter the required labor click on the ellipsis button in the labor field and the following form 
will appear: 

 

From this screen click on the ADD (+) button, enter in the quantity of operators required (this 
does not have to be a whole number) then select the Employee Level Code from the drop down 
list. The Labor Rate will fill in with the rate associated with the code. 

The user can select multiple labor codes. 

EnterpriseIQ supports a range of 0.00 to 999 operators per job. A number less than 1 can be 
used for jobs running automatically and an operator is not always at the press. For these tools, a 
partial number such as 0.5 is entered depending upon the number of machines the operator is 
tending. 

The Employee Levels list is created in Sys Setup/System Parameters/Lists. An unlimited number 
of employee levels may be created for use in the BOM module. The system comes with a 
Default labor code. 

If the Default labor code is selected the system will use the labor rate associated with the 
specific BOM (BOM/Options/Misc Parameters/Labor tab). If that is blank it will use the labor 
associated with the Manufacturing Cell. If the cell does not have a labor rate associated with it 
the system will use the labor rate associated with the Manufacturing Type. 

NOTE: If the BOM is converted from a quote or cloned from another BOM, the labor 
will be assigned to the Default labor code. 

SetUp Hours 1 How long does it take (in hours) to setup the work center to perform this operation. 
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SetUp Hours 2 This field is used in the schedule when the same tool is running consecutively in a machine 
instead of Setup Hours 1. If the same tool is running back to back in a work center the Setup 
Hours 2 value will be used instead of Setup Hours 1. 

Cycle Time Required field. Enter in the length of time that it takes to complete a cycle. As mentioned, a 
cycle might make one, many, or a fractional amount of the final part. The unit of measure 
defaults to seconds. 

In a Generic BOM, a cycle is the amount of time it takes to complete a single operation, such as 
pad print, die cut or heat seal. For example, if it takes 30 seconds to pad print the item, then 
enter 30. You can adjust the number of parts printed per cycle by using the multiplier on the 
Item Detail page. 

Efficiency Factor You can adjust the total time required to produce the part with this field. Enter an efficiency 
factor that accounts for production problems that effect overall performance. 

This field is used to calculate the assumed production time. 

Scrap% Enter in how much percentage of scrap that you anticipate will occur when performing this 
operation. This value will only affect the amount of time it will take to run the item(s). It does 
not affect attached material on the Item Details tab. There is a separate scrap field for attached 
items. 

FG Lot # This selection allows the user to assign a Finished Goods lot number to the configuration. For 
additional information on this field, please see Finished Goods Lot number section for 
additional information. 

Max WO Batch 
Size 

Enter the maximum work order batch size if desired. This will break up the sales order releases 
into multiple buckets if necessary on the work order(s). For example: The sales order release is 
2000 pieces, and the Max WO Batch is 500. Assuming zero on hand the system will create four 
work orders for 500 pieces each.  

Note: This setting is not the size of the batch for use with the Batch Production option. 

Note:  Similar to the Inventory setting MFG Min Quantity, entering a value in this field 
will create a separate work order for each release quantity. 

  

Production Summary 

Cycle/Hr The system takes the number of seconds in an hour and divides it by the cycle time to 
calculate the number of cycles/hr. Shows how many parts will be assembled in an hour. 

Calculation: 
3600 / Cycle Time = Cycles/Hr. 

Hours/K Cycles This value displays the number of hours that it takes to complete 1000 operational cycles. 
Each cycle may produce one or many actual parts, depending on the operation itself. The 
calculation is based on Gross cycles per hour, not Net cycles. 

Calculation: 

Assume Cycles/Hr is 60 
Hours/K Cycles = 1000 / 60 = 16.67 Hours 
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Net Cycles/Hr The total number of assumed or net cycles that will be generated in an hour. This field is 
calculated by taking the number of seconds in an hour and dividing it by the cycle time, and 
then factoring in the scrap rate and the efficiency factor. This is the value used by the Work 
Order system to generate the total length of time required to manufacture the part(s). 

Calculation: 

Net Cycles/Hr  = (3600 / (cycle Time))(1-Scrap Rate percentage)(Efficiency Factor) 

All other functions within the Generic BOM, such as adding items, attaching components and packaging, 
linking documents and auxiliary equipment, are identical to the Injection BOM, explained earlier in this 
chapter. The one difference is the Apply Mfg# drop down box. 

Note: When a user creates a User Defined Form field and grants security to that UDF field, if the UDF field 
is deleted the security to the field is removed. If the UDF field is re-added with the same name, security 
will need to be reestablished for users. 
 

Apply Mfg # 

The Apply Mfg # field on the Item Details tab allows for simultaneous or parallel scheduling of an 
injection job and a generic job. This is used if you are doing an assembly at the press but want to track 
the FG items separately. By applying the injection BOM that correlates with the generic you will create a 
line item for both on the RealTime™ production report with the corresponding lot number information 
(if applicable) for each based on the individual BOM’s. The work order for the generic job will only be 
automatically added to the production report if RealTime™ is being used. For this to function properly 
the cycle time, set up hours, efficiency factor, and scrap % for the generic BOM should be identical to the 
injection BOM. 

Note: It is recommended that material requirements (PK, IN, etc.) are attached to the Injection work 
order to make sure material planning, usage, and staging reports are accurate. 

Note: Material should not be attached to the Generic BOM when using the 'Apply Mfg #' option because 
the work order for the Generic BOM is not actually scheduled. If there is a material requirement 
associated to the Generic work order, because it is not scheduled the material exception and usage 
reports would be based on the must start date (as you do not ever get an actual start date). Also, 
because the generic is not scheduled on a machine, the material requirements would not show up on 
the staging reports as the staging reports are only looking at scheduled work orders. 

Note: If both the work order for the Generic BOM  and the manufactured injection item is scheduled, 
the user will not see material requirements for any attached components. The system will ignore 
attached components due to both work orders being scheduled, when only one should be. 

Note: Even though this requires RealTime™ for this option to create a production report line for the 
Generic work order, it will not be visible in RealTime™. 
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Kitting 

A user defined MFG Type can be created to handle configurations where multiple items are shipped as a 
kit. The kit item is created as a phantom item. When the kit item is added to a sales order the system will 
create requirements for the components, and typically just the components are picked for shipping. The 
kit item will be listed on the packing slip with the components that make up the kit listed in an indented 
format. The invoice will list the kit item and the components, but by default only the Kit item displays a 
unit price (it displays zero for the components). 

Note:  If the ‘Include Kitting Components on SO' and the 'Price Based on Components/Modify 
Components' options are checked for the Kit item (inventory->Manufacturing tab), when a KIT is added 
to a Sales Order, the unit price of the phantom item will be null and the unit prices of the components 
will populate instead. 

Creating the Kitting BOM 

Create Kitting MFG Type 

The first step is to create a user defined MFG Type using the Generic type as the 'Default To' type. From 
MFG Types select the insert record button and from the User Defined tab enter the Mfg Type name and 
select Generic as the default. The phantom kit item should not have labor and overhead costs associated 
to it for standard costing purposes (see the standard cost note at the bottom of this section), therefore 
the Labor rate should be zero. 

Note: Creating a new MFG Type specifically for Kitting is optional, the Generic MFG Type can be used. 

  

 (Please see Modifying  Manufacturing Types for a complete discussion on creating MFG Types). 

Create Kitting Work Center(s) 

At least one work center must be created for the Kitting MFG Type. For standard costing purposes the 
overhead should be zero. 
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Create the Kitting BOM 

Next, create the BOM using the new MFG Type just created. If adding labor, be sure that the cost is zero 
for standard costing purposes. (Refer to the section on Generic Standards for more information). 

On the Item Details tab add the kit item. The inventory item that is the complete kit must be marked as a 
Phantom item. To do this, right click on the item in the tree and select Jump to Inventory. 
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From the Manufacturing tab in master inventory select the 'Phantom Item' check box. With this box 
checked the system will only remove the attached components when shipping the kit to the customer. 

Also check the 'Include Kitting Components on SO' box if you want to ensure the components of the kit 
will automatically be added to the sales order. When this is checked, if the Must Ship Date is changed on 
the Parent Item, the change will carry through to the components like it does when changing the 
Promise date. 

Additional Option:  

Price Based on Components/Modify Components - This check box is only visible if the ‘Include Kitting 
Components on SO’ is checked. If this is checked, when a KIT is added to a Sales Order, the unit price of 
the phantom item will be null. The unit prices of the components will populate instead. The component 
pricing will follow normal pricing rules (e.g. pricing hierarchy, discounts/markups, etc). When the kit is 
added to a sales order or AR invoice, users are not allowed to delete kit components from the kit, and 
are prevented from modifying the kit components' quantity. When a packing slip is invoiced in the AR 
module, the components listed on the packing slip will appear on the Invoice. The price of the phantom 
will remain suppressed and the prices of the components will remain populated. 

Note: A phantom Kit item is a top-level item, and when selected to ship (instead of the components), this 
will drive the phantom Kit item negative regardless of ‘Drive Phantom Negative’ check box selection. 
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Next, add the components to the BOM that make up the kit using the Add Component speed button and 
selecting the kit items from the pick list. Enter the components per part and any other required details. 
(See Attaching Components for more information). 

Note: Kits cannot be added as components to existing BOMs that make a Kit ('Sub-Kits' are not allowed). 
If users attempt to add a kit item on the item Details tab of a Kitting BOM a message will appear stating, 
'A Kit cannot be a component on a BOM that makes a Kit – operation cancelled.' This message will also 
appear when selecting the check box to ‘Include Kitting Components on SO’, if the item is currently a 
component on a BOM that makes a Kit, or is a manufactured item that includes a component that is a 
Kit. 

When the BOM is for a Kit item, there is an additional option for the components of the kit on the 
Attached Material Details tab in the General section called Exclude from KIT MTO. When this option is 
checked the system will exclude the component from inheriting the Make To Order (MTO) status of the 
phantom Kit item on the sales order.  This will ensure that users will not be forced to select only a MTO 
location for the components when creating a pick ticket. Note: This option can be checked for any 
component of a phantom (purchased or manufactured), however it only applies if the main phantom 
item has the check box in Inventory to ‘Include Kit Components on SO’ checked. For non-Kit phantom 
items, since components are not included on a sales order they do not automatically inherit the MTO 
status. 

Note:  With the 'Exclude from KIT MTO' option selected on a manufactured component of a phantom 
item that also has the option ‘Cascade Parent MTO Designation‘ selected in Inventory (Manufacturing 
tab), the ‘Exclude from Kit MTO’ option in the BOM module overrides this and the component will NOT 
be marked MTO on the sales order.  

Sales Orders 
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When a sales order (or other demand) is created for the kit item with the 'Include Kitting Components on 
SO' inventory setting checked, the kit item will display in bold and all components will also appear on the 
sales order (indented). By default the sales order price is based on the kit item and not the components. 
Pricing can come from AKA or the Selling Price tab just as with other inventory items. If the 'Price Based 
on Components/Modify Components' option is checked the unit price of the phantom item will be 
suppressed and the unit prices of the components will populate instead.  
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The system will create work orders for any components that are manufactured and material 
requirements for purchased components (if required). The required components will be listed In the 
Projected Material Exception list, however since there is no work order generated the system treats the 
demand as a DRP demand. Therefore the sales order information can be viewed via the 'DRP Demand' 
right click option in the middle grid.  

When a Sales Order phantom Kit item is marked ‘On Hold’ or 'Ship Hold' the system also updates the 
status of the components accordingly.  When marked 'On Hold' no work orders will be created for 
manufactured kit components, and no material exceptions are generated for purchased items. 

Modifications are not allowed on phantom components except line item notes can be added to the 
components for informational purposes, such as packaging instructions. Also, Kit components cannot be 
removed from a sales order. If the user attempts to make a change to a kit component a message will 
appear stating, "Direct modification of phantom component is not allowed - operation aborted."  

If the Kit item changes status to non-phantom, when the Phantom check box in inventory is un-checked, 
modifications such as removing a kit component will be allowed. 

Shipping the Kit 

Pick Tickets 

When the Kit item is added to the pick ticket the Kit item is listed as a phantom item and the 
components from the kitting BOM will be listed in indented format on the pick ticket. Both the Kit item 
and/or the components can be picked.  Any quantity can be picked/shipped (whole or decimal) for Kit 
or component items and the sales order will update accordingly.  

Note: If users plan to not have the components on hand but have the top level phantom kit with on hand 
(this rarely should be the case), and expect the components to follow to the pick ticket this should be 
done in SO Based Mode. Inventory Based mode will only pull the top level item with the on hand to the 
pick ticket. 

Note: If a quantity to relieve has been selected for the phantom kit item a warning will appear when the 
user clicks on the Convert to Pack Slip button stating, ‘Items marked Phantom have been assigned do 
you wish to continue?’. If the user selects Yes the pick ticket will be converted to a packing slip.  If No, 
the user is brought back to the pick ticket. This warning is due to the fact that a Phantom Kit should 
never be relieved from Inventory. It can have a quantity so that it can be invoiced, but for Phantom Kits 
to properly post to the GL through the entire process, only the components should be picked/relieved 
from Inventory locations. If a pick ticket is created selecting the Kit and the components in the detail 
section but only relieving the Components from a location (components are pulled and shipped, the Kit is 
selected but not relieved from a location) then when converting to a Packing Slip, posting PIT shipments 
and AR Invoicing the GL accounts are hit properly and everything stays in balance. 
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Partial Shipments of Kits 

Users are able to process partial shipments of kits both via pick tickets and packing slips. If a pick ticket is 
generated for a partial shipment, users will need to modify the Ship Quantity field of the phantom item 
to reflect the proper quantity of kits to be shipped. Unless users are intending to relieve inventory for 
the phantom item (which is rarely the case), the “Relieve Inventory Locations” section of the pick ticket 
should not be populated for the phantom item. Similarly, if a packing slip is generated for a partial 
shipment, users will need to modify the Quantity field of the phantom item to reflect the proper quantity 
of kits to be shipped. Again, a location should not be selected and relieved. 

Notes on using RF/WMS for shipping Kits: 

If an IQRF user has pick ticket profile for ‘Allow Undershipping’ = N when picking a Kit item (instead of 
components), or partial component quantities, the user must edit the pick ticket to match what they are 
picking before converting it to a packing slip (for Status to = ‘Pick Complete’). To avoid this requirement 
their user profile can be changed to allow undershipping in IQRF (this will affect all shipments). 

Splitting Pick Tickets: 

▪ Users can select a Kit and/or component items when splitting pick tickets. You can multi-select and 
change quantities to any whole number (not a decimal) on the proposed pick ticket. If decimal is 
entered the user will get an error, 'The Ship Qty of a phantom kit item must be a whole number, and 
should be greater than zero.' This message surfaces only for the phantom Kit item itself when 
splitting a pick ticket, not components. 

Converted Packing Slip 

When the pick ticket is converted to a packing slip the components are indented under the Kit item.  All 
of the components or Kits that were picked are relieved from inventory. The printed packing slip report 
will also display the components as indented items. 
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Creating Packing Slips without Pick Ticket 

A Kit can be shipped creating a packing slip without first creating a pick ticket, but the preferred method 
for shipping Kits is from a pick ticket. 

When creating a packing slip for the kit item and the components, select the double arrow button to add 
all of the required items to the packing slip items section. The user must manually enter a quantity for 
the phantom kit item as there is no assign quantity button available. A value must be entered in order to 
update the sales order for the phantom item, and in order for the AR invoice to have pricing (as the only 
item that brings over pricing to the AR Invoice is the kit). If the quantity is left at zero a confirm message 
will appear stating, "Order# 'XXXX' (Row: #), Qty is Zero. Do you wish to create a packing slip with Zero 
entry?". The user should select No and enter a quantity for the Kit item. A location and quantity must 
also be entered for each component being shipped within the Kit by selecting the green assign quantity 
button in the quantity field. 

If just the kit item (no components) are to be shipped just select the kit item and use the single arrow 
append button to add it to the packing slip items section. Select the location from the pop up and enter a 
quantity.  
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Note: If packing slips are created for only the components (Kit item excluded), using the Auto Invoicing 
function will result in burned invoice numbers. 

Note: Phantom KITs will not have a Translog entry when a packing slip is voided. Inventory will not be 
placed back in On Hand for inventory items that are marked 'Phantom' and 'Include Kitting components 
on SO'. Instead, there will be an entry in System->Event Log->PS that reads: "Voiding Packslip #xxxx - 
Quick void - skipping ARINVT ID xxxxx because it is marked Phantom and Include Kitting Components on 
SO". Components will still be returned to inventory with the correct serial association.  

AR Invoice 

When creating the invoice, only the Kit is selected from the Uninvoiced Shipments tab. 
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Only the Kit item displays on the invoice 
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Note: If packing slips are created for only the components (Kit item excluded), using the Auto Invoicing 
function will result in burned invoice numbers. 

Note: If the 'Price Based on Components/Modify Components' option is checked, when a packing slip is 
invoiced in the AR module, the components listed on the packing slip will appear on the Invoice. The 
price of the phantom will remain suppressed and the prices of the components will remain populated. 

RMAs for Kits 

The RMA module can be used to return shipments of a phantom Kit item and/or shipped components of 
a Kit. The shipments pick list displays the Kit item bolded with indented components. With the selection 
of a phantom Kit item for the return, the inventory of components shipped (where applicable) is not 
affected. 

Note:  If a Kit was selected for the RMA return and components of this Kit are also being sent back to 
inventory, jump to Transactions and Locations and remove the Kit item from inventory with backflush 
included. Optionally assign a Trans Code and/or type a Reason indicating the RMA #, which will populate 
in translog records for both the Kit and the components. If just a component of a Kit is being returned on 
the RMA and a credit memo is created, pricing for the component will be null (since there is no price for 
components of a Kit on the Sales Order), but can be manually entered. 

Kitting and VMI 

VMI functionality works with phantom kit items and components of a kit.  When performing a Consume 
VMI on a kit item, the system displays the finished phantom item (as grayed out per color chip) and the 
components shipped.  A quantity to consume can be entered for the kit and/or the components, and 
the system will pull the items shipped from their respective VMI locations.  When applying the quantity 
to consume for the kit, there will not be a VMI location displayed unless the phantom item was actually 
pulled from inventory during shipping.  When voiding the consumption for a kit item and/or 
components, the system will put the items shipped back to the VMI locations.  Return VMI will move 
the shipped kit and/or components back to non-VMI locations. 

Standard Cost Related Notes 

Since the Kit item is a phantom, there should not be labor or overhead costs associated to it (since this 
part is never produced). Also, the 'Post shipments awaiting invoicing/PIT' option must be checked in 
System Parameters -> Inventory Setup tab.  This is due to the unique circumstances related to Kitting, 
where the phantom items components are shipped but the phantom item is invoiced. In Post Inventory 
Transactions for the Shipment type, the system will pickup the components standard costs and GL 
accounts and the offset is accrued shipments. Then when the AR invoice is created, the system will pull 
back out of accrued shipments and post to 'shipped' accounts for raw material, etc.  This will be a wash 
if the kit does not have labor or overhead. 
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Masterbatch MFG Type 

The Masterbatch manufacturing type is used to create items with a unit of measure based on a weight 
such as grams or pounds. The item produced is made up of several components which also must have a 
weight type unit of measure. 

All of the fields are the same as described above ( in General BOM Information for Generic BOM) except 
as noted below: 

General BOM Info tab: 

Batch Time The time required to produce the batch, defaulting to seconds. 

 

Item Details tab: 

Std Batch Size The standard batch size produced during the batch time. 

Act Batch Size The actual batch size produced during the batch time. 



BOM-Manufacturing Configurations Page 181 of 273 

 

 

Assigning Batch Components 

There are three methods to assign the batch components: Assign Batch Components by Percentage, 
Assign Batch Components by Quantity, or Assign Batch Components by calculating unit quantity based 
on weighted average. 

 Assign Batch Components by Percentage - Components are added by entering a percentage using 
this speed button. A form appears to associate all of the required components to produce the batch. 
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From this form select the ADD (+) button and then click in the Item # field and select the ellipsis button. A 
pick list of inventory items with a primary material class will appear. Select the item from the list and 
enter the Batch Percent required of this material. Only items with a weight type unit of measure are 
allowed to be selected. The Qty Per field is based on the manufactured items unit of measure. It is 
calculated based on the Batch Percent. For example, the manufactured item has a UOM of LBS, the 
component item’s UOM is KG with a Batch Percent of 33%, the Qty Per will be 14.96847, (33 * 0.45359). 
Continue this process until all of the required components have been added. The Batch Percent must 
total 100%. 

 Assign Batch Components by Quantity - Select this button to enter the batch components by 
quantity and then calculate the percentages.  
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from this form select the ADD (+) button and then click in the Item # field and select the ellipsis button. 
Select the item from the pick list and enter the Qty Per Std Batch. Continue this process until all of the 
required components have been added. Select the Calculate button to have the system calculate the 
Batch Percent. The Batch Percent must total 100%. 

 Assign Batch Components by calculating unit quantity based on weighted average - Select this option 
to have the system calculate the unit quantity based on weighted average. The following form will 
appear: 
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From this form users can add materials to be used for the batch. Select the insert record button to add a 
row then select the ellipsis button in the Item # field to access the inventory pick list. Enter the quantity 
in the Parts field.  

Select the Calculate button to have the system perform the weighted average calculation. Following are 
the calculations with examples based on the first line in the above screen shot. 

▪ Unit Qty = (Qty/SUM Qty)  45/60 = .75 

▪ Percent = (Unit Qty*100)   0.75 * 100 = 75 

▪ SPG Total = For each item Parts/SPG = D, then SPG Total field = SUM(Parts/D):  D = (5/1.11) + 
(10/0.9) + (45/1.05) = 58.4728; SPG Total = 60/58.4728 = 1.0261 

▪ Cost Total = (SUM(Unit Qty*Cost))  (0.75 * 1.695222) + (0.083333 * 0.67) + (0.166667 * 1.05) = 
1.5022 

If changes are made recalculate by clicking the Calculate button.  

Any changes made to the worksheet are reverted if Cancel is clicked. 

Clicking Save & Exit on worksheet, saves the changes and updates the BOM. 

Right click on an item and select 'Jump to Inventory' to open the inventory module for the item. 
 

Outsourcing 

Occasionally the need arises to utilize operations of an outside vendor. EnterpriseIQ efficiently handles 
outsourcing two ways: via the purchasing and receiving of inventory items or via purchasing and 
receiving a miscellaneous item and production report. For either way you decide to handle outsource 
operations, you must first setup certain functions. 

Follow each of the steps below accordingly. 
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Outsource - Step 1: Creating an  Outsource Vendor 

The first step is to create your outsource vendor in Vendor Maintenance. Go to AP/Vendor Maintenance 
and select New from the pick list. Enter your vendor information as you would with any other vendor 
who is not an outsource vendor. The screen shot below shows our new outsource painting, Great Paint, 
Inc.: 
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Outsource - Step 2: Creating an  Outsource Work Center 

Once you have the outsource vendor created, an outsource work center must be created. While the 
work center does not exist at your facility, adding a center to your listing will allow for BOM usage, as 
well as work orders and scheduling. You should create an outsource work center for each outsource 
vendor and/or each out source vendor process. For example, Great Paint and T& W Paint can be two 
separate work centers, but also Great Paint could do two outsource processes such as painting and hot 
stamping. In the latter example, you would want two distinct work centers set up for Great Paint. 

The first step in adding an outsource work center is to verify that your system setup supports the 
OUTSOURCE Manufacturing Type. The easiest place to check this is from the work center module itself. 
From the Manufacturing Tab, select the Work Center tab, and choose any existing work center to view. 
From this open work center screen, choose Options/Mfg Types. Within this dialog box, verify that the 
OUTSOURCE type is listed. If it exists, you can proceed to add an outsource work center. If it does not 
exist, you need to add it using the following steps: 

▪ Click ADD (+) button to add a new record. 

▪ Click in the MFG TYPE field and from the drop down arrow, select OUTSOURCE or type in the word 
OUTSOURCE (spelled precisely and in upper case letters). 

▪ Enter OUTSOURCED in the Description column (this will be used for all your outsource work centers, 
so do not call it by your vendor's name). 

▪ Enter an optional Default Labor Rate. This rate will be used when linking a Type with a BOM, and can 
be used if you require labor allocation and you are using the production reporting option. 

NOTE: If your facility is set up to use Manufacturing Work Cells, you must also add a new Cell and link it 
to this Manufacturing Type.   This can also be done from the Work Center screen, Options/Mfg Cells. 

With the OUTSOURCE type created, you can now add a new work center. From the open Work Center 
screen choose the Add (+) button to insert a new Work Center or click “New” from the Work Center pick 
list. 

▪ Choose a Manufacturing Type of OUTSOURCE and Manufacturing Cell (if using cells). 

▪ Enter a Work Center number and a description (typically this is the process that your outsource 
vendor will be performing). 

▪ Because the Manufacturing Type chosen is OUTSOURCE, you will see that the “Center Type” field has 
changed to read “Vendor”. This allows you to link in the actual outsource vendor with the work 
center using the eyeglass search to the right of the field. 

▪ The RealTime Information box is only applicable to an outsource work center if you have a license for 
this work center and even then the work center should only be noted as “RT Server is not Signaled”. 

Your completed Outsource Work Center screen should look similar to this: 
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Outsource - Step 3: Creating a Bill of Manufacture for Outsourcing 

With the Work Center created, we can now create an operation through the BOM system that requires 
the use of this center. 

Begin by creating a new BOM and selecting the OUTSOURCE type. The outsource BOM behaves very 
much like the GENERIC BOM type, as there is no main material. The screen however, does reflect some 
important differences as seen and described below: 
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Like any other BOM, you will enter a MFG#, select a default customer (this is optional), and notice that 
instead of Center Type, the field says Vendor. From the drop down menu in that field, choose the vendor 
that you linked into your Outsource Work Center. 

As with other BOMs you have created in the system, once the work center, or in this case the outsource 
vendor, has been selected, any work order that uses this BOM will be available for scheduling on all work 
centers linked to the same vendor. 

The rate of production for an outsource operation is handled in two different ways. You can either set 
the production rate as a flat daily capacity (Days) or as a capacity per 1000 pieces (Days/K). In the 
example above, it takes three days to make every 1000 parts. To use the flat Days feature, you must 
check the “Flat Ratio” box. Posting your edit (using the “+” on the navigator bar) after checking that box 
will change the wording from “Days/K” to “Days”. Whichever way you select to record production rate, 
this field is always used to generate the approximate time the operation will consume. 

Use the field listing to familiarize yourself with the data fields prior to making any entries. 

BOM/Standards Info 

Mfg # Up to 50 characters can be entered in this field. The number entered here is the number of 
the actual standard.  

Each configuration number and routing number combination must be unique. If the user 
enters a Mfg #/Routing # combination that already exists, a prompt will be issued informing 
that a duplicate number was entered. The user will need to reenter a new Mfg or routing 
number. 

Note: To view the STANDARD ID for the BOM select the Alt F1 keys and a pop up will display 
the ID (for example, Table = IQMS.STANDARD, ID = 46825). 

Routing Seq # This field can be used for informational purposes to define the routing step sequence of the 
BOM when there are several steps. This field displays in the BOM pick list. 

Customer This field shows the customer the bill belongs to. 

From RFQ# Request for Quote Number. The information displayed here originates from the Quote 
Module and will only be present if the standard was converted from a Quote. 

This field cannot be edited. 

BOM Control # The BOM Control number will change automatically when someone makes a change to the 
configuration. This field cannot be edited. This field will not update immediately. In order to 
see the change, the user would have to exit the BOM module and come back in. 

The field consists of today’s date, time, and EnterpriseIQ user ID of the person who made 
the change. 

EPlant Name This field is used to designate the configuration to a specific EPlant. It is not a required field 
if EPlant is not being used. 

Inactive A BOM can be marked inactive. This will ‘hide’ the BOM from pick lists. To view an inactive 
BOM the pick lists have a new button in the upper right corner to ‘view inactive’ items. 
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Schedule Info The user can enter up to 250 characters of information that will display when a work order is 
scheduled to a work center that uses this BOM. The information can be printed using the 
Print button from the BOM or from the schedule. 

1st Article Ins Date Enter in the 1st Article Ins Date using the drop down calendar (Optional). This is the date that 
the configuration was first approved for use in a production run. This field is for information 
purposes only. 

This field description can also be changed by right clicking on the field and selecting the 
Define Label Text option. Enter in a user defined caption in the New Value field. The 
customized caption is based on Manufacturing Type. If the caption is changed for an 
Outsource BOM, all of the Outsource BOM’s will have that same caption but not other types 
of BOM’s such as Generic. 

 

BOM Manufacturing Details 

Mfg Type Shows the ‘Type’ of manufacturing of this standard. 

Cell Optional. Cells allow the system to distinguish between types of machines and processes. 
For example, you may have extruders and injection 

Vendor Use the arrow drop down list to select the appropriate vendor for this particular BOM. The 
vendor list is compiled from the ‘Type’ field found within the Work Center. 

Days/K The rate of production for an outsource operation is handled with the Days per 1000 parts 
field entry unless the Flat Ratio is checked. This field is used to generate the approximate 
time the operation will consume. 

Scrap% This is the estimated amount of scrap that the process itself will generate. This is used in 
calculating the extra production time required to complete the run. For Outsource Central 
users, it is also used to determine the quantity of items for the Ship Orders. 

Flat Ratio Check this box if the rate of production is based on the number of days and not days per 
1000 parts. Once checked, enter the number of production days in the preceding Days field 
to complete this operation. 

Note: When Flat Rate Ratio is checked, update schedule will look only at the number of days 
to determine the WO Start and End date. When flat ratio is un-checked, scheduling will look 
at the shop calendar set up and use the shift and hours/days information to determine the 
WO Start and End dates.  

Note regarding MRP: When flat ratio is selected, the system puts all the product in the first 
day of production. The daily material projections will show the entire amount being 
'produced' on the first day of the work order. In purchasing, the program sees that the 
production date is the first day and schedules the consumed components to come in just in 
time to be used on that day. 

FG Lot # Optional. Link a Finished Goods Lot number to the BOM. 
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Drop Ship This option is used in conjunction with the Outsource Central module. If checked it indicates 
the outsource vendor will drop ship the items to another vendor or the customer. 
Documentation is handled using ASN’s through EDI. 
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Create the Part Number 

Once you have set up the Manufacturing Number and the vendor, you will need to enter part number 
information. Within the BOM, go to the Item Details tab, and click ADD (+) button from the middle 
navigator bar. You will now add the part number and description as it will be returned by your vendor. 
When the part comes back from the outsource stage is it a different class or different number scheme? 
How you receive it back into your facility is the part number you want to add here. 

Note: If the ‘System-Generated Inventory#’ option is enabled in System Parameters->Sequential 
Numbering tab, the system will populate the item number with the next sequential number. If the user 
clicks on the 'Pick Item' button and clicks 'New' on the pick list, the item # will be the same as what was 
generated. For example, if the next sequential item was '123', when selecting 'New' on the pick list it will 
still be '123'.  The value can be overwritten if desired. 

You will also want to add any packaging or components to this BOM. This includes parts you previously 
manufactured and must now send to your vendor for them to complete. In our example below, we will 
be sending to the outsource vendor our manufactured part number NOK120. The vendor will use a one-
to-one ratio and return to us the part number NOK120P. 
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Notice in the above example that we are also supplying our outsource vendor with ink with which he will 
paint our parts. This is optional, but if there are any items you send to your outsource vendor, it is 
imperative to add them to your BOM. This allows for proper tracking and purchasing. 

Note For Outsource Central users only - There is an additional option available for items attached to an 
Outsource BOM. On the Details tab the user can select the Exclude from Ship Orders option to prevent an 
attached component from being added to the Ship Order. When checked, the item will still be in the 
material exception list. If it is not checked any attached items will also be added to the ship order to be 
shipped to the vendor. If the 'Drop ship' check box is checked on the BOM any attached components 
should have the 'Exclude from Ship Orders' checked in the attached materials detail section, otherwise 
the system assumes all items are to be drop shipped (the MFG item and the attached component) which 
causes the packing slip to be made for the wrong item. (Please see the Outsource Central help file for 
more information). 

Quantity Breaks 

You can assign quantity price breaks to an Outsource operation. Please note that this price list is for 
the cost of the vendor operation, based on quantity. It is NOT the selling price of the new item but rather 
what your vendor charges you for this operation. 

To add vendor price breaks, click the Qty Breaks icon in the middle section of the Item Detail screen. 
Enter as many or few price breaks as appropriate. Optionally you can enter the date the price was 
entered/changed, the date the price becomes effective, and the expiration date of the price. 

NOTES:  

The system does not calculate the additional outsource cost for the vendor operation. The user must 
manually add the outsource cost element to the final item's standard cost tab if you want to use this cost 
to determine the Standard Cost. To add this manually, go to the Inventory-> Standard Cost tab of the 
item that gets returned from the vendor. Choose ADD (+) button from the navigator bar on the left, 
choose your cost element, and enter a price of that element. The manually added cost will be rolled up 
in higher BOMs. 

If an outsource item is attached as a component to an Assembly Process, and the item changes, users 
should always clone the BOM and not just change it to a new item. This will prevent out of balance 
costing issues. 
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Outsource - Step 4:  Scheduling the Outsource Operation 

EnterpriseIQ will automatically generate a work order for an OUTSOURCE operation just like it will for an 
INJECTION, EXTRUSION, etc. type operation. Of course, this assumes there is an order for the item in the 
Sales Order system, and no current inventory exists on hand. 

To schedule work orders based on outsourcing, open the Scheduling module and select the OUTSOURCE 
type from the view pick list. Note that only those work centers linked to the OUTSOURCE Mfg Type are 
displayed. 

Schedule these outsource work orders as you would any other work orders created by the system. While 
scheduling your outsource work orders are optional, it is helpful in determining which items your 
outsource vendor is working on. Not scheduling them will still allow you to use the outsource process 
however. 

Note the Must Start Date on the work order. This date is calculated to be the date that you should send 
any consumed parts to your vendor. If your Outsource vendor has a transit time longer then the same 
day, you might want to use the Move Time field located in Inventory > Mfg Tab > Move Time. The transit 
time should be added to the manufactured item that you ship to your vendor (in our example, part 
number NOK120). This Move Time field is a days value, so if the transit time to your vendor is two days, 
enter 2 in that field. EnterpriseIQ will use this field to back up the Must Start Date so you have a more 
accurate reflection of when the Vendor should be sent parts. 
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Outsource - Steps 5 and Beyond in Outsource BOMs 

Two Options for Receipt/Reporting of Items Completed by Your Outsource Vendor 

As mentioned earlier in this section, EnterpriseIQ allows for two ways to handle Outsource Items: either 
by receiving from a purchase order or via production reporting. The first four steps are the same 
regardless of which way you choose to handle outsource items. It is from this point forward where you 
choose which method works best for your facility. 

Option A will explain how to use the Purchase Order and Purchase Order Receiving modules to enter 
items returned from your outsource vendor, as well as backflushing any components you sent to him. 

With Option A the steps are: 
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Option B will explain how to use the Purchase Order and Production Reporting modules to enter items 
returned by your outsource vendor, as well as backflushing any components you sent to him. 

With Option B the steps are: 
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Outsource - Option A - Create Inventory PO for Outsource 

Step 5: Create an Inventory Purchase Order 

Enter a Purchase Order for your Master Inventory item as you receive it back from your vendor. Using 
the part number from our earlier BOM example, we would enter a PO for part number NOK120P. You 
want to enter pricing (that your vendor charges you so as to match the AP invoice that your vendor 
sends you later), total quantity the vendor will return to you, and the date(s) you requested parts be 
returned to your facility. For added reference you can enter a work order number in the comment field, 
but this is optional and will not affect the process. 

NOTE: When Creating a PO to the vendor for the outsourced item, the work order will not disappear like 
it would on all the other items. The system recognizes that it is an Outsource item and it does not 
eliminate the work order. 

Outsource - Option A, Step 6: Manually Ship and Adjust Your Inventory Locations 

Creating A Manual Packing Slip 

Because you have to send parts to your outsource vendor and do not have a sales order from him to ship 
them on a system generated packing slip, it is recommended that you ship any components to your 
outsource vendor on a manual packing slip. This gives you a record that the parts were shipped but does 
not affect your inventory's on hand quantity. Since you still own the manufactured parts and 
components you are sending, you do not want to deduct them from inventory at this point. 

Remember, your manual packing slip should be created for the components that you are sending to your 
outsource vendor, not the part he is returning to you. Thus, the manual packing slip on the next page 
reflects the manufactured item and ink we need to send to Great Paint. 

Notice, the amounts sent to Great Paint also reflect the scrap that is anticipated based on the setup of 
the BOM. This is optional. The correct amounts consumed will be deducted at a later time. However, the 
exact amounts you send to your vendor should be noted here. 
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Manually Adjusting Inventory Locations 

Once you have prepared the shipment to your outsource vendor, it is also recommended that you adjust 
your inventory locations to reflect that those items sent, while still considered on hand, are no longer at 
your facility. Users should set up a location called Outsource Vendor. You can have one location per each 
outsource vendor, or one location for all outsource vendors. 

In our example below, we have one location called outsource and all items sent to outsource vendors are 
designated with that location: 
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Don't forget to move all items sent to your vendor, not just the manufactured part. 

Outsource - Option A, Step 7: Receiving Items in From Your Outsource Vendor 

After your vendor has completed the parts and sends them back to you, you need to receive them into 
your inventory. Because you have already created a Purchase Order from Inventory, you want to receive 
those items from your vendor off that purchase order. Since you will not (with this option) be completing 
a production report, it is upon receiving that you will also want to backflush. 

▪ Open the purchase order from which you sent the items to your vendor, in the PO Receiving module. 

▪ Enter the quantity of the finished part your vendor is returning to you 

When posting this item into inventory, make sure the “Include Materials Backflush” box is checked on 
the “Add To Location(s)” screen, as in the example below: 
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With the Include Materials Backflush box checked, the receiver can choose the “Calculate” button and 
EnterpriseIQ will determine the accurate amount of material needed to backflush based on the Add To 
quantity. All calculations are based on the BOM. If your Outsource Vendor notes either on the receipt, by 
other means, that he did indeed create scrap, the quantities consumed can be adjusted here. 

The locations from which to backflush should be the outsource locations you already moved the 
consumable items to in the previous step. This creates less work on maintaining those locations later 

Hint: As a reminder to your receiving department that they must always backflush materials on this 
returned item from your outsource vendor, you can set this item in the master inventory to always bring 
up the Include Materials Backflush box. To do this, go to the outsource item in Inventory. Click on the 
Manufacturing Tab and check “Backflush Materials” box. 

Note: If the quantity of the components are adjusted then in Post Inventory Transactions-> Receiving the 
variance will go to the System Default MFG Variance GL Account. This is a receiving transaction and the 
system does not look at how much should have been received compared to actual on the consumed 
items and come up with a variance on the attached components like in dispositioning. It takes the 
difference in the costs and that is what it considers to be the ‘outsource’ cost. To get individual variances 
users can either use the production report (Option B – Create Misc PO for Outsource) for outsource 
items instead of PO receipts or adjust the components manually after receipt. 

Receiving Outsource Serialized Inventory Control Items 

If Outsource Central is used, for Serialized Inventory Control (SIC) items users can select specific serial 
numbers to relieve. The system will display a pick list of the serial numbers in the In-Transit location (the 
serials sent to the vendor). (Note: Only individual, not full pallet, labels may be selected). If the double 
arrows button is selected, for non-SIC items the system will populate the location(s) based on the IN 
TRANSIT locations based on the parent work order # that is associated to the outsource PO that is 
associated to the PO receipt. If the consumed item is SIC, a pick list of labels will appear to allow the user 
to select the labels (when using Outsource Central). 

If Outsource Central is not used when selecting the double arrow option the system will backflush based 
on FIFO. When using the single arrow option the screen will display all of the labels for the item, not just 
the ones sent to the vendor. (This is because the system does not have the required links to the sent 
serial numbers as it would when using Outsource Central). The Location is listed in the grid to enable 
users to choose the ones that were sent to the vendor.  
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Your Finished Item is now in inventory and available to ship to a customer against a sales order or is 
available to move to another operation that consumes this item. 

Outsource - Option A, Step 8: Removing the Work Order From Your Schedule 

The last step is to remove the Work Order from your schedule. Once update schedule is run, the 
requirements, if met, will have adjusted this work order to show the color code of all white (meaning 
that there are no longer requirements for this to be run). Items are now in inventory and you can adjust 
your schedule to more accurately reflect those items for which your outsource vendor is now 
responsible. 
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Outsource - Option B - Create Misc. PO for Outsource 

Step 5: Create a Miscellaneous Purchase Order 

Enter a Purchase Order for a Miscellaneous Item. We enter a miscellaneous item so that, when received 
back in from the vendor, we are not affecting inventory. Using the part number as our description, we 
would enter a PO for miscellaneous item NOK120P.   You will want to enter pricing (that your vendor 
charges you so as to match the AP invoice that your vendor sends you later), total quantity the vendor 
will return to you, and the date(s) you requested parts be returned to your facility. For added reference 
you can enter a work order number in the comment field, but this is optional and will not affect the 
process. 

Outsource - Option B, Step 6: Manually Ship and Adjust Your Inventory Locations 

Creating A Manual Packing Slip 

Because you have to send parts to your outsource vendor and do not have a sales order to ship them on 
a system generated packing slip, it is recommended that you ship any components to your outsource 
vendor on a manual packing slip. This gives you a record that the parts were shipped but does not affect 
your inventory's on hand quantity. Since you still own the manufactured parts and components you are 
sending, you do not want to deduct them from inventory at this point. 
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Remember, your manual packing slip should be created for the components that you are sending to your 
outsource vendor, not the part he is returning to you. Thus, the manual packing slip on the next page 
reflects the manufactured item and ink we need to send to Great Paint. 

Notice, the amounts sent to Great Paint also reflect the scrap that is anticipated based on the setup of 
the BOM. This is optional. The correct amounts consumed will be deducted at a later time. However, the 
exact amounts you send to your vendor should be noted here. 

Manually Adjusting Inventory Locations 

Once you have prepared the shipment to your outsource vendor, it is also recommended that you adjust 
your inventory locations to reflect that those items sent, while still considered on hand, are no longer at 
your facility. Users should set up a location called Outsource Vendor. You can have one location per each 
outsource vendor, or one location for all outsource vendors. 

In our example below, we have one location called OUTSOURCE and all items sent to outsource vendors 
are designated with that location: 
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Don't forget to move all items sent to your vendor, not just the manufactured part. 

Outsource - Option B, Step 7: Receiving Items in From Your Outsource Vendor 

After your vendor has completed the parts and sends them back to you, you need to receive them into 
your facility. Because you have already created a Purchase Order for a miscellaneous item, even when 
you receive them inventory will not be affected. 

▪ Open the purchase order from which you sent the items to your vendor, in the PO Receiving module. 

▪ Enter the quantity of the finished part your vendor is returning to you 

When posting this item into inventory, you will get a message that there is no location assigned because 
this is a miscellaneous item. That is correct. You just want a record that the vendor returned the parts 
from your original purchase order. 

Outsource - Option B, Step 8: Creating a Production Report for you Outsource Work 
Center 

Your items are now at your facility and since they were received in from a miscellaneous purchase order, 
you still need to backflush and report the finished item into inventory. You will do this via a production 
report. 

To create a new production report, you will complete the following steps: 

▪ Go to the MFG Tab > Production / Labor Reporting and click the button for Non-RT. 

▪ Enter the date of production (or the receiving date), shift, and cell (is using cells). 
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▪ From the blank production report screen, select ADD (+) button from the top navigator bar. 

▪ Choose to enter either by the Work Order browser (if you know the work order number created by 
the system to make these parts) or by the Mfg #. 

▪ Enter the appropriate Work Center (or outsource vendor) for where these parts were completed. 

▪ Choose OK (if this is the only item to add to your production report) or Apply (to add in a batch 
process). 

▪ Enter in the total hours, cycles, downtime, etc.… or simply enter in the total quantity received from 
your vendor in the lower portion of the screen that shows item number being reported. 

▪ Once all items have been noted on the production report, you can auto-disposition or disposition the 
selected item. Don't forget to enter scrap and recalculate the materials if manually dispositioning 
selected items. 

Your completed production report should look similar to the following: 
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Once dispositioned, your Finished Item is now in inventory and available to ship to a customer against a 
sales order or is available to move to another operation that consumes this item. 

Don't forget to either relieve components from the OUTSOURCE location or to do a manual location-to-
location adjustment to accurately reflect locations of your inventory items. 

Outsource - Option B, Step 9: Removing the Work Order From Your Schedule 

The last step is to remove the Work Order from your schedule. Once update schedule is run, the 
requirements, if met, will have adjusted this work order to show the color code of all white (meaning 
that there are no longer requirements for this to be run). Items are now in inventory and you can adjust 
your schedule to more accurately reflect those items for which your outsource vendor is now 
responsible. 
 

Slitting 

Slitting is a manufacturing process by which a single roll of material (plastic, paper, sheet metal, rubber, 
etc.) is placed on a rotating spindle and knives are used to cut lengthwise strips of the material as it 
unwinds from the roll. Characteristics of the roll often include an inner diameter (Core Size), outside 
diameter (OD), width, and length.  In addition, the material itself may have properties such as gauge 
(thickness), special coatings, and density (often stated as Specific Gravity or SPG). A mathematical 
formula exists between ID, OD, gauge, and length in order to calculate the fourth variable if only 3 are 
known.  Also, density and width can be incorporated into that formula to calculate the weight of a roll. 
The slitting process often produces trim which is basically an unused strip of material on either end of 
the roll.  Trim is typically handled as regrind. 

For example, the primary material may be an 8 feet in diameter and 8 feet wide, and the finished 
products may require this material in 6", 8" and 12" widths. Rather than require a separate BOM for 
each potential width, all possible items are added to a single Slitting BOM. The 'Agg. Demand Collector' 
(ADC) box is checked to indicate the system will analyze the demand and create substitute BOMs 
associated to firm work orders based on the requirements. 
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Slitting can be designated as inline slitting or offline slitting.  Offline slitting occurs when a master roll 
removed from inventory, loaded onto a slitting machine, and then cut into strips.  Inline slitting occurs 
when the material is directly cut into slits as a final step in the extrusion process. 

Slitting Notes: 

▪ Slitting will work with or without serialized inventory control.  Material can be represented as 
different inventory items (if not using SIC) or as a single item with dimensional characteristics (if 
using SIC).  The SIC item would be a material with the exact same characteristics (except for slit 
width) and the SIC dimension would represent width. 

▪ When using the ADC functionality update schedule creates an intermediate work order which must 
be further “massaged” to generate the slitting work orders. The intermediate work order represents 
aggregate demand for a particular item. The final slitting work orders are created via the Slitting 
Optimization module within Work Orders. 

The slitting BOM is based on the concept of an extrusion BOM.  The primary material is the master roll 
which is the item that typically will be used as the source for the slit material.  Manufacturers will often 
substitute a roll of smaller width if one is available and it leads to less scrap.  Within EIQ, any Alternate 
Items attached to the master roll are considered candidates for “substitution” within the slitting process. 

Primary Material for Slitting BOMs 

A new Inventory Class can be created for the Master Rolls if desired. If a new class is to be used for the 
master roll make sure the 'Primary Material' box is checked so the master roll can be designated on the 
BOM. 
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Create a Master Roll inventory item 

Once the basic information is entered such as item #, revision, description, and UOM, enter the physical 

characteristics by selecting the Physical Characteristic button . This includes the Volume, SPG, 
Length, Width, Gauge, Core Size, and Outside Diameter. 

Note: The  Master Roll must be in same unit of measure (UOM) as the Slitting MFG Type. If it is set up as 
Slitting by length then the Master Roll must be in a length UOM. If it is set up as Slitting by weight then 
the Master Roll must be in weight UOM. 
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The unit of measure defaults to inches but can be changed. From the Physical Characteristics File menu 
select Physical Characteristics UOMs.   
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A form will appear with a System Default column and columns for each EPlant. Select the drop down list 
to choose a different UOM. 

Create Slit Items 

The manufactured slit rolls are created in the same manner as shown above, or they can be added on 
the fly while creating the BOM on the Item Details tab. 

Note: In Inventory the Physical Characteristics are automatically cloned when cloning an item. If they are 
different than the item cloned from be sure to make those changes for the new item. 

Alternate items can be set up if desired.  For example, an item may represent a roll 120 inches wide. 
The slitter also stocks a roll of the same material and gauge that is 100 inches wide and can be 
substituted for the master roll if the total width of all slit rolls plus trim on the work order is to be 100 
inches or less. The 100 inch roll would then be designated as an alternate item for the 120 inch roll. 
(Refer to the Alternate Items section for more information). 

Slitting Manufacturing Type 

 



BOM-Manufacturing Configurations Page 212 of 273 

 

The setup for the Slitting Mfg Type is similar to other types. Refer to the Manufacturing Types section for 
details. There is one unique field related to Slitting: 

Default UOM - This field on the General tab is unique to the Slitting MFG Type or a user defined type 
based on Slitting. A UOM based on weight or length can be specified. This setting affects how the BOM, 
Work Orders, Production Report and RealTime™ displays UOMs. When a new BOM is created the system 
will look at the Mfg Type's Default UOM to determine if the BOM is weight or length based, and will use 
the UOM on the BOM when adding new BOMs.  The system will not allow the user to switch from 
weight to length if there are any BOMs for the Mfg Type. If attempted an error will appear stating, 
'Unable to change this Mfg Type. BOMs within this Mfg Type with the prior UOM that cannot be 
converted.' Note: If both types (weight and length) are used then they must be two different MFG Types 
(based on SLITTING).  

Slitting BOM 

The sample below shows a completed configuration. This is the main entry screen for building a BOM for 
a Slitting standard. It contains all of the standard information such as the customer, manufacturing type, 
line size, Feet/Lb, Lbs/Hr, materials, etc. 
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Select the item to be used as the Master Roll in the Material Spec. field. The Gauge, SPG, Core Size, and 
Outside Diameter will populate automatically from the item master. The primary material's UOM must 
be in same unit of measure (UOM) as the Slitting MFG Type (length or weight). If the selected primary 
material is not, a warning will display stating, "The primary material selected does not match slitting by 
weight or length" (whichever UOM that applies). When selecting the 'OK' button on the warning users 
should cancel the changes made so the BOM is not saved with a material in an incorrect UOM. If the 
BOM is saved with a primary material that is not the same UOM as the Slitting BOM, the Costed BOM 
will show an incorrect extended cost causing the standard cost of the manufactured item to be incorrect.  

Min and Max width should be set to actual width of master roll. The Trim width should also be 
populated. This information carries over to the Slitting Optimizer. 

If using RealTime™, a RT signal rate should be specified. This is the number of feet slit per cycle reported 
by RealTime™.  This will vary by machine based on where the signal is being captured. For  Slitting by 
Weight the RT Signal Rate will be in feet or meters depending on the Native UOM setting in System 
Parameters. For Slitting by Length BOMs the UOM for RT Signal Rate will match the BOM's UOM. 

Lbs/Hr is the rate of production for the machine. 

Check the 'Agg Demand Collector' button to utilize the Slitting Optimizer in the work order. If this is not 
checked intermediate work order are not created, just the final work order based on demand. 

Refer to the General BOM Information for Generic BOMs section for details on the standard BOM fields. 

Item Details 

For Mfg Type's with the Default UOM set to weight, the manufactured item will include Slit Roll Weight 
and Width. The weight unit of measure is based on the UOM on the General BOM tab.  For Mfg Type's 
with the Default UOM set to length based, the manufactured item will include Slit Roll Length and Width. 
The length unit of measure is based on the UOM on the General BOM tab. 

The UOM for the Slit Roll Width for both types will be based on the settings from Physical Characteristics 
UOMs. 

Select the insert record button then select Pick Item if the rolls have already been added to inventory, or 
enter the item information to add an item on the fly. Note: If creating new items from the BOM be sure 
to enter the Physical Characteristics in Inventory. 

Set the Slit Roll Weight and populate the Slit Roll Width. Continue to populate with all items that can be 
produced by the master roll. 
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Packaging and components can also be added to the BOM if required. 

Note: If the Slitting MFG Type is set up for a length unit of measure (i.e. FT), the field is labeled Slit Roll 
Length instead of Slit Roll Weight. 

Note: The Slit Roll Weight/Length should be equal to 1 of the UOM of the FG item.  Example: If the UOM 
for the BOM and the FG item is in Feet, then enter a Slit Roll Length of 1.  If it is in Rolls, then enter the 
full length or weight of a roll based on the UOM of the BOM.  So if a Roll weighs 1 KG, and the BOM is in 
Grams, then the slit Roll Weight would be 1000 Grams. 

Note: Patterns Std and Patterns Act are for costing purposes only. They will carry through onto the ADC 
work order as cavitation, but they will not automatically pull into the Slitting Optimizer. They need to be 
manually added as multiple Slits. 

Slitting Work Order 

Once there is demand in the system a work order will be created. If the ADC box was checked on the 
BOM the work order will have the Slitting Optimizer button at the top. 
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Slitting Optimization  

When the Slitting BOM has the 'Agg. Demand Collector' option checked this module will be available on 
the work order. Running update schedule creates an intermediate work order which must be optimized 
to generate the slitting work orders. This module allows users to define a pattern so the unused width is 
minimized. 

Select the Slitting Optimization button on the work order  to access the form. The Slitting 
Optimization module can also be accessed directly from the Manufacturing tab of the EIQ Launcher Bar. 
When accessed from the Launcher Bar a pick list of Slitting ADC Work Orders filtered for the logged in 
EPlant will appear. The pick list also includes a "Has WOs" column that will show ADC work orders that 
have had Slitting Work Orders already created for them.  This will help to show what orders still require 
slitting work orders to be created without running update schedule or going into individual records. 
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Optimization Parameters 
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From the Edit menu select Optimization Parameters to set a percentage for over and/or under 
production. Enter a specified percentage as a whole number that the slitting optimizer will use to color 
code the total manufactured quantity column in the Satisfied Order section. The setting compares 
Release Quantity to Total Manufactured Quantity in the Satisfied Orders section and color codes the 
Total Manufactured Quantity if the difference % is larger than specified in the Parameters screen. 

▪ Allowed Over Production % 

▪ Allowed Under Production % 

If the manufactured quantity is > release quantity * (1 + tolerance), or if manufactured quantity is < 
release quantity * (1 - tolerance) then the total manufactured quantity column will be red. 

▪ Round Sets Per Master Roll -  If checked, and the calculated value for Sets Per Master Roll in the 
Satisfied Orders grid is a decimal (1.5) the value will be rounded down. 

Work Order Section 

The Work Order section in top left populates the Master Roll information based on the BOM. This 
includes the dimensions of the master roll such as OD, Core Size, and Length. 

Right Click Options: 

▪ Jump to Inventory 

▪ Jump to ADC BOM 

▪ Jump to ADC Work Order 

Slitting Optimizer Sections 

▪ Patterns – To create roll patterns. 

▪ Satisfied Orders – To designate which releases to fulfill and any make-to-stock items to slit. 

▪ Stock Rolls – To select specific rolls to use (from stock master rolls and any alternate items). 

▪ Material Summary – The material summary information such as master rolls required and quantity to 
manufacture based on the patterns. 

Patterns 

From the Patterns section select the + button to add a record. This initially populates with the 
information from the BOM (roll width, trim width). 

 

# The pattern record number. 

Allocated Weight This is the weight of the allocated stock rolls. 
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Inline Check this box if the material will be directly cut into slits as a final step in the extrusion process. 
When this box is checked the Stock Rolls section will not display. The checkbox cannot be 
checked if a Stock Roll has already been selected. When work orders are generated and 
Extrusion work order is created from the BOM assigned to the Master Roll Item associated to 
the ADC work order. 

Master Rolls 
Required 

This is calculated as the number of Master Rolls required for the Pattern. 

Matched Item # The system will match a master roll if possible based on the roll width and it will populate in the 
Matched Item # field. If a number is added to the Roll OD field than the matched items displayed 
will be an exact match to both the Roll OD and the Roll Width. If a master roll cannot be 
matched this field will be red.  

Note: Roll Width and Roll Outside Diameter values come from the Physical Characteristics for 
the master roll in Inventory. 

Part Weight This is the sum of the Manufactured Quantity for the items listed in the Satisfied Orders section. 

Part Width The Part Width field will update as items are added to the Satisfied Orders section. If the Part 
Width + Trim Width is greater than the Roll width this field will be in yellow. 

Roll OD If a number is added to this field than the system will also evaluate the Roll OD in addition to 
Roll Width to find matched item #'s.  If this field is left blank, the system will just match based 
on Roll Width. 

Roll Width The Roll Width is the Minimum Width from the BOM. 

Sets Sets represents the number of times the pattern will be repeated. 

Slits Number of cuts. This populates based on the total slits from the Satisfied Orders section. 

Trim Width The user can override the Trim Width in the Patterns section of the Slitting Optimization form 
that is initially populated from the BOM. 

Unused Width Unused Width is a calculated field (Roll Width - Part Width - Trim Width) 
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Right Click Options: 

▪ Jump to Slitting Work Order - If a slitting work order has been generated the line item will turn green 
and users can jump tot he work order. 

▪ Jump to Master Roll Work Order - This will allow users to jump to the work order to manufacture the 
master roll if applicable. 

Satisfied Orders 

This is where the user defines what the pattern will look like and manually select which demand will be 
fulfilled. The goal is to define a pattern such that off-cut (i.e. unused width) is minimized. 

From the Satisfied Orders section select the + button to add a record. The Add Items form will appear: 

 

▪ Select from the 'On Order' tab to satisfy demand requirements from sales orders. If the 'Hide Fully 
Satisfied Orders' button on the On Order tab is pressed when adding an item in the Satisfied Orders 
section, only orders that have demand that has not already been completely added to a pattern are 
visible. Toggling the button will show all items with demand regardless of whether they have already 
been added to a pattern. 

▪ Select from the 'All Items' tab to create items to be stocked for future demand (Make-to-Stock). 

 

Item Information Item #, Description, Rev, UOM, and Class. 
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Item's Physical  
Characteristics 

Length and Width 

Manufactured 
Quantity 

Manufactured weight * Slits  

Order # 

Customer # 

Ship To 

Sales order #, Customer #, and Ship To associated to the item if applicable. 

PO # PO # associated to the item if applicable. 

Release Date The date of the sales order release. 

Release Quantity Release quantity from the sales order. 

Sets per Master 
Roll 

This is calculated as matched roll length divided by part length. 

Example:  If a matched roll has a length of 5000ft and items in a set have a length of 1250ft the 
sets per master roll is 4.  If the 'Round Sets Per Master Roll' parameter is checked (Edit menu), 
rounding down will occur (i.e. a value of 3.6 sets per master roll is interpreted as 3 sets per 
master roll). 

Slits Enter the number of slits for the item. Users can experiment with the Slits column until a 
quantity manufactured will meet demand (Manufactured Quantity field will turn yellow) 

Total 
Manufactured 
Quantity 

The total quantity added to the Optimizer for the item from all patterns. This is what is 
compared to the order quantity. If the total manufactured quantity is less than the demand this 
field will be red, if it is more it will be yellow. 

Weight This is a calculated field based on the value from the Physical Characteristics form in the 
inventory module (Edit Physical Characteristics speed button). 

(Length * Width * Gauge) in cm * SPG * .001 KG/CM3 = weight in KG, then converted to the 
appropriate weight unit 



BOM-Manufacturing Configurations Page 223 of 273 

 

Note: The system allows for a different Core Size and/or OD (and thus a different length) on the item 
produced than is called for on the BOM Master Roll Item.  This affects the Rolls Per Master Roll column 
in the Satisfied Orders grid and Cavitation on the resulting work order. 

Right Click Options: 

▪ Jump to Inventory 

▪ Jump to Sales Order 

Stock Rolls 

The pick list will only list rolls with a width listed in the Roll Width in the Pattern section or greater. The 
rolls must have a serial (label) and exist in a location. Rolls that have already been allocated are not 
available in the pick list to add to a work order. Different Master Roll item numbers with appropriate 
widths can be selected in the Stock Rolls section of the Slitting Optimizer if the items are added to the 
Master Roll inventory record as an Alternate Item. Once a roll has been allocated, only additional rolls of 
the same width are available to be added. Once stock roll(s) are selected they will appear in this section. 
The fields include Item information such as Item #, Description and Rev. Also included are serial number, 
dimensions, and location. 

Right Click Option: 

▪ Jump to Inventory 

Generated Work Orders 

Once the information is complete in the Slitting Optimizer select the Generate Work Orders button. The 
system will create substitute work orders based on the patterns from the Optimizer. These work orders 
will be available to schedule where the planned ADC work orders will not be listed in the insert job 
screen, and are not scheduled as part of Auto Load. 

Notes:  

Only slitting items from a Slitting BOM marked as Agg. Demand Collector that have demand will show in 
the Work Order picklist. Only the item with demand will display in the Configuration Details section of 
the Work Order. 

Material requirements are calculated for a Slitting work order from the generated substitute BOM, the 
requirements for ADC work orders are ignored. 

The customers whose demand is being filled by the slitting work order will appear on the work order, 
and when multiple customers are attached, the system will display the first one by default.  

Schedule allocation will not occur against ADC Slitting Work Orders. 

When making a manual work order for a Slitting item it must be done via the Slitting Optimization 
module.  An ADC work Order can be created via the Work Order module, but Slitting Work Orders will 
then need to be created via the Slitting Optimizer. 

For example, using the screen shot below the system would generate two work orders for the 
designated patterns. 
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For Pattern #2 the work order would look like this: 
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It includes the three items each with the corresponding multiplier based on the slits. The Lbs Req, Cycles 
Planned and Lbs/Hr are based on the weight of the master roll. 

When a work order is generated from the optimizer users can right click from the Configuration Details 
section and select Jump To Slitting Pattern to access the Slitting Optimization form. 

Material Allocation 

From the work order users can access the Material Allocation form. The system handles the UOM 
conversions for Parts Per if applicable.  

Example for Slitting by Length: 

▪ Master Roll = 100 inches wide, 3600 inches length  

▪ Slit Roll 1 = 35in 

▪ Slit Roll 2 = 45in 

▪ Slit Roll 3 = 10in 

[Total of Slit Rolls is 90 inches of the 100 inch wide Master Roll]   

▪ The parts per for Slit Roll 1 is (35 / (35+45+10)) * 3600 = 1400 in 

▪ The parts per for Slit Roll 2 is (45 / (35+45+10)) * 3600 = 1800 in 

▪ The parts per for Slit Roll 3 is (10 / (35+45+10)) * 3600 =  400 in 
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If stock rolls were selected the system will automatically allocate them to the work order. 

 

Master Roll Work Order 

If no manufactured stock rolls are assigned a work order to manufacture the master roll will also be 
created when the 'Generate Work Orders' button is selected. If the master roll is purchased (no MFG # is 
assigned to it) then it will display in material requirements if there is not enough on hand. 

If the 'Inline' box is checked for the pattern only a manual Extrusion work order will be created (not a 
Slitting work order). 

Note: When making a manual work order for a Slitting item it must be done via the Slitting Optimizer 
module.  Trying to create one via the work order module will not work. 

Production Reporting Notes 

The Production report will have Total Lbs in the top grid populated based on the weight of the master 
roll.  

The system will calculate the unreported rejects on a line by line basis: Total Lbs -  (k=0) ^ n [(Good 
Parts + Rejects)=Unreported Rejects] 
 

Slitting Example 

This section provides an example of the minimal setup entry information required to create work orders 
from the Slitting Optimizer for the Slitting Manufacturing Type. 

The values in the screenshots can be used to test the slitting functionality to gain a better understanding 
of the functionality. 

Setup 

Create Slitting MFG Type 

1 From BOMs->Configure menu or System Parameters->Lists – access Manufacturing Types 
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2 Select the insert button and choose the Slitting Mfg Type from the list. 

 

Default UOM - This field on the General tab is unique to the Slitting MFG Type. A UOM based on weight or 
length can be specified. This setting affects how the BOM, Work Orders, Production Report and 
RealTime™ displays UOMs. When a new BOM is created the system will look at the Mfg Type's Default 
UOM to determine if the BOM is weight or length based, and will use the UOM on the BOM when adding 
new BOMs. 

For this example LBS is being used. 

 

Create a Work Center for the Slitting Manufacturing Type 

1 From the Work Center module create a new work center 
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2 Choose the Slitting Manufacturing Type (and optionally a Mfg. Cell if one was created). 

3 Enter the basic information such as Work Center #, Description, Center Type, etc. 

 

Create new Inventory Class for Master Rolls (optional) 

1 Go to: Inventory->Miscellaneous Menu->Inventory Classes 

2 Select the insert button and enter a new Class. For example ‘MR’ 



BOM-Manufacturing Configurations Page 230 of 273 

 

3 Mark the new class as ‘Primary Material’ 

 

Create Master Roll Inventory items 

1 From Inventory create a new item for the master roll with a UOM in LBS. 
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2 Click the button  to access the Physical Characteristics, and enter the details for all fields except 
Volume which is calculated by clicking on the green arrow. 

 

Note: The unit of measure defaults to inches but can be changed by selecting ‘Physical Characteristics 

UOMs’ from the Physical Characteristics File menu. 
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Create Slitting BOM 

From the BOM module create a new BOM using the Slitting Manufacturing Type. 

 

1 Enter the Mfg # 

2 Select the item to be used as the Master Roll in the ‘Material Spec.’ field. The Gauge, SPG, Core Size, 
and Outside Diameter will populate automatically from the item master (based on the information 
from the Physical Characteristics). 

3 Min and Max width should be set to actual width of master roll. 

4 Enter the Trim width. This information carries over to the Slitting Optimizer. 

5 Select the Line Size (work center) from the pick list. 

6 Enter the Feet/Lb and Lbs/Hr 

7 Enter the Setup Hours 1 

8 Check the 'Agg Demand Collector' button to utilize the Slitting Optimizer in the work order. If this is 
not checked intermediate work order are not created, just the final work order based on demand. 

9 Optionally enter information in the other fields such as Setup Hours 2, Labor, etc. 
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Item Details 

From the Item Details tab on the BOM create all of the inventory items that can be produced by the 
master roll specified on the General BOM Info tab. In the example below four different items can be 
manufactured using this BOM. 

 

1 Select the Insert button and choose the Class from the drop down list (in this example MR). 

2 Enter the Item #, Unit of measure (LBS), and Description 
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For Mfg. Type's with the Default UOM set to weight, the manufactured item will include Slit Roll Weight 
and Width. 

3 Enter the Slit Roll Weight – for simplicity in this example this is set to 1 LB. 

4 Enter the Slit Roll Width. This is the width that the roll will be cut and is used in the Slitting Optimizer 
when creating the work order(s).   

Note: The Slit Roll Weight should be equal to 1 of the UOM of the FG item.  Example: If a Roll weighs 1 
KG, and the BOM is in Grams, then the slit Roll Weight would be 1000 Grams. 

Note: Patterns Std and Patterns Act are for costing purposes only. They will carry through onto the ADC 
work order as cavitation, but they will not automatically pull into the Slitting Optimizer. They need to be 
manually added as multiple Slits. 

Enter the Item’s Physical Characteristics 

1 From the BOM, right click on the item that was just created and Jump to Inventory. 

2 Click on the  button to access the ‘Edit Physical Characteristics’ form and enter all of the details. 

 

Note in this example the Slit Roll Width and the Width are both 20". 

Continue adding additional inventory items that can be made with the master rill using the steps above. 

In this example there are four items all of different widths (20, 80, 60, and 40 inches): 
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Once these setup steps have been completed continue with creating demand and utilizing the Slitting 
Optimizer. 

Create demand by Creating a Sales Order 

1 Enter a sales order for any or all of the items associated to the Slitting BOM. 

 

2 Run Update Schedule 
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Work Order 

Assuming no on hand for the item on the sales order a work order will be created. 
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Slitting Optimizer 

Access the Slitting Optimizer by clicking the  button on the work order, or by accessing the module 
from the Manufacturing tab of the Launcher Bar. 

The form will include the Work Order and Material Summary details. The Patterns, Satisfied Orders and 
Stock Rolls sections will be blank. 
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Patterns 

From the Patterns section select the + button to add a record. This initially populates with the 
information from the BOM (roll width, trim width). 

Satisfied Orders 

This is where the user defines what the pattern will look like and manually select which demand will be 
fulfilled. The goal is to define a pattern such that off-cut (i.e. unused width) is minimized. 

From the Satisfied Orders section select the + button to add a record. The Add Items form will appear: 
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▪ Select from the 'On Order' tab to satisfy demand requirements from sales orders. If the 'Hide Fully 
Satisfied Orders' button on the On Order tab is pressed when adding an item in the Satisfied Orders 
section, only orders that have demand that has not already been completely added to a pattern are 
visible. Toggling the button will show all items with demand regardless of whether they have already 
been added to a pattern. 

▪ Select from the 'All Items' tab to create items to be stocked for future demand (Make-to-Stock). 

ACD BOM 

▪ In this example the SR-01 20 IN and the SR-03 60 IN were selected. 

▪ The number of slits for the SR-01 20 IN item was changed to 2 so the Part width equals the Roll width 
so there is no unused width. 
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The total manufactured quantity for SR-01 is less than the demand of 100, and it is greater than the 
demand for SR-03. 

From the Slitting Optimizer different or additional configurations can be created in order to optimize the 
best usage of the roll and meet the demand. 

Once satisfied with the selected pattern(s) click on the ‘Generate Work Orders’ button. 

The line in the Patterns section will display in green indicating a work order was generated. 
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The work order generated will be a Firm work order with a substitute BOM assigned. The items will be 
those selected in the Satisfied Orders section. 
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Thermoform - General BOM Information 

The following information is specific to the Thermoform Manufacturing type. There are two 
manufacturing types for Thermoform, THERMOFORM and TFORM2.  The main difference between 
TFORM2 and THERMOFORM is that in the TFORM2 MFG Type the sheets have a native UOM of each and 
they are dispositioned in each. 

The sample below shows a completed Thermoform configuration. This is the main entry screen for 
building a BOM for a Thermoform standard. 
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The following field listing details the information that is required for each Thermoform configuration. 
The information in the field listing has been broken down into separate sections (corresponding with 
your screen) for easy reference. Use the field listing to familiarize yourself with the data fields prior to 
making any entries. 

BOM/Standards Info 

Mfg # Up to 50 characters can be entered in this field. The number entered here is the number of 
the actual standard. This number must be UNIQUE. 

Customer This is not a required field, but is often used to associate a job with a particular customer. If 
you are a proprietary producer, you may leave this blank or list your company as the owner. 

To select a customer, type in the first couple of letters of the customer’s name and the 
system will hyperbrowse to that customer. Another method is to select the customer from 
the pick list near the customer field. 

From RFQ #: Request for Quote Number. The information displayed here originates from the Quote module 
and will only be present if the standard was converted from a Quote. 

This field cannot be edited. 

BOM Control # The BOM Control number will change automatically when someone makes a change to the 
configuration. This field cannot be edited. This field will not update immediately. In order to 
see the change, the user would have to exit the BOM module and come back in. 

The field consists of today’s date, time and EnterpriseIQ user ID of the person who made the 
change. 

Note: Changing the Lot Number will not update the BOM Control Number. 

Schedule Info The user can enter up to 250 characters of information that will display when a work order is 
scheduled to a work center that uses this BOM. The information can be printed using the 
Print button from the BOM or from the schedule. 

EPlant Name This field is used to designate the configuration to a specific EPlant. It is not a required field if 
EPlant is not being used. 

Inactive A BOM can be marked inactive. This will ‘hide’ the BOM from pick lists. To view an inactive 
BOM the pick lists have a new button in the upper right corner to ‘view inactive’ items. 

1st Article Ins 
Date 

Enter the First Article Inspection date using the drop down calendar (Optional). This is the 
date that the configuration was first approved for use in a production run. This field is for 
information purposes only. 

This field description can also be changed by right clicking on the field and selecting the 
Define Label Text option. Enter in a user defined caption in the New Value field. The 
customized caption is based on Manufacturing Type. If the caption is changed for an Injection 
BOM, all of the Injection BOM’s will have that same caption but not other types of BOM’s 
such as Generic. 
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Material/Regrind 

 

Material Spec. This field is used for selecting the material that will be used for this job. This section has two 
fields--one will list the material item number and the other will fill in with the description. The 
user can “Jump to Inventory” by right clicking of the material description field. Use the Jump 
To function to make changes to that item, check quantities on hand, etc. 

When creating a new primary material to be associated to a TFORM2 BOM, the only unit of 
measure available to select will be each. 

EPlant The EPlant information associated with the material. 

Gauge The gauge of the raw material. This will fill in based on the gauge associated to the attached 
material. If the gauge of the attached material is changed in master inventory, the system will 
ask the user if the change should be propagated to all of the BOMs that use the material. 
Security can be placed on the pop up message. 

This field can be changed for the specific BOM without affecting the default gauge value 
associated to the raw material. 

SPG The specific gravity of the raw material. This also populates automatically based on the SPG 
associated to the Material Spec. If the SPG is changed on the raw material it will also change 
on the BOM and the BOMs sheet weight and production summary will be recalculated. 

Tool Width The width of the tool. This is entered on the General tab for THERMOFORM. If the specified 
material has this information set in the UOM Conversion Factors in inventory, that value will 
populate this field if it is zero. If this field already has a value the system will not overwrite that 
information. 

For TFORM2 this value only comes from the specified material. (It is entered in the UOM 
Conversion Factors form in Master Inventory). 

Rail Optional.The rail material on the sides used to align the sheet to the tool. 

Tool Length The length of the tool. This is entered on the General tab for THERMOFORM. If the specified 
material has this information set in the UOM Conversion Factors in inventory, that value will 
populate this field if it is zero. If this field already has a value the system will not overwrite that 
information. 

For TFORM2 this value only comes from the specified material. (It is entered in the UOM 
Conversion Factors form in Master Inventory). 

Clamp Optional. The clamp material on the end used to align the sheet to the tool. 
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Sheet Weight If Imperial is selected in the Regional settings the calculation is as follows:  

Thermoform: Sheet Weight = (Width +Rail) x (Length + Clamp) x SPG x Gauge x .0361.  

(Multiplied by 453.59237 if the UOM is in grams). 

TFORM2: Sheet Weight = Width x Length x SPG x Gauge x .0361. 

(Multiplied by 453.59237 if the UOM is in grams). 

If Metric is selected in the Regional settings the calculation is as follows:  

Thermoform: Sheet Weight = (Width +Rail) x (Length + Clamp) x SPG x Gauge.  

TFORM2: Sheet Weight = Width x Length x SPG x Gauge. 

Note: The Native UOM selected in System Parameters will display next to this field. 

 

BOM Manufacturing Details 

 

Mfg. Type This field shows the TYPE of manufacturing this standard will be used for. Cannot be edited. 

Cell Manufacturing Cells are associated to specific MFG Types and are used to designate separate 
areas in your facility. Manufacturing Cells allow a logical grouping of work centers. Group 
work centers by location, product line, process, etc… for separate scheduling and production 
reporting. 

Cells are discussed in the Setup Manual under Manufacturing Cells. Refer to that section for 
more information. 

Center Type Required Field. The entry here is based on the TYPE field in the Work Center module. 

This field links the job to a particular type of work center, though it does not necessarily link it 
to any one specific work center. Conceptually, EnterpriseIQ needs to know what kind of work 
center is used in the production of the item. It does not need to know specifically which work 
center. Assigning a specific work center is done during scheduling, where the user will have 
many options when placing the job in a particular work center queue. 

The machine scheduling portion of EnterpriseIQ will group production jobs together according 
to the type, though the user can override this behavior. 

Cycle Time Required data. This field is the time, measured in seconds, from the start of one shot to the 
start of the next shot. EnterpriseIQ will convert cycle time in seconds to shots per hour on all 
production reports. 

Seconds per cycle can be calculated from parts per hour by this simple equation. Divide parts 
per hour by the number of cavities in the tool, then divide 3600 by that number to achieve 
cycles in seconds. Conversely, shots per hour is calculated by dividing 3600 by the seconds 
per cycle. 

NOTE that EnterpriseIQ supports an efficiency factor which can be used to alter the net shots 
per hour value (see below for more information). 
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Labor This is the labor required at the press to run this operation. This field is used to compute the 
labor hours required to complete the work order.To enter the required labor click on the 
ellipsis button in the labor field and the following form will appear: 

 

From this screen click on the ADD (+) button, enter in the quantity of operators required (this 
does not have to be a whole number) then select the Employee Level Code from the drop 
down list. The Labor Rate will fill in with the rate associated with the code. 

The user can select multiple labor codes and associate fractions of operators per code or 
multiple operators per code. 

EnterpriseIQ supports a range of 0.00 to 999 operators per job. A number less than 1 can be 
used for jobs running automatically and an operator is not always at the press. For these 
tools, a partial number such as 0.5 is entered depending upon the number of machines the 
operator is tending. 

The Employee Levels list is created in Sys Setup->System Parameters->Lists. An unlimited 
number of employee levels may be created for use in the BOM module. The system comes 
with a Default labor code. 

If the Default labor code is selected the system will use the labor rate associated with the 
specific BOM (BOM->Options->Misc Parameters->Labor tab). If that is blank it will use the 
labor associated with the Manufacturing Cell. If the cell does not have a labor rate associated 
with it the system will use the labor rate associated with the Manufacturing Type. 
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SetUp Hours 1 This is the typical time in hours required to set up the tool. Use a close estimate, but 
remember that it could vary from time to time based on the previous job. The schedule will 
add this amount of time to each work order, or bucket, for this configuration. 

This field can also be used to determine the set up cost portion for a manufactured item. 
Setup Labor can be broken out on the standard cost of a manufactured item. This option 
must be turned on in system parameters (Sys Setup->System Parameters->Inv Setup tab). 
When activated, the user can add a cost element and type to an employee level. There are 
two supported types: Setup and Production. When the standard cost is calculated the system 
will check to see if this option is on and if so will break out the labor costs to the cost 
elements attached to any employee levels on the BOM. For “Production” types, the 
calculation will remain as is. For “Setup” types, the system will look at the number of setup 
hours 1 on the BOM times the number of operators for that type times the rate for the 
employee level divided by the standard run qty. 

Please see the Standard Cost section or the Inventory section for more information on the 
standard set up cost. 

SetUp Hours 2 This field is used in the schedule when the same tool is running consecutively in a machine 
instead of Setup Hours 1. If the same tool is running back to back in a work center the Setup 
Hours 2 value will be used instead of Setup Hours 1. For example, this value can be set to zero 
and if the same tool will be running back to back the schedule will not add the set up to the 
schedule which will provide a more accurate end time for the job. 

Scrap% This is the estimated amount of scrap that the production process itself will generate. This is 
used in calculating the extra production time and extra material you will need. 

Try it yourself. Leave this field empty and note the Net Cycles per hour calculation displayed 
on the bottom right portion of the screen. Change the scrap rate, press the Refresh navigator 
button and note the new Net Cycles per hour figure. 

Because each configuration can have it’s own scrap rate, you should not include any other 
anticipated scrap usage here. EnterpriseIQ will calculate the total of all the rates and add the 
yielded scrap back into the job prior to production. 

UOM Unit of Measurement (i.e. feet, inches, meters). This UOM defaults to the UOM set up in the 
Quote module under Misc/Rates and Parameters. 

Eff. Factor You can adjust the total time required to produce the part with this field. Enter an efficiency 
factor that accounts for production problems that effect overall performance. 

Entries made here will affect the Net Feet/hr and Feet/K fields in the Production Summary. 

This field is used to calculate the assumed production time. 

FG Lot # This selection allows the user to assign a Finished Goods lot number to the configuration. For 
additional information on this field, please see the Finished Goods Lot Number section.   
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Assy @ Mach. This not applicable to the Thermoform MFG type.  

 
 

Item Details tab for Thermoform MFG Type 

 

Class Shows the class of the item that you are adding to the BOM. When you first enter this screen, 
the class field will default to ‘FG’ for Finished Goods item but can be changed by selecting a class 
from the drop down list.  

The master class list can be accessed by selecting the button next to this field. 
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Item # Enter in the inventory item part number. This number must be unique. 

Note: If the ‘System-Generated Inventory#’ option is enabled in System Parameters-
>Sequential Numbering tab, the system will populate the item number with the next 
sequential number. If the user clicks on the 'Pick Item' button and clicks 'New' on the 
pick list, the item # will be the same as what was generated. For example, if the next 
sequential item was '123', when selecting 'New' on the pick list it will still be '123'.  
The value can be overwritten if desired. 

Rev This field is optional though very important for tracking revisions to parts. It is used to 
distinguish between similar part numbers. (EnterpriseIQ sorts and stores unique part numbers 
based on Class, Item Number and Rev). You can use it to track any revisions made to the part 
and can also be retrieved in reports. 

The information can be typed manually or selected from a user defined list. To create the list 
right click on the Rev field and select ‘Edit User Defined List’. Select the + button and enter the 
text. (This field is only 15 characters - any additional characters entered will be ignored). 

Unit This is the Unit of Measurement. Defaults to EACH. 

Description Enter a short description or common name of the item. The description entered here will be 
used throughout the system to identify this item. If producing the same part in different colors, 
we suggest you include the color in the item description. 

Ext. Description Second part description field—use up to 100 characters for the description. 

Item Weight Enter the weight for a single item. The weight will be shown in either pounds, grams or ounces 
(the system defaults to the UOM set up in the Quote Module under Misc/Rates and Parameters 
or if the default UOM was overridden it will look at what you entered in the UOM field on the 
general BOM screen). Do not multiply the weight by the number of ups. 

Note: For users installed before version 2011, updating the Item Weight on the BOM modifies 
the Weight field in Inventory > Additional tab. For versions after 2011 this field will not populate 
the inventory weight field, but if for some reason this is a requirement please contact 
DELMIAworks support and the required trigger can be provided. 

Actual & 
Standard Up 

The Standard Up is the number of items produced during the cycle. The Actual Up is how many 
ups in the tool for the item are functioning. 

Actual Up is used to determine how many shots are required on a production run. The 
calculation is the number of Items Required divided by the Actual Up. 
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Costing Weight The costing weight is used to determine material costs for standard costing purposes. It equals 
the Sheet Weight divided by the standard ups plus the item weight. If the ‘Include scrap in By-
Product weight calc’ option is checked for the MFG Type then it is: ((Skeleton / Total Std Ups) + 
((Sheet / Ups) * scrap%)) + Item Weight. 

Example (using screen shots from above with 5% scrap): 

((504.485564 / 3) + ((589.485564 / 3) * .05)) + 25 

= 168.16185 + 9.82476 + 25 

= 202.9866 

Sheet Weight The calculated Sheet Weight from the General BOM Info tab 

Skeleton Weight Skeleton Weight = Sheet Weight - (Part Weight(s) * Up) 

Example (using screen shots from above):  

589.485564 - ((25 x 1) + (30 x 2)) = 504.485564 

User Num On this screen there is an additional field called User Num. This field is only used for EDI or 
Crystal reports. (The field is in the table Partno and is called Nuser1). 

Drawing No. Optional. The number entered here is used to track the drawing number for the part. Use up to 
30 characters. 

ECNO Optional. This user defined field normally carries an engineering change number, but it can also 
be used to hold additional information about the part, such as a UL number. 

Note: This field will not exist for users with the Engineering Change Order (ECO) Quality module. 

 

Attached Materials 

By Product To add a By Product select the speed button next to the Skeleton Weight field. The By Product 
pick list will appear to choose from or select New to create a new By Product inventory item. 
The Quick Add form will appear to enter the By Product Item Number, Description, Rev, unit of 
measure, etc. The Class defaults to PL.  

If a By Product item is created based on the Skeleton Weight the By Product box will be checked. 
It cannot be manually checked or unchecked. 

During Production Reporting both items will  be dispositioned into inventory. 

Note: The value of the skeleton (By Product) does not impact the standard cost of the 
manufactured item. 
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Parts Per The calculation for the By Product Parts Per is dependent on whether the’ Include scrap in by 
Product weight calc’ option in MFG Types is checked or not.  

When 'Include scrap in by product calculation' check box is not checked:  

1 By-Product = Skeleton / Ups 

 

When 'Include scrap in by product calculation' check box is checked:  

1 By-Product = Skeleton / Ups + ((Sheet / Ups) * scrap%) 

(The scrap % comes from the General BOM Info Scrap % field). 

This will be a negative value so that it is put into inventory during dispositions 

Example using screen shots from above: 

((504.485564 / 3) + ((589.485564 / 3) * .05)) 

= 168.16185 + 9.824759 

= 177.98661 
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Treatment 

The Treatment manufacturing type is used for processes such as heat treatment and annealing where 
multiple items are processed at one time. All items that require a specific Treatment are included in a 
single BOM. 

Steps to implement the Treatment Manufacturing Type: 

▪ Create a Treatment Manufacturing Type and optionally Manufacturing Cell(s) associated to the 
Treatment Manufacturing Type. (Refer to Manufacturing Types and Manufacturing Cells for details). 

▪ Create Work Centers for the Manufacturing Type and cell(s). 

▪ Create Treatment BOM(s) 

▪ Enter the inventory items loose volume in BOL Data 

Treatment Work Centers 

The fields for a work center associated to the Treatment Manufacturing Type are the same as other 
types of work centers with the exception of the Center Usable Volume.  This field is used to determine 
the volume in cubic inches that can fit in a single cycle. The system will use the Inventory item's loose 
volume (BOL data) to evaluate the items that can fit in the work center. 

Refer to the Work Centers section for more information on other fields. 
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Note: The TREATMENT MFG Type is not RealTime™ compatible.  It can be used with non-signaled 
RealTime™, and will correctly produce a production report when a shift changes or when the job is 
removed from first position. 

Treatment BOM 
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Specific fields for the Treatment BOM: 

▪ Treatment Information - 2000 character field to enter the treatment instructions.  

▪ Load Time Hrs - The number of hours to load the work center. 

▪ Unload Time Hrs - The number of hours to unload the work center. 

Both times will be added to the Production Hours calculation for each cycle required. 

Note: The Cycle Time defaults to seconds for the Treatment MFG Type but can be changed to a different 
unit of measure such as hours or minutes in the User Defined Conversion Factor option in Manufacturing 
Types (See Manufacturing Types for details). 

Note: Treatment BOM's production hours on work orders are not adjusted by the scrap %.  The 
production hours calculation for the Treatment Mfg type is cycle time + load time + unload time. If parts 
are scrapped, another full cycle time needs to be run. 

Note: Treatment BOM's do not have an Eff. Factor field as it is not relevant to this manufacturing type. 

Production Summary: 

▪ Cycles/Hr - 3600/Total Cycle Time 

▪ Hours/K-cycles - 1000/Cycles/Hr 

▪ Total Cycle Time Hrs - Cycle Time + Load Time Hrs + Unload Time Hrs 

Example: Using the screen shot above where the Cycle Time is in minutes: 

▪ Cycles/Hr = 3600/3600+1800+1800 = 0.50 (Total Cycle Time converted to seconds) 

▪ Hours/K-cycles = 1000/0.50 = 2000 

▪ Total Cycle Time Hrs = 1 +0.5 + 0.5 = 2 

Item Details: 

All items that require a Treatment based on the BOM (specific treatment information and cycle time) 
must be included on the item details tab (like a family tool). 
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Update Schedule and Work Orders: 

When Update Schedule runs, for planned work orders only the items with outstanding demand will be 
added to the work order. For manual work orders, all items on the BOM will be added to the work order. 

The work order processing will calculate the total cycles required for all demand by multiplying the 
demand quantity for each item times the Loose Volume. 

Work Order Cycles Required =  the Total volume of all items attached to the work order / Work Center 
Usable Volume 

Work Order Production Hours = Cycle Required * (BOM Cycle Time + Load Time Hrs + Unload Time Hrs) 

Example: 

▪ 2 item's on work order with demand, each with an Item Volume = 10, and demand = 1000 for each 
item 

▪ Work Center Usable Volume = 10000 

▪ Cycle Time on BOM = 1 hour 

Work Order Cycles Required = (1000 * 10 + 1000 * 10) / 10000 = 2 

Work Order Production Hours = 2 * (1 hour + 0.50 Hour + 0.50 Hour) = 4 Prod Hrs 
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Note: The system calculates how many cycles will be required to process all the items with demand 
based on the volume and work center capacity, and creates a single work order. The decision of which 
items to run in each cycle is up to the operator. 

Note: The system will evaluate the MFG Run Size to determine if the parts should be bucketed. 

Scheduling and Production Reporting 

TREATMENT Work Orders are finite schedule based on Production Hours on individual TREATMENT Work 
Centers. 

The TREATMENT MFG Type is not RealTime™ compatible. 

Only the items that have demand are evaluated for material exceptions. 

Production Reporting will report how many of each item in the TREATMENT Work Orders have been 
processed.  The pre-treatment item # is backflushed to the Treated Item #.  When Update Schedule 
runs the Work Order Cycle Req and Production Hours will be reduced by the production that was 
reported. 
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Visual BOM Routing 

The EnterpriseIQ Visual BOM Routing module is a tool which enables the user to create bills of 
manufacture in a more visual way or view existing BOM’s visually. This option is very similar to the 
Routing Diagram option available from the items details tab of a BOM except the Visual BOM Routing 
module has add and edit capabilities. 

From this screen the user can create the BOM’s for the entire routing process. To create a BOM Routing 
diagram you start at the end of the process and work your way to the beginning routing steps required 
to make the final item. 

Overview 

The basis of the EnterpriseIQ Visual BOM Routing module involves creating a routing structure for 
products that you run in your facility. This module is used to create routing diagrams for repetitive type 
manufacturing processes. 

Below is an example of a Visual BOM Routing diagram: 
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Creating a New Visual BOM Routing 

To create a new BOM Routing diagram go to the Visual BOM Routing speed button on the main launcher 

bar . Click on the New button on the pick list and the following screen will appear: 

                       

From this screen you may choose a Mfg Type and cell you want the BOM assigned to. 

Once a Mfg type (and optionally a cell) has been selected the appropriate configuration screen will 
appear based on the manufacturing type selected. Enter the BOM information in as described earlier in 
this document. 

Once the information is entered, click on the OK button and the BOM Routing screen will appear 
showing a blue box with the basic information regarding the operation. Below is an example: 
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This box shows the work center type, Mfg #, a calculated rate per hour based on the cycle time in 
seconds (The calculation is 3600/cycle time in seconds), and the Item #. 

Primary Right Click Options 

You can also access Visual BOM Routing functions quickly and easily by right clicking a BOM. Doing so will 
open a list of possible actions, which are listed below: 

▪ New Routing BOM - With this option, the user can create a new Routing BOM diagram via the right 
click rather than the speed button. 

▪ Cost/Quote - With this option, the user can access the Cost/Quote calculations associated with the 
given BOM in a separate window. 

Adding Additional Routing Steps 

To continue creating associated BOM Routing steps, right click and choose Add Routing BOM. Choose the 
Mfg Type and cell (optional) then fill in the fields on the form with the information for the step. An 
unlimited number of BOM Routing steps can be created. 

 

Other Right Click Options 

▪ Add Routing BOM(s) Like - This option allows the user to ‘clone’ a BOM and add it to the routing 
diagram. After selecting this option a Routing Diagram pick list will appear. The user can double click 
on an item to view it’s routing diagram. Once the desired step is found, drag the step(s) from the pick 
list and drop it onto the step it will follow in the visual routing diagram. A ‘List of items to be cloned 
or reused’ will appear. Enter the desired Mfg#, Item #, Rev, and Description. 

Note: To add existing BOMs (not cloning) to the routing diagram use the Components option (discussed 
below) and select a FG or WP item as the component. 

New LIKE 

From the File menu users can select New LIKE to clone an entire routing diagram. Users can select from 
existing diagrams or portions of a diagram and clone the routing steps into different Mfg #'s. The Item 
numbers, Description, and Revision level can all be changed as desired. All processes attached to the 
source routing steps will carry over to the new routing steps. 

▪ To use the New Like feature go to Visual BOM Routing from the launcher bar and select any Mfg # 
from the pick list, the Visual BOM Routing screen will appear. 

▪ Select New Like from the File menu and a Routing Diagram pick list will appear: 
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This form is a pick list of all existing routing items (BOMs). The left side lists the routing diagrams and the 
right side will display the visual routing diagram associated with the selected item. The user can choose 
to display only the top level items by checking the box next to Top Level. If the box is not checked all 
routing items will appear in the list. Note that the top level items are in bold. The Show all check box can 
be checked to also display inactive configurations. 

To view the visual routing diagram for a particular item double click on the item and the visual 
information will appear on the right side of the form. The line item that the visual information is 
displayed for will be gray. This way the user will know which item the visual routing diagram displayed on 
the form is for. 

Select a routing diagram that you would like to clone. Highlight that line item and then drag and drop the 
information from the pick list to the Visual BOM Routing by holding down the left mouse button. 

A 'List of Items to be cloned or reused' will appear. 
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From this grid users can edit the Mfg #, Item #, Rev, and Description fields for the new BOM(s). By 
default the grid will leave the highest level New Mfg # blank and fill in the others with the same 
information as the source routing steps. Users can determine which Mfg #'s to reuse or create as new 
ones. If the information in the 'New Mfg #' field remains the same as the source steps (BOM Tree field) 
the system will assume those BOM's are to be reused. If different information is entered in the New Mfg 
# field the system will create a new BOM. Simply type over the data in the 'New' fields to change the 
information. 

Note: If a new Mfg # is created and the Item # is not changed the system recognizes that the item can be 
produced using either Mfg # (the original one or the newly cloned one). The Default Mfg # associated to 
the item will stay as it was prior to creating the new Mfg # but can be manually changed by going to the 
Inventory Module->Manufacturing tab. 

When cloning the BOM any attached Processes will be reused. Once all the data has been entered select 
OK and the new routing diagram will appear. 

▪ Edit Routing BOM- This function brings up the BOM for editing purposes. 

▪ Delete Routing BOM - This function will delete the BOM Routing step (blue node) that is right clicked 
on and all of it’s attached steps. This only removes the routing step(s) from the diagram it does not 
delete the BOM(s). A pop up screen asking if you are sure will appear. To delete the step(s) click on 
the Yes button. The top blue node can only be deleted if there is no quantity on hand. If attempted 
for a BOM with associated on hand inventory, the user will receive a message similar to the 
following: "Unable to Delete Item - On hand quantity found. Unable to delete item(s). Details - The 
following item on hand quantity is not zero: 08092-102, Routing # 0". 

▪ Routing Notes - This brings up the Routing Notes for the routing step. This is a 2000 character note 
field used for work instructions for routings. This information will print on the Routing Packet report 
available in work orders. 

▪ Components - This function enables you to add any components from your master inventory. After 
selecting this function the following form will appear:        

  

To add a component from inventory, click on the ADD (+) key then double click in the Item # field. Click 
on the ellipsis button in that field and the following screen will appear: 
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This screen is a list of all items in your master inventory. To add a component such as a finished good, 
WP item, raw material, additive, insert, etc. Highlight the item on the list and click OK. To add a 
packaging item change the Type to Packaging using the drop down list at the bottom of the form. Once 
an item is selected, you will be returned to the Component form and the Type, Item #, Description, and 
Unit fields will be filled in with the information from master inventory. Complete the information by 
filling in the Parts Per (the parts per will default to one), Overlap Hours, and Scrap information for the 
component or Packaging Sequence # and Scrap% for a packaging item. Overlap hours are the number of 
hours you can overlap with the Routing step above. Scrap% is the anticipated percent of scrap for the 
item you will make performing this operation. The Packaging Sequence number is related to the bill of 
lading, make the largest packaging item (or the one you will be putting on the BOL) sequence # 1. 

When a finished good or work in process item is chosen the attached materials associated with its BOM 
will also appear on the BOM Routing form. 

▪ Processes - This is only available for ASSY manufacturing types. To add/edit other types of second 
operations, use Jump to BOM, and select Add Operation. For ASSY manufacturing types, this option 
allows the user to add processes to the routing step. Processes are steps that are not scheduled but 
are tracked using the Assembly Track and AssyData modules. From the Processes Maintenance 
module users can create an unlimited number of processes that can be associated to ASSY BOM's. 
(For more information on Processes please see the Assembly Manufacturing documentation). 

▪ Expand - This right click function opens up the colored box that was right clicked on to show 
additional information about the routing step. In addition to the four fields shown on the non 
expanded box, you will see the Item Description, Parts Per, Required, On Hand, and Non Committed. 
For purchased items the lead time will also display. 

Under Options, Toggle Expanded allows the user the choice to be able to expand multiple windows or 
only one at a time. With this option checked, only one box may be expanded at a time. With this option 
not checked, multiple boxes may be expanded and open at one time. 

▪ Jump to Inventory - This function will take you to the Inventory screen for the item that was right 
clicked on. 

▪ Jump to BOM - This function will take you to the BOM screen for the item that was right clicked on. 

▪ Jump to Exception List - This function will take you to the material exception list for the item that was 
right clicked on. If the item is not on the list a pop up form stating so will appear. 

Color Coding 

Each type of attached operation/component has a corresponding color associated with the information 
box. 

▪ Blue - represents a BOM / Routing. 

▪ Purple - is the Primary raw material. 

▪ Green - is a Purchased Component. 

▪ Yellow - is a packaging item. 

▪ White - is a purchased component used in a sub-operation. A sub-operation is an operation attached 
to an existing BOM which has been attached to the BOM Routing. If components are attached to this 
sub-operation they will show in white. 

▪ Medium Blue - is an Outsourced BOM. 
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▪ Gray - is a Process. 

▪ Light Blue - is an Assy Process 

Once a Visual BOM Routing diagram is created, all of the steps are treated like traditional BOM’s. Sales 
Orders may be added for the item. Work Orders will be generated, and the operations may be 
scheduled. 

Print Visual Routing 

The user can print the BOM Tree Visual report from the printer speed button. This will print the report to 
the printer. (For more information on the Printer Speed button see Speed Buttons). 

Note: To print a report from the reports menu you must print through the speed button first each time 
you want information for another BOM. Or if you modify a BOM you will need to print it again through 
the speed button to refresh the data in the c_bom_depend_flat table. The report does not have to 
actually be printed, you can select Cancel on the Print form and the table will still be populated in order 
to print to screen from the reports menu. Each time the table is populated the system will delete data 
three days or older. 

Note: When printing the visual bom routing there is a package that gets executed that populates a 
composite table C_BOM_DEPEND. This table populates the multiple levels of a BOM into one table 
allowing report writing to be easier. This package is an "execute before print" action so that it can be set 
up at the report level to eliminate the need for sub reports. 
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Main Item Cost/Quote in Visual BOM Routing 

Once all of the steps for a Routing operation have been created the user may calculate the costs and 
input a mark up % that can be used in reports.  

Select the Cost/Quote speed button  to access the form. This is basically the same Cost 
Calculations form which is accessed from the Standard Costing tab in inventory. The only difference is 
the addition of the % Markup and Quote Total columns.  
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From this screen the user can calculate costs for the item based on the routing steps set up. A quoted 
price can also be calculated based on a user-defined mark up. The mark up is based on a percentage or 
points. 

To specify how the markup will be calculated select Options > Parameters from the menu and the 
following screen will appear: 
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The markup will either be calculated based on a Percentage or Points. 

Mark-up By 

Percentage The Percentage function takes a certain percentage of the cost, and adds that 
value back to the original. 

Example: 

Item cost is $1.00 with a 25% percentage markup calculates to $1.25 (1.00 x .25) 
+ 1.00 = 1.25. 

Points The Points function increases the total cost by the percentage used. This is 
accomplished by dividing the cost by the percentage. 

Example: 

Item cost is $1.00 with a 25% Points markup calculates to $1.3333 (1.00 / .75 = 
1.3333). 

Decimal Precision - From the Parameters screen the user can also specify the Decimal Precision for the 
quote price. The system defaults to six decimal places but can be changed by typing in the desired 
decimal precision. The allowable decimal range is from 0 - 6. 

Entering % Markups 

After selecting the single calculator button the system will populate the Future Cost column. To create a 
quote price enter a value in the % Markup column for each cost source to be marked up. The system will 
calculate the Quote Total column based on the selected 'Markup By' parameter. The Quote Total 
information does not carry over to master inventory. The information can be added to reports and 
printed prior to rolling the costs.  

For more information on calculating standard costs for manufactured items please see Standard Costs 
for Manufactured Items. 
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